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Overview of GPT for Work

What is GPT for Work?

GPT for Work is a set of add-ons, developed by Talarian, that integrate the power and intelligence
of generative AI directly into Microsoft Excel and Word and Google Sheets and Docs. GPT for
Work supports models from Anthropic, Azure, DeepSeek, Google, Mistral, OpenAI, OpenRouter,
Perplexity, and xAI. GPT for Work also supports open-source models through Ollama and any
OpenAI-compatible API endpoint.

GPT for Work allows you to:

Apply AI prompts in bulk on spreadsheet data. Use your favorite AIs to generate, rewrite,
translate, categorize, extract, and otherwise process text at machine-powered scale and speed
in Microsoft Excel and Google Sheets.

Author documents with a personal writing assistant. Use your favorite AIs to edit, rewrite,
correct, review, translate, summarize, draft, write, and more in Microsoft Word and Google Docs.

GPT for Work comes in the following flavors:

GPT for Excel and Word: Microsoft Office add-in that bundles together GPT for Excel and GPT
for Word.

GPT for Sheets and Docs: Google Workspace add-on that bundles together GPT for Sheets and
GPT for Docs.

Install GPT for Sheets and Docs Install GPT for Excel and Word

https://talarian.io/
https://www.anthropic.com/
https://azure.microsoft.com/en-us/
https://www.deepseek.com/en
https://ai.google/
https://mistral.ai/
https://openai.com/
https://openrouter.ai/
https://www.perplexity.ai/
https://x.ai/
https://ollama.com/
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://workspace.google.com/marketplace/app/gpt_for_sheets_and_docs/677318054654?utm_medium=website&utm_source=help
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help&src=website&mktcmpid=help


GPT for Work Help (Microsoft) 2025-10-22

3 / 366

MS Excel

MS Word
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Get started

For a quick walkthrough of each add-on from installation to trying out key features, see our
quickstart guides:

Quickstart for spreadsheets

Quickstart for documents

Compatibility

Microsoft Office

The following table lists the minimum versions of Microsoft Excel compatible with the GPT for
Excel add-in on different Microsoft Office platforms.

Windows Mac Online

Microsoft 365 subscription:

Version 2002 (Build
12527.20092)

Retail perpetual:

Version 2002 (Build
12527.20092)

Volume-licensed perpetual:

Excel 2021: Version 2108 (Build
12527.20092)

Version 16.35 (Build
20030802)

Supported on:

Google Chrome (latest
version)

Microsoft Edge (latest
version)

Which version of Excel am I using?

The following table lists the minimum versions of Microsoft Word compatible with the GPT for
Word add-in on different Microsoft Office platforms.

https://gptforwork.com/help/quickstart-for-spreadsheets
https://gptforwork.com/help/quickstart-for-documents
https://gptforwork.com/help/gpt-for-excel/faq#my-excel
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Windows Mac Online

Microsoft 365 subscription:

Version 2205 (Build 15202.10000)

Retail perpetual:

Version 2205 (Build 15202.10000)

Volume-licensed perpetual:

Word 2024: Version 2205 (Build
15202.10000)

Version 16.61 (Build
22040100)

Supported on:

Google Chrome (latest
version)

Microsoft Edge (latest
version)

Which version of Word am I using?

Google Workspace

GPT for Sheets and Docs works with Google Sheets and Google Docs on Google Chrome (latest
version).

What's next

Try out example spreadsheet use cases for different business applications and product
capabilities.

Browse the AI providers and models supported by GPT for Work.

Learn how to use the add-ons:

GPT for Excel

GPT for Sheets

GPT for Word

GPT for Docs

Learn about pricing and billing.

https://gptforwork.com/help/gpt-for-word/faq#my-word
https://gptforwork.com/help/use-cases-spreadsheets/business-applications
https://gptforwork.com/help/use-cases-spreadsheets/product-capabilities
https://gptforwork.com/help/use-cases-spreadsheets/product-capabilities
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/gpt-for-excel
https://gptforwork.com/help/gpt-for-sheets
https://gptforwork.com/help/gpt-for-word
https://gptforwork.com/help/gpt-for-docs
https://gptforwork.com/help/pricing-and-billing
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Quickstart for spreadsheets
GPT for Work integrates the power and intelligence of generative AIs directly into Microsoft Excel
and Google Sheets. Use your favorite AI to generate, rewrite, translate, categorize, extract, and
otherwise process text in bulk – at machine-powered scale and speed.

GPT for Work contains two spreadsheet add-ons: GPT for Excel and GPT for Sheets.

This guide gives you a quick walkthrough of the add-ons from installation to trying out their key
features.

Install the add-on

To use GPT for Work in Excel or Sheets, install the appropriate add-on:

Install GPT for Sheets and Docs Install GPT for Excel and Word

For detailed installation instructions, see Install GPT for Work add-ons.

EXCEL IS BETTER THAN SHEETS

If you have a choice between using Excel or Sheets, choose Excel. Excel is generally faster at
processing data, provides a smoother user experience, and can reliably handle bigger
spreadsheets (200 000 rows and above) than Sheets.

GPT for Excel can execute up to 1,000 prompts per minute and reliably process up to a
million rows in one go

GPT for Sheets can execute up to 360 prompts per minute and reliably process up to
200,000 rows in one go.

USE AN API KEY

To get more AI models, more control, and more privacy, use an API key. For more information,
see Select a model.

https://gptforwork.com/help/
https://workspace.google.com/marketplace/app/gpt_for_sheets_and_docs/677318054654?utm_medium=website&utm_source=help-quickstart-for-spreadsheets
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-quickstart-for-spreadsheets&src=website&mktcmpid=help-quickstart-for-spreadsheets
https://gptforwork.com/help/install
https://gptforwork.com/help/ai-models/select-model#select-byok
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Open the add-on

MS Excel

Download our quickstart example template, and open it in Excel as a new workbook. You'll
need the workbook for the example tasks below.

1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

The GPT for Excel sidebar opens.

2

https://drive.google.com/file/d/1l3UXEJnAnbL9JbAMKtuQpphy5FvtXO7R/
https://gptforwork.com/help/concepts?app=excel#sidebar
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Use a bulk AI tool

Bulk AI tools allow you to run prompts on an entire spreadsheet column at once without writing
any formulas. You configure and run bulk tools from the add-on sidebar.

Let's generate some text with the Custom prompt bulk tool:

MS Excel

The following video shows the entire process.

Use a GPT function

GPT functions are custom spreadsheet functions that allow you to prompt AI from inside
spreadsheet cells. GPT functions work exactly like native functions in that you can use them on
their own or combine them with other functions when creating formulas.

Let's use the GPT_TRANSLATE function to translate the first few product descriptions you
generated above to French:

MS Excel

In the sidebar, select Bulk AI tools if not already selected.1

Click Custom prompt.2

Define the following settings:3

Header row: Select 2. The bulk tool will process all rows with content below this row.

Prompt to run for each row: Enter the following prompt for the AI:

Write a short SEO-optimized product description for a bike based on its 
specifications: {{Specifications}}

Put results in column: Select B.

Leave all other settings to their default values.

Run the bulk tool:

The bulk tool executes the prompt for every row with content, starting from row 2, and puts
the responses generated by the AI in column C.

4

i. Select All rows1

ii. Click Run all rows.2

In the sheet, select cell C3.1

https://gptforwork.com/help/concepts#bulk-ai-tools
https://gptforwork.com/help/concepts#gpt-functions
https://gptforwork.com/help/concepts#function-spreadsheet
https://gptforwork.com/help/concepts#formula-spreadsheet
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The following video shows the entire process.

TIP

You can also use the Translate bulk tool to translate text. If you're working with up to a few
hundred cells, GPT_TRANSLATE is fine. However, if you're working with thousands or more
rows, or if you don't want to write formulas, use the Translate bulk tool.

Use the formula assistant

The formula assistant allows you to generate spreadsheet formulas based on plain-language
descriptions of what you want to achieve. You can also use the formula assistant to explain
existing formulas (in English).

Let's both generate and explain a formula:

MS Excel

The following video shows the entire process.

You're done with the quickstart! You've successfully dipped your toe in GPT for Excel. 💚

Enter the following formula in the cell:

The function generates a translation of the content in cell B3.

2

=GPT_TRANSLATE(B3, "French")

Drag the formula from cell C3 across to cell C7. The function is copied to each cell in the range,
which automatically generates a dedicated translation for each row.

3

In the sidebar menu, select Formula assistant.1

In Describe your goal, enter the following prompt:2

Return the difference in number of characters between cells B3 and C3.

Click Generate formula. The assistant generates the formula.3

Click Copy. This copies the generated formula to the clipboard.4

Expand Explain formula.5

In Formula, paste the generated formula from the clipboard.6

Click Explain formula. The assistant generates an explanation of what the formula does.7

https://gptforwork.com/help/concepts#formula-assistant
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What's next

MS Excel

Learn more about GPT for Excel.

Get going with bulk AI tools.

Get going with GPT functions.

Try out different AI models.

Try out example use cases for different business applications and product capabilities.

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/start-using-gpt-functions
https://gptforwork.com/help/ai-models
https://gptforwork.com/help/use-cases-spreadsheets/business-applications
https://gptforwork.com/help/use-cases-spreadsheets/product-capabilities
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Quickstart for documents
GPT for Work turns generative AIs into your personal writing assistants available directly in
Microsoft Word and Google Docs. Think of it as ChatGPT inside Word and Docs. Use your favorite
AI to edit, rewrite, correct, review, translate, summarize, draft, write, and more.

GPT for Work contains two document add-ons: GPT for Word and GPT for Docs.

This guide gives you a quick walkthrough of the add-ons from installation to trying out one of their
key features.

Install the add-on

To use GPT for Work in Word or Docs, install the appropriate add-on:

Install GPT for Sheets and Docs Install GPT for Excel and Word

For detailed installation instructions, see Install GPT for Work add-ons.

USE AN API KEY

To get more AI models, more control, and more privacy, use an API key. For more information,
see Select a model.

Open the add-on

MS Word

Download our quickstart example template, and open it in Word as a new document.1

In the Home tab, click GPT for Excel Word.2

https://gptforwork.com/help/
https://workspace.google.com/marketplace/app/gpt_for_sheets_and_docs/677318054654?utm_medium=website&utm_source=help-quickstart-for-documents
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-quickstart-for-documents&src=website&mktcmpid=help-quickstart-for-documents
https://gptforwork.com/help/install
https://gptforwork.com/help/ai-models/select-model#select-byok
https://drive.google.com/file/d/1DKQKXQBjkYGfFvlIIp3o2JUix8X_vljt/
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Try out the add-on

MS Word

GPT for Word allows you to prompt an AI as you would in ChatGPT or another AI chatbot, but from
inside Word. You can then use the AI responses directly in your document, without needing to
copy-paste anything between the document and an external chatbot.

Let's translate some text and replace the original with the translation:

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

The GPT for Word sidebar opens.

In the document, select some text to translate. For example, select the first heading and
paragraph.

1

In the sidebar, above the prompt field, select Use selection or document for context. The
option changes to Using selection as context.

2

Enter the following prompt:3

Translate to French

https://gptforwork.com/help/concepts?app=word#sidebar
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The following video shows the entire process.

You're done with the quickstart! You've successfully dipped your toe in GPT for Word. 💙

What's next

MS Word

Learn more about GPT for Word.

Start authoring text.

Learn how to use GPT for Word effectively through practical examples.

Try out different AI models.

Below the prompt field, make sure Plain text mode is disabled. We want to maintain text
formatting.

4

Click Send. GPT for Word generates a translation of the selected text and displays the
translation in the sidebar chat.

5

Click Replace. GPT for Word replaces the selected text with the translation while maintaining
the original text formatting.

6

https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/author-text
https://gptforwork.com/help/gpt-for-word/examples
https://gptforwork.com/help/ai-models
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AI providers & models supported by GPT for
Work
GPT for Work supports models from Anthropic, Azure, DeepSeek, Google, Mistral, OpenAI,
OpenRouter, Perplexity, and xAI. GPT for Work also supports open-source models through Ollama
and any OpenAI-compatible API endpoint. The tables below show which models you can use with
and without an API key, in which GPT for Work add-ons, and at what price.

INFO

Space admins can control model availability (Microsoft accounts only). Learn more.

Models you can use without an API key

You can use models from OpenAI, Google, Anthropic, and Perplexity.

INFO

Reasoning models, vision models, and web search models typically cost much more than
regular, text-only models. Learn more.

SEE THE CURRENTLY SUPPORTED MODELS

Models that support prompt caching get a 75% discount on cached input tokens.

Models you can use with an API key

You can use models from OpenAI, Perplexity, Google, Anthropic, OpenRouter, DeepSeek, Mistral,
Azure, xAI, and open-source models through Ollama and any OpenAI-compatible API endpoint.

INFO

Reasoning models, vision models, and web search models typically cost much more than
regular, text-only models. Learn more.

SEE THE CURRENTLY SUPPORTED MODELS

You pay the API cost directly to the AI provider.

Models available through dedicated API endpoints (Azure, Ollama, other local servers and cloud-based
platforms) do not consume credits, but require a positive balance or a valid subscription.

https://gptforwork.com/help/
https://www.anthropic.com/
https://azure.microsoft.com/en-us/
https://www.deepseek.com/en
https://ai.google/
https://mistral.ai/
https://openai.com/
https://openrouter.ai/
https://www.perplexity.ai/
https://x.ai/
https://ollama.com/
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://openai.com/
https://ai.google/
https://www.anthropic.com/
https://www.perplexity.ai/
https://gptforwork.com/help/ai-providers-and-models#tk
https://openai.com/
https://www.perplexity.ai/
https://ai.google/
https://www.anthropic.com/
https://openrouter.ai/
https://www.deepseek.com/en
https://mistral.ai/
https://azure.microsoft.com/en-us/
https://x.ai/
https://ollama.com/
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://gptforwork.com/help/ai-providers-and-models#byok
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Notes

Reasoning models

Reasoning models are trained to think before they answer, producing an internal chain of thought
before responding to a prompt. Reasoning models generate two types of tokens:

Completion tokens make up the model's response.

Reasoning tokens make up the model's internal chain of thought.

You are billed for both types of tokens.

Vision models

Vision models can process images as input. The following features support vision models:

Custom prompt bulk AI tool

Prompt images (Vision) bulk AI tool

GPT_VISION function

Image inputs are measured and charged in tokens, just like text inputs. How images are converted
to text tokens depends on the model. You can find more information about the conversion in the
OpenAI documentation and Anthropic documentation.

Web search models

Web search models can gather the latest information from the web and use it as context when
generating responses. The larger the context, the more information a model can retrieve from
each web source, producing richer and more detailed responses. For some models, you can select
the context size in the model settings.

How web search model pricing works:

Cost without an API key: Token cost + search cost

Cost with an API key: Token cost

For more information about token cost and search cost, see Models you can use without an API
key and Models you can use with an API key. The search cost varies by AI provider and context size.

API endpoints

You can use any OpenAI-compatible API endpoint with GPT for Work. You can connect to two main
types of services:

https://gptforwork.com/help/concepts#tokens
https://gptforwork.com/help/concepts#tokens
https://platform.openai.com/docs/guides/images-vision?api-mode=chat#calculating-costs
https://docs.anthropic.com/en/docs/build-with-claude/vision#calculate-image-costs


GPT for Work Help (Microsoft) 2025-10-22

16 / 366

Cloud-based LLM platforms provide access to models over the internet with no software
installation or setup required on your part. Popular examples include Anyscale, Fireworks AI,
and Together AI. The available models vary from platform to platform.

Local LLM servers run on a local machine, such as your own computer or another computer on
a local network. Popular examples include LM Studio, LocalAI, and Open WebUI. The available
models depend on what's installed on the server you're using.

What's next

AI models

Cost estimator

Price evolution

TIP

The tables on this page were created with Awesome Table Apps.

https://www.anyscale.com/
https://fireworks.ai/
https://www.together.ai/
https://lmstudio.ai/
https://localai.io/
https://github.com/open-webui/open-webui
https://gptforwork.com/help/ai-models
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/cost-estimator
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work#price-evolution
https://awesome-table.com/apps
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Security and privacy FAQ
In this article, we (Talarian, maker of GPT for Work) aim to answer the most frequent questions
about the security and privacy measures we implement and our compliance with global
regulations like the GDPR. For more details, check the Talarian security portal.

Compliance

Is your organization ISO 27001 certified?

Yes, we are certified under the ISO 27001 standard. The certificate is available through the Talarian
security portal.

Do you comply with GDPR and other privacy regulations?

Yes, we comply with GDPR. As a data controller, we process personal data in a fair, transparent and
secure way in accordance with our Privacy Policy. As a data processor, we process personal data
according to our Data Processing Agreement.

Security

Do you conduct independent third-party security testing?

Yes, we rely on annual third-party security assessments. The resulting reports are available
through the Talarian security portal. Also, our infrastructure is hosted on Google Cloud Platform,
which undergoes its own independent security audits.

We are certified under the CASA Tier 3 certification for Google, ensuring GPT for Work meets
Google's standards for security and privacy. Additionally, we have completed the Microsoft
publisher attestation for the Microsoft 365 App Compliance Program.

Is my data encrypted at rest and in transit?

Yes. We rely on Google's encryption-at-rest mechanism (which is based on the AES algorithm with a
key size of 256 bits). Google Cloud Platform's security infrastructure uses a common cryptographic
library called Tink, which includes the FIPS 140-2 validated module (named BoringCrypto) to
implement encryption consistently across Google Cloud.

For data in transit, we exclusively use TLS 1.2 and TLS 1.3 to ensure secure transmission. The
following data is also encrypted when in use: API keys, bulk tools configuration history (when GPT
for Work is used with Google Sheets and Excel spreadsheets) and GPT functions cache (when GPT
for Work is used with Google Sheets and cache is enabled).

https://security.talarian.io/
https://security.talarian.io/
https://security.talarian.io/
https://talarian.io/privacy-policy
https://talarian.io/data-processing-agreement
https://security.talarian.io/
https://cloud.google.com/docs/security/infrastructure/design
https://learn.microsoft.com/en-us/microsoft-365-app-certification/excel/gpt-for-excel-word?pivots=general
https://learn.microsoft.com/en-us/microsoft-365-app-certification/excel/gpt-for-excel-word?pivots=general
https://cloud.google.com/docs/security/encryption/default-encryption
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What measures are in place to prevent unauthorized access to customer data?

We restrict and monitor access to production data on an as-needed basis. We use a robust access
control policy with quarterly admin rights reviews. We enforce stringent password security policies
and enforce Multi-factor Authentication (MFA) for all our personnel.

How do you ensure secured user identification?

We offer Single Sign-On (SSO) access to GPT for Work with Microsoft 365 (for GPT for Excel Word)
or Google Workspace (for GPT for Sheets and Docs). User identification security levels are
therefore those provided by either Microsoft or Google.

How do you handle software and hardware vulnerabilities?

With respect to the devices used to develop our application: hardware and software provided to our
employees are controlled under a centralized Mobile Device Management (MDM) solution. This
allows us to control our fleet and its usage. In this respect, critical software (such as antivirus and
vulnerability management solutions) are deployed on personnel's devices and strictly controlled
via our MDM solution.

With respect to the hosting of our application: we rely on the infrastructure provided by Google Cloud
Platform (GCP) and on its vulnerability and patch management programs.

Finally, the GPT for Work application is subject to our software development lifecycle (SDLC)
process where security by design is key, from the product initiative stage until the product delivery
stage. Through our continuous integration and continuous delivery (CI/CD) process, every new
piece of application code is subject to state-of-the-art code security scanning (which includes
detecting public vulnerabilities and ensuring compliance with frameworks such as OWASP Top10).

How do you ensure data center physical security?

As our application is hosted within data centers provided by Google, the physical security of our
infrastructure is managed by Google Cloud Platform. Additional information can be found in
Google Cloud Platform's security documentation available at:
https://www.google.com/about/datacenters/data-security/.

Do you have a formal incident response plan?

Yes, as part of our ISO 27001 compliance framework, Talarian has security incident management
procedures in place. The customer notification process in the event of a data incident involving
personal identifiable information is set forth in our Data Processing Agreement.

https://www.google.com/about/datacenters/data-security/
https://talarian.io/data-processing-agreement
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Data & Privacy

What permissions are needed to use GPT for Work?

GPT for Work includes add-ons for Google Sheets and Google Docs (GPT for Sheets and Docs) as
well as add-ins for Microsoft Excel and Microsoft Word (GPT for Excel Word). GPT for Work requires
permissions to interact with these Google and Microsoft applications. Only the authorization
scopes necessary for GPT for Work's performance are requested.

Google permissions for GPT for Sheets and Docs

Authorization scope

When you install GPT for Sheets and Docs from the marketplace, you are asked to allow the
following:
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INFO

By clicking 'Allow' or 'Continue', you indicate your acceptance of the Terms of Service and
Privacy Policy of GPT for Work.

Authorization scopes Why does GPT for Work need it

See your primary Google
account email address

Required to identify the user and fetch their associated
metadata.See your personal info,

including any personal info
you've made publicly available

View and manage documents
that this application has been
installed in

Allows GPT for Work to fetch the user-selected Google Docs
content in accordance with requests launched by the user
on the application. Also allows GPT for Work to insert data
in Google Docs in response to a user's request.

View and manage spreadsheets
that this application has been
installed in

Allows GPT for Work to fetch the user-selected Google
Sheets data in accordance with requests launched by the
user on the application. Also allows GPT for Work to insert
data in Google Sheets in response to a user's request.

https://gptforwork.com/terms-of-service
https://talarian.io/privacy-policy


GPT for Work Help (Microsoft) 2025-10-22

21 / 366

Authorization scopes Why does GPT for Work need it

Connect to an external service

Required to allow GPT for Work add-on to send/retrieve
information from its backend.
Even if this authorization is described as an 'external
service', it still stays within the Google environment because
GPT for Work is hosted on Google Cloud Platform.

Display and run third-party web
content in prompts and
sidebars inside Google
applications

Required to display GPT for Work sidebars inside Google
Sheets and Google Docs.

When you enable the 'Bulk Tools' functionality, you are asked to allow the following:
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Authorization scopes Why does GPT for Work need it

See, edit, create, and
delete all your Google
Sheets spreadsheets

Allows GPT for Work to write results from AI providers into the
user's spreadsheets in response to an asynchronous user
request (through bulk tool runs).

There is unfortunately no way to limit that scope to specific
spreadsheets with the way that the Google Sheets API works.
However, GPT for Work never reads from or writes to
spreadsheets you didn't launch the add-on in.

How to review or revoke permissions

At any point in time, you can review the permissions you have granted for GPT for Sheets and
Docs. See more details here.

Microsoft Permissions for GPT for Excel Word

Authorization scope

When you install GPT for Excel Word from the marketplace, you are asked to allow the following:

https://gptforwork.com/help/gpt-for-sheets/remove-google-account-access
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INFO

By clicking Accept, you indicate your acceptance of the Terms of Service and Privacy Policy of
GPT for Work.

Authorization scopes Why does GPT for Work need it

User's email address

Required to identify the user and fetch their associated
metadata.

User basic profile information
(including name, surname,
preferred username)

OpenID (user's unique identifier
and token)

https://gptforwork.com/terms-of-service
https://talarian.io/privacy-policy
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Authorization scopes Why does GPT for Work need it

offline_access
Required to keep the user signed-in. The offline_access
scope allows GPT for Work to receive refresh tokens from
the Microsoft identity platform token endpoint.

How to review or revoke permissions

At any point in time, you can review the permissions you have granted for GPT for Excel Word. See
more details here.

How is my data processed?

Here are some details as to the customer data used by GPT for Work, and which of this data is
being stored on GPT for Work's infrastructure (i.e., Google Cloud Platform).

User identification

This includes the following stored data: username, account email address, basic profile
information, GoogleID or MicrosoftID (as applicable). No other user identification data is stored.

Documents, Inputs, Outputs and Configurations

First, let's introduce three key concepts used in this paragraph:

Documents mean the spreadsheets (Google Sheets or Microsoft Excel) and documents (Google
Docs or Microsoft Word) in which the GPT for Work add-on is used;

Inputs are the information you submit through GPT for Work. This includes:

the prompts and custom instructions you give (e.g. generating text, summarizing data or
analyzing content). When using the 'Bulk AI tools' functionality in Google Sheets or Excel, you
can configure these prompts and instructions, and these configurations are saved in your
history for easy reuse (Configurations); and

the portion of the Documents submitted along with these prompts and instructions (e.g.
relevant cells of your spreadsheets and parts of your documents) (Submitted Document
Portions). To avoid any doubt, Configurations do not contain any Submitted Document
Portions; and

Outputs are the results generated by AI providers based on your Inputs.

Here is how GPT for Work uses your Documents, Inputs, Outputs and Configurations:

Documents

https://gptforwork.com/help/gpt-for-excel/remove-microsoft-account-access
https://gptforwork.com/help/gpt-for-sheets/bulk-ai-tools


GPT for Work Help (Microsoft) 2025-10-22

25 / 366

Except when you are using the 'Agent' functionality, GPT for Work does not read or store any
data from your Documents that you do not use as an Input in your prompt.

When using the 'Agent' functionality, GPT for Work automatically selects the relevant parts of
the Document that are necessary to respond effectively to your request. As of July 21, 2025, the
'Agent' feature is available in Beta mode to a select number of users only in Google Sheets and
operates exclusively via Talarian’s own API key(s) (OpenAI's model).

GPT for Work sends your Inputs to the relevant AI provider's API or custom endpoint and writes
the resulting Outputs in your Document.

Inputs & Outputs

If you use a custom endpoint (as opposed to a model with API keys), such as on-premise
inference servers (e.g., Ollama) or an Azure endpoint, the Inputs submitted and Outputs
received do not go through our infrastructure, as the GPT for Work add-ons directly call the set
endpoint. The use of custom endpoints therefore constitutes the most private option currently
available.

If you use a model with an API key, GPT for Work does not log any of the Inputs submitted or
Outputs received. By using an API key, your AI provider usage (e.g. data retention, rate limits,
cost, moderation) is bound by the terms you negotiated with your AI provider.

If you use a model without an API key, we log all the Inputs and Outputs for support purposes
for a duration of 30 days. We also store them for product improvement purposes (excluding the
training of any language model) for no longer than 1 year. Outputs and Inputs may be stored for
up to 5 years and can only be accessed on an ad hoc and as-needed basis by the authorized
personnel.

In Google Sheets only, and only if cache is enabled, Inputs and Outputs of executions made
through GPT functions are cached encrypted for a short period of time (30 days) to prevent
unexpected costs and loss of data due to Google Sheets automated recalculations. This caching
occurs regardless of whether you use a model with or without an API key.

Configurations

When you use the 'Bulk AI tools' functionality in Google Sheets or Excel, your bulk tools
Configurations are securely stored in encrypted form for a limited period (90 days) to support
the history feature.

Examples of data that may be contained in Configurations include your desired translation
glossary (if you are using the 'translate' tool) or your tailored classification instructions (if you
are using the 'classify/categorize' tool). To avoid any doubt, Configurations do not contain any
Submitted Document Portions.

Settings

These include the name of the model and the AI provider, the temperature (i.e., the setting that
controls the creativity of a model’s response), and any custom instruction you decide to insert to

https://gptforwork.com/help/gpt-for-sheets/bulk-ai-tools
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provide context and shape how the chosen model responds.

Metadata relating to your Documents

GPT for Work stores the following additional data from your Document:

Google Sheets: spreadsheets ID (identifier of the spreadsheet), sheet IDs (identifier of the sheet
within a specific spreadsheet), sheet name; and

Google Docs: Google Doc ID.

Usage metadata

These are data events corresponding to the different actions of GPT for Work users (e.g., user
clicking on the 'Run' button).

API keys and custom endpoints

If you set up API keys for AI providers or use custom endpoints, they will be stored encrypted in
transit, at rest and in use on Google Cloud Platform.

When setting up a team, space owners and admins can choose whether team members are
allowed to use their own API keys and, in GPT for Excel Word, their own custom endpoints. In other
words, space owners and admins have complete control over which AI providers and models are
available to their space members.

Subscription data

This includes the following stored data: current plan details, transaction details (amount, invoice ID
and payment date), details of the invoiced person or company (customer email and customer ID).
We do not store payment card credentials on Talarian's infrastructure and always rely on Stripe, a
third-party PCI-DSS-compliant payment processor, for payment card processing.

Is my data used by GPT for Work to train models?

No. Whether you use a model with or without an API key, Talarian does not use your Inputs and
Outputs to train language models. Also, according to their terms as of July 21, 2025, the AI
provider APIs we rely on (when using GPT for Work through Talarian's own API key(s)) currently do
not use your Inputs and Outputs to train their models.

To check the AI provider's models available with or without an API key, please see our list of
supported models.

https://gptforwork.com/help/create-team#invite-users-to-your-space
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/ai-providers-and-models
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Who owns Inputs and Outputs?

As between you and Talarian, you retain all rights in your Inputs and Outputs. More details are
available in GPT for Work terms of service.

What do you do with my API Key and custom endpoints, when I use them
within GPT for Work add-ons?

If you set up API keys for AI providers or use custom endpoints, they will be stored encrypted in
transit, at rest and in use on Google Cloud Platform.

Do you store payment card information?

We don't store payment card credentials. Payments are processed through Stripe
(https://stripe.com/en-fr). They are a PCI Service Provider Level 1 organization. Using Stripe means
we don't need to store your payment card credentials.

You can read more about security at Stripe here: https://stripe.com/docs/security/stripe.

Where is my data located?

The Google Cloud Platform datacenters on which your data is stored are located in the United
States - us-central1 region (Iowa). More details on Google Cloud Platform's region are available
here.

Do you sell any of my data?

No, we never sell data.

Do you use third-party service providers?

Yes. GPT for Work relies on or interacts with several service providers in order to operate. They fall
within 2 different categories:

Talarian's third-party service providers

These are service providers with which we hold a contractual relationship. They help us with
various services including cloud hosting, generative AI provision or support ticket management.

Whenever we share data with these service providers, we make sure that they use it in compliance
with data protection legislation, and that the personal data processing they carry out is covered by
a specific data processing contract. They are of two sorts:

Talarian's subprocessors

https://gptforwork.com/terms-of-service
https://stripe.com/en-fr
https://stripe.com/docs/security/stripe
https://cloud.google.com/compute/docs/regions-zones
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They process personal data for which we are a processor, following our instructions. This
processing is carried out as part of the services you have subscribed to. You will find details of our
subprocessors in our Data Processing Agreement.

Service provider Purpose

Google LLC or any of its affiliates Data hosting, Generative AI*

Zendesk, Inc. Support

OpenAI OpCo, LLC or any of its affiliates Generative AI*

Anthropic, PBC or any of its affiliates Generative AI*

Perplexity, Inc. Generative AI*

Functional Software, Inc. (d/b/a Sentry) Error Monitoring

* Google LLC, OpenAI OpCo, LLC, Anthropic, PBC, and Perplexity, Inc. are engaged for Generative
AI purposes only to the extent (i) you are using GPT for Work through Talarian's own API key(s) and
(ii) choose any such third-party service provider as AI provider.

Talarian's processors

They process data for which we act as the controller, and therefore act as processors.

Service provider Purpose

SalesForce, Inc. CRM

Sendinblue, SAS (d/b/a Brevo) Transactional and marketing email

Slack Technologies Limited Internal communication tool

Google Ireland Limited (Google Workspace) Collaboration tool

Microsoft Corporation (Microsoft Clarity) Front end analytics

Retool, Inc. Admin dashboards for customer support

https://talarian.io/data-processing-agreement
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Other third-party service providers

These are third-party service providers with which you hold directly a contractual relationship.
These can be of various types, notably:

AI providers that you use by creating and setting up API keys or via a custom endpoint. The full list of
these AI providers are set forth in section "Models you can use with an API key" of the following
page: https://gptforwork.com/help/ai-providers-and-models.

Payment processor. Payments are processed through Stripe (https://stripe.com/en-fr), which is a
PCI Service Provider Level 1 organization. By purchasing GPT for Work you accept to be bound
by the Stripe terms and conditions (https://stripe.com/en-fr/legal/consumer).

Can I have my data deleted?

Yes, you can.

As long as your GPT for Work account is active, we retain your data in accordance with our Privacy
policy and Data Processing Agreement. Upon deletion of your GPT for Work account, we may
archive your data only for a specified period of time in accordance with our internal data retention
policy, and in any case no longer than legally permitted.

To request all your data to be deleted following deletion of your GPT for Work account, submit
your request via our contact form and write 'Data Deletion request' as the subject line.

Deleting your data will interrupt GPT for Work's functionality. Signing up again with the same
Google or Microsoft account will not restore the deleted data.

How can I send you a privacy complaint?

For privacy complaints, you can reach us at: legal@talarian.io.

https://gptforwork.com/help/ai-providers-and-models
https://stripe.com/en-fr
https://stripe.com/en-fr/legal/consumer
https://talarian.io/privacy-policy
https://talarian.io/privacy-policy
https://talarian.io/data-processing-agreement
https://support.gptforwork.com/hc/en-us/requests/new?ticket_form_id=8184677501596
mailto:legal@talarian.io
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Create a team
You can create a team in GPT for Work so that all team members can use the add-ons with shared
billing and optionally shared API keys.

To set up your team:

Create a GPT for Work account

INFO

If you already have a GPT for Work account, skip to Set up your space.

Microsoft

You have created the GPT for Work account. The account comes with a space that you own.

Set up your space

Before inviting users, set up your space to provide access to the necessary models:

Manage API keys for your space.

Control whether users can set up their own API endpoints.

Set up the model switcher, and set a default model.

Invite users to your space

You are the owner or an admin of the space.

Create a GPT for Work account (if you don't already have one).1

Set up your space.2

Invite users to your space.3

Open the GPT for Work dashboard.1

Click Sign in with Microsoft.2

Choose the Microsoft account you want to associate with the GPT for Work account.3

Click Continue to sign in with your Microsoft account.4

Prerequisites

https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/concepts#model
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space#control-whether-users-can-set-up-api-endpoints
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://dashboard.gptforwork.com/
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Microsoft

You have successfully invited users to your space. You can resend or cancel an invitation while its
status remains Pending.

What's next

Install the add-ons on your domain or have your team members install the add-ons individually.

Manage API keys, API endpoints, and models for your space.

Manage users in your team.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

Click Invite users.3

Enter the email addresses of the users you want to invite, separated by commas or spaces.4

Click Send invitations.5

https://gptforwork.com/help/install
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/manage-users-in-your-team
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Manage available models for your team
As a space owner or admin, you can centralize AI model access and billing for your team by setting
API keys, configuring API endpoints, and enabling and disabling individual models for your space.
This allows you to create a curated set of models available to your team.

Manage API keys

Manage space API keys and control whether users can set their own API keys from the GPT for Work
dashboard.

Manage API endpoints

Manage space API endpoints and control whether users can set their own API endpoints from the GPT for
Work dashboard.

Manage models

Configure which AI models are available to users in your team space from the GPT for Work dashboard.

https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
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Manage API keys for your space
As a space owner or admin, you can manage API keys for your team by setting shared space keys
and controlling whether users can set their own keys. This allows users to access models without
providing their own keys, gives you control over which models are available, and centralizes billing.

Set space API keys

Set a space API key to give users access to additional models without extra cost to them. Users can
still use their own keys to access models, unless you disallow this.

You are the owner or an admin of the space.

Microsoft

Prerequisites

Create an API key, or request an API key from your AI provider platform admin. Learn more.

INFO

Make sure your keys belong to an organization or project with the following rate limits:

The actual limits required depend on your team's workload requirements.

1

RPM (requests per minute) ≥ 1,000

TPM (tokens per minute) ≥ 1,000,000

Sign in to the GPT for Work dashboard with your Microsoft account.2

In the sidebar, select API keys.3

Select Configure space API keys.4

https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/concepts#model
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#create
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft


GPT for Work Help (Microsoft) 2025-10-22

34 / 366

You have set a space API key. All space users can now use any model available with the key in GPT
for Excel or GPT for Word.

Control whether users can set API keys

Choose whether space users can set their own API keys. If you enable this option, users can
override a space key with their own key for any AI provider. If you disable this option, users can
only use models that do not require API keys or models available through space API keys.

Click the AI provider whose API key you want to set.5

Set the API key:6

i. In the text field, enter the key.1

ii. Click Check to verify that the key is valid.2

iii. Click Save.3

https://gptforwork.com/help/ai-providers-and-models#tk
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You are the owner or an admin of the space.

Microsoft

What's next

Microsoft

Manage API endpoints for your space.

Manage models for your space.

Invite users to your space.

Manage users in your team.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API keys.2

Use the toggle to allow or disallow space users to use their own API keys.3

https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/create-team#invite-users-to-your-space
https://gptforwork.com/help/manage-users-in-your-team
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Manage API endpoints for your space
As a space owner or admin, you can make additional models available to your team by setting up
API endpoint connections for your space. You can also control whether users can set up their own
endpoints.

NOTE

This feature is available only for Microsoft accounts.

Connect to Azure OpenAI

GPT for Excel and Word can connect to Azure AI to use OpenAI models.

You are the owner or an admin of the space.

You have an Azure subscription with Azure AI service access.

You have deployed a model in an Azure OpenAI resource.

Get your Azure OpenAI endpoint details

To connect to Azure AI from GPT for Excel and Word, you need the endpoint URL, name, and API
key for the Azure OpenAI model you want to use.

Prerequisites

Sign in to Azure AI Foundry.1

Select the Azure OpenAI resource that has the model you want to use.2

https://azure.microsoft.com/en-us/products/ai-services
https://learn.microsoft.com/en-us/azure/ai-foundry/foundry-models/concepts/models-sold-directly-by-azure
https://azure.microsoft.com/en-us/pricing/purchase-options/azure-account
https://learn.microsoft.com/en-us/azure/ai-foundry/openai/how-to/create-resource
https://ai.azure.com/
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In the sidebar, select My assets > Models + endpoints.3

In Model deployments, in the models list, click the name of the model you want to use.4
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Set up the Azure OpenAI endpoint

In the model details, copy the Target URI, Key, and Model name.5

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click Azure OpenAI endpoints.3

https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Define the endpoint settings:4

Endpoint URL: Enter the endpoint URL for the model.

Model name: Enter the model name.

API key: Enter the API key for accessing the endpoint.

Display name (optional): Enter a custom display name for the model. If not set, the model
switcher uses Model name as the display name.

Click Check to validate the settings, and click Save.5
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You have set up the Azure OpenAI endpoint. All space users can now use the endpoint model in
GPT for Excel and Word.

TIP

To define another Azure OpenAI endpoint with a different model, click Add another Azure
OpenAI endpoint and repeat steps 4 and 5.

Control whether users can set up API endpoints

Choose whether space users can set up their own API endpoints. If you enable this option, users
can connect to their own endpoints from GPT for Excel and Word. If you disable this option, users
are limited to the endpoints you set up for the space.

You are the owner or an admin of the space.

What's next

Manage API keys for your space.

Manage models for your space.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Use the toggle to allow or disallow space users to set up their own API endpoints.3

https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft


GPT for Work Help (Microsoft) 2025-10-22

41 / 366

Manage users in your team.

https://gptforwork.com/help/manage-users-in-your-team
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Manage models for your space
As a space owner or admin, you can control which AI models are available to your team. This
standardizes model access for your team and allows you to control costs.

NOTE

This feature is available only for Microsoft accounts.

You are the owner or an admin of the space.

Enable or disable models

You can enable or disable individual models for your team. This controls which models are
available to your team in the add-in.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Models.2

Use the toggle next to a model to enable or disable the model.

NOTE

Models without an API key are not available with your subscription.

3

https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft?platform=microsoft
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Your team can only select the enabled models in the add-ins.

Set a default model

You can choose which model is selected by default for new users. This allows you to standardize
the model that users start with when they open the add-in for the first time.

The model is automatically selected as the default model for new users who open the add-in for
the first time.

Manage access to future models

You can choose whether newly integrated models are automatically available to your team.
Disabling automatic access to new models allows you to evaluate them before making them
available to your team.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Models.2

Find the model you want to set as the default, and click Make default for the model.3

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Models.2

In the Other settings section, use the Enable new models by default toggle to enable or
disable automatic access to new models.

NOTE

When this setting is disabled, new models remain unavailable to your team until you
manually enable them.

3

https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft?platform=microsoft
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft?platform=microsoft
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This setting now applies to all future models for your team.

What's next

Invite users to your space.

Manage users in your team.

https://gptforwork.com/help/create-team#invite-users-to-your-space
https://gptforwork.com/help/manage-users-in-your-team
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Manage users in your team
Once you have created a team by inviting users to your space, you can perform several operations
to manage your team. You can add new users or remove existing ones, grant admin privileges to
trusted team members to help with space management, and transfer ownership to another user
when needed.

Add / Remove users

Add or remove users from your GPT for Work space to ensure only the right people have access to your
space's shared billing and API keys.

Promote users to admins

Promote a user to admin in a team space in GPT for Work to give them access to all the dashboard
features.

Transfer ownership

Transfer the ownership of your team space to another user in GPT for Work.

https://gptforwork.com/help/manage-users-in-your-team/add-remove-users
https://gptforwork.com/help/manage-users-in-your-team/promote-user-to-admin
https://gptforwork.com/help/manage-users-in-your-team/transfer-ownership-of-space
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Add / Remove users
As your team grows and changes, you can add or remove users from your GPT for Work space to
ensure only the right people have access to your space's shared billing and API keys.

You are the owner or an admin of the space.

Add users to your team

You can add users to your team at any time by inviting them to your space in GPT for Work.

Microsoft

You have successfully invited users to your space. You can resend or cancel an invitation while its
status remains Pending.

Remove users from your team

You can remove users from your team at any time by removing them from your space in GPT for
Work.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

Click Invite users.3

Enter the email addresses of the users you want to invite, separated by commas or spaces.4

Click Send invitations.5

https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/concepts#space
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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When you remove a user from a GPT for Work team space, they can still use the add-ons. However,
they are no longer able to use the space balance or subscription, or the space API keys.

INFO

The space owner cannot be removed. If you want to remove the space owner from the team,
you must transfer ownership to another user first.

Microsoft

You have successfully removed the user from the space. When they next sign in to the dashboard,
they only see their personal space, not your team space.

What's next

Promote a user to admin.

Transfer the ownership of a team space.

Sign in to the GPT for Work dashboard with your account.1

In the sidebar, select Users.2

Click the three horizontal dots (...) next to the user you want to remove, then select Remove
user, or Cancel invitation if the user hasn't accepted the invitation to the space.

3

https://gptforwork.com/help/manage-users-in-your-team/transfer-ownership-of-space
https://gptforwork.com/help/manage-users-in-your-team/promote-user-to-admin
https://gptforwork.com/help/manage-users-in-your-team/transfer-ownership-of-space
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Promote users to admins
You can promote a user to admin in a team space in GPT for Work to give them access to all the
dashboard features. Admin users can do everything the owner can do, except transfer the
ownership of a space.

You are the owner or an admin of the space.

Microsoft

You have successfully promoted the user to admin. They can now access all the dashboard
features.

INFO

You can revoke admin permissions at any time by clicking the three horizontal dots (...) in the
admin user's row, then selecting Remove admin role.

What's next

Remove a user from your team space.

Transfer the ownership of your team space.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

Click the three horizontal dots (...) next to the user you want to promote, then select Set as
admin.

3

https://gptforwork.com/help/manage-users-in-your-team/add-remove-users#remove-users-from-your-team
https://gptforwork.com/help/manage-users-in-your-team/transfer-ownership-of-space
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Transfer the ownership of your team space
As the space owner, you can transfer the ownership of your team space in GPT for Work to any
other user in the team. After the transfer, the new owner takes full control of the space, and you
remain in the space as an admin.

You are the owner of the space.

Microsoft

You have successfully transferred the ownership of the space to the user. You remain in the space
as an admin.

What's next

Manage users in your team.

Manage API keys, API endpoints, and models for your space.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Settings.2

In the Transfer ownership section, select the user to whom you want to transfer the
ownership.

3

Click Save to confirm.4

https://gptforwork.com/help/manage-users-in-your-team
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://dashboard.gptforwork.com/
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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Install GPT for Work add-ons

Install GPT for Sheets and Docs Install GPT for Excel and Word

For detailed installation instructions, see below.

Microsoft

To use GPT for Work in Microsoft Excel or Microsoft Word, you need to install the GPT for Excel
Word add-in. One installation covers both applications and environments.

Excel: Compatible versions by platform

The following table lists the minimum versions of Microsoft Excel compatible with the GPT
for Excel add-in on different Microsoft Office platforms.

Windows Mac Online

Microsoft 365 subscription:

Version 2002 (Build
12527.20092)

Retail perpetual:

Version 2002 (Build
12527.20092)

Volume-licensed perpetual:

Excel 2021: Version 2108 (Build
12527.20092)

Version 16.35 (Build
20030802)

Supported on:

Google Chrome
(latest version)

Microsoft Edge
(latest version)

Which version of Excel am I using?

Word: Compatible versions by platform

The following table lists the minimum versions of Microsoft Word compatible with the GPT
for Word add-in on different Microsoft Office platforms.

Prerequisites

https://workspace.google.com/marketplace/app/gpt_for_sheets_and_docs/677318054654?utm_medium=website&utm_source=help-install
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-install&src=website&mktcmpid=help-install
https://gptforwork.com/help/gpt-for-excel/faq#my-excel
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Windows Mac Online

Microsoft 365 subscription:

Version 2205 (Build
15202.10000)

Retail perpetual:

Version 2205 (Build
15202.10000)

Volume-licensed perpetual:

Word 2024: Version 2205 (Build
15202.10000)

Version 16.61 (Build
22040100)

Supported on:

Google Chrome
(latest version)

Microsoft Edge
(latest version)

Which version of Word am I using?

Go to the installation page.1

Click Open in Excel or Open in Word.

INFO

The add-in will be installed on your Microsoft account for both Excel and Word.

A pop-up appears at the top of the window, requesting your permission to proceed.

2

https://gptforwork.com/help/gpt-for-word/faq#my-word
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502
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You have installed GPT for Excel Word on your Microsoft account. The add-in is now available from
the Home tab on the desktop app and the Web version of Excel and Word. If you don't see it, go to
Home > Add-ins > My add-ins > GPT for Excel Word.

Confirm to open the Microsoft Excel or Word desktop app.

INFO

If this method doesn't work, proceed as follows:

3

i. Open Microsoft Excel or Word.1

ii. Click Add-ins from the Home tab.2

iii. Search for "Talarian", the maker of GPT for Excel Word.3

iv. In the search results, click Add for GPT for Excel Word.4

Click Accept and Continue to accept the permissions.4
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What's next

Microsoft

Open GPT for Excel / GPT for Word.
Learn about GPT for Excel / GPT for Word.
Select a model in GPT for Excel / GPT for Word.
Start using bulk AI tools and GPT functions in GPT for Excel.
Start authoring text with GPT for Word.

https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=word
https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/ai-models/select-model?app=excel
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/start-using-gpt-functions
https://gptforwork.com/help/gpt-for-word/author-text
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Open GPT for Work add-ons
MS Excel

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

What's next
Sign in with Microsoft.

If you run into issues, see our troubleshooting guide.

MS Word

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

What's next
Sign in with Microsoft.

https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft?app=microsoft
https://gptforwork.com/help/gpt-for-excel/troubleshooting/add-in-not-working
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft?app=microsoft
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If you run into issues, see our troubleshooting guide.

https://gptforwork.com/help/gpt-for-word/troubleshooting
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Sign in to GPT for Work
Whether you're using Google Sheets or Docs, or Microsoft Excel or Word, this section explains how
GPT for Work authenticates your user account, how to check which account you're using, and how
to switch between accounts or sign out if needed.

Sign in with Google or Microsoft

How to sign in to GPT for Work via Google and Microsoft authentication systems.

Check which account you are using

How to check which Google or Microsoft account GPT for Work is using.

Switch to another account

Use a different Google or Microsoft account with GPT for Work.

Sign out from GPT for Excel and Word

How to sign out from GPT for Work when using Microsoft Excel and Word.

https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
https://gptforwork.com/help/sign-in/check-which-account-you-are-using
https://gptforwork.com/help/sign-in/switch-to-another-account
https://gptforwork.com/help/sign-in/sign-out-from-gpt-for-excel-and-word
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Sign in with Google or Microsoft
You need a Google account to use GPT for Sheets and Docs.

You need a Microsoft account to use GPT for Excel and Word.

Microsoft

When you launch the GPT for Excel Word add-ins:

From a web version of Excel or Word: You need to sign in with your Microsoft account when
you first launch the add-in.

From a desktop version of Excel or Word:

If you're already signed in with your Microsoft account, the add-in automatically uses that
account.

If you're not signed in or using multiple accounts, the add-in prompts you to choose an
account.

If you have multiple Microsoft accounts, such as a personal account and a work account, you can
switch between them to ensure you are using the correct account in GPT for Work.

What's next

Check which account is used by GPT for Work.

If needed, switch to another account.

https://gptforwork.com/help/
https://gptforwork.com/help/
https://gptforwork.com/help/sign-in/switch-to-another-account?platform=microsoft
https://gptforwork.com/help/sign-in/check-which-account-you-are-using
https://gptforwork.com/help/sign-in/switch-to-another-account
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Check which account you are using
To check which Google or Microsoft account you are using in GPT for Work:

Microsoft

Open a Microsoft Excel workbook or Word document.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2
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What's next

If needed, switch to another account.

In the sidebar, open the main menu. Your account is displayed at the bottom of the menu.3

https://gptforwork.com/help/sign-in/switch-to-another-account
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Switch to another account
If the account currently used by GPT for Work is not the one you want to use, switch to another
account:

Microsoft

You have switched to another account. You can now launch and use GPT for Work with the new
account.

TIP

If you signed in with the wrong account during installation, contact support to request an
account transfer.

Launch Excel or Word.1

In the upper-right corner of the application, click your account icon or picture.2

Select the account you want to switch to.

INFO

If the account you want to switch to is not in the list, click to add a new account and
complete the sign-in process.

3

If you are using the desktop version of Excel or Word, close the application and reopen it.4

https://support.gptforwork.com/hc/en-us/requests/new
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Sign out from GPT for Excel and Word
To sign out from GPT for Excel and Word:

Open a Microsoft Excel workbook or Word document.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

In the sidebar, open the main menu. Then, select Log out.3
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NOTE

Signing out from GPT for Excel also signs you out from GPT for Word since they use the same
Microsoft account session.

You have signed out from GPT for Excel and Word. You'll need to sign in again when you next
launch the add-in.

What's next

Sign in with Google or Microsoft

https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft
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AI models
Models are the engines that power GPT for Work. Which model is the right one depends on your
specific needs in terms of response quality, speed, privacy, and cost. GPT for Work supports
models from Anthropic, Azure, DeepSeek, Google, Mistral, OpenAI, OpenRouter, Perplexity, and
xAI. GPT for Work also supports open-source models through Ollama and any OpenAI-compatible
API endpoint.

NOTE

As a space owner or admin (Microsoft accounts only), you can control which models are
available to users in your space through the Models section of the dashboard.

The following table summarizes the different kinds of models available in GPT for Work from zero
set up to more advanced options:

Use Setup When
Available

for

Models
without an
API key

None.

Use the default
model or select a
different model.

You want to get started quickly
without setting up API keys.

✅ Available models

Excel,
Sheets,
Word, Docs

https://gptforwork.com/help/concepts#model
https://gptforwork.com/help/
https://www.anthropic.com/
https://azure.microsoft.com/en-us/
https://www.deepseek.com/en
https://ai.google/
https://mistral.ai/
https://openai.com/
https://openrouter.ai/
https://www.perplexity.ai/
https://x.ai/
https://ollama.com/
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://gptforwork.com/help/ai-providers-and-models#api-endpoints
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/ai-providers-and-models#tk
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Use Setup When
Available

for

Models with
an API key 🔑

AI provider models:

Set an API key for an
AI provider.

You want to benefit from the
terms of service you have with an
AI provider, such as cost, privacy,
and rate limits.
You want to use a model that is
not available without an API key.
You want more control.

✅ Available models

Excel,
Sheets,
Word, Docs

OpenRouter
models:

Set an API key for
OpenRouter.

You want to access models from
different providers without
managing multiple API keys.
You want to use models that are
only available through
OpenRouter.

✅ Available models

Excel,
Sheets,
Word

OpenAI Assistants:

Create an OpenAI
Assistant and set an
OpenAI API key.

You need to add custom
capabilities to a model.

You want to upload your own files
as knowledge for the AI.

Excel,
Sheets

Models from
cloud
endpoints

Azure OpenAI
models:

Set up an Azure
OpenAI endpoint.

Your company is already using
Azure with a consumption
commitment. Using Azure OpenAI
counts towards that commitment.
You want to use models that are
available through Azure OpenAI.

✅ Available models

Excel, Word

OpenAI-compatible
models:

Set up an OpenAI-
compatible platform
endpoint.

You want to use models available
on a cloud-based LLM platform
such as Anyscale or Fireworks AI.
You need a fast and powerful
inference infrastructure that scales
to your performance needs.

Excel, Word

https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/ai-models/connect-to-openrouter-from-excel-sheets-and-word
https://gptforwork.com/help/ai-models/connect-to-openrouter-from-excel-sheets-and-word
https://openrouter.ai/models
https://gptforwork.com/help/ai-models/connect-to-openai-assistants-from-excel-and-sheets
https://gptforwork.com/help/ai-models/connect-to-openai-assistants-from-excel-and-sheets
https://gptforwork.com/help/ai-models/connect-to-openai-assistants-from-excel-and-sheets
https://gptforwork.com/help/ai-models/connect-to-azure-openai-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-azure-openai-from-excel-and-word
https://learn.microsoft.com/en-us/azure/ai-foundry/foundry-models/concepts/models-sold-directly-by-azure
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://www.anyscale.com/
https://fireworks.ai/
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Use Setup When
Available

for

Local models

OpenAI-compatible
models:

Set up an OpenAI-
compatible server
endpoint.

You want to use models available
on a local LLM server such as LM
Studio.
You want to run models on a local
machine.
You do not want to send or receive
any prompt or response data over
the internet.

Excel, Word

Ollama models:

Set up an Ollama
endpoint.

You want to use models available
through Ollama.
You want to run models on a local
machine.

You do not want to send or receive
any prompt or response data over
the internet.

✅ Available models

Excel, Word

What's next

Get started with the option that works best for you:

Select a model.

Set and manage your API keys.

Use OpenRouter models.

Use OpenAI Assistants.

Use OpenAI-compatible models through API endpoints.

Use Ollama models.

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://lmstudio.ai/
https://lmstudio.ai/
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://ollama.com/library
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models/connect-to-openrouter-from-excel-sheets-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-assistants-from-excel-and-sheets
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
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Select a model
GPT for Work supports a range of models that you can use for your AI work. To help you find the
model that offers the best balance of accuracy, speed, and cost for your use case, see our
recommended models.

The available models depend on:

The GPT for Work add-on you're using. For a list of supported models by add-on, see AI
providers & models.

The API keys you've set, if any. Each add-on gives you access to a default set of models
available without an API key. To access additional models, set an API key for one or more AI
providers.

Your space admin's model settings (Microsoft accounts only). If you're using GPT for Work as
part of a Microsoft team space, your space admin can control which models are available in the
add-ins. Learn more.

Select a model without an API key

MS Excel

Open a Microsoft Excel workbook.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

Expand the model switcher.3

https://gptforwork.com/help/
https://gptforwork.com/help/concepts#model
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
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GPT for Excel uses the selected model to generate all responses.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
model when you re-execute them.

To re-execute an existing formula with the new model:

The GPT_MATCH function uses text-embedding-ada-002 , not the model you select.

MS Word

Select a model.

Models that are available without any setup are listed under No API key needed.

4

i. Set the model as a parameter in the formula.1

ii. Press Enter to re-execute the formula.2

Open a Microsoft Word document.1

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_match-function
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#temperature-and-model
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

Expand the model switcher.3

Select a model.

Models that are available without any setup are listed under No API key needed.

4
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GPT for Word uses the selected model to generate all responses.

Select a model with an API key

You have set an API key for the AI provider whose model you want to use.

In Excel and Word, if you want to use an Azure model or an OpenAI-compatible model from
an API endpoint, you have set up the correct endpoint.

Prerequisites

https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models
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MS Excel

Open a Microsoft Excel workbook.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

Expand the model switcher.3

Select a model with a key icon.

Models that are available with an API key are listed under Use your API key or endpoint and
have a key icon in front of their name.

4
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GPT for Excel uses the selected model to generate all responses.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
model when you re-execute them.

To re-execute an existing formula with the new model:

The GPT_MATCH function uses text-embedding-ada-002 , not the model you select.

MS Word

i. Set the model as a parameter in the formula.1

ii. Press Enter to re-execute the formula.2

Open a Microsoft Word document.1

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_match-function
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#temperature-and-model
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

Expand the model switcher.3

Select a model with a key icon.

Models that are available with an API key are listed under Use your API key or endpoint and
have a key icon in front of their name.

4
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GPT for Word uses the selected model to generate all responses.

Recommended models

As a general rule, OpenAI models are more reliable and less likely to decline prompts than models
from other providers.

The following table lists our recommended models available without an API key. For more
information about which add-on supports which models, see AI providers & models.

https://gptforwork.com/help/ai-providers-and-models
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Model Provider Description

gpt-4o OpenAI
Best overall balance of easy prompting, speed, quality,
reliability, and cost. Recommended for most use cases.

gpt-4.1-mini OpenAI
Fast, cost-effective model with strong reasoning and
language capabilities. Follows instructions closely.

gpt-5-mini OpenAI
Fast, cost-effective reasoning (with low or medium reasoning
effort). Great for analysis tasks.

gpt-4.1 OpenAI
Exceptionally strong at image understanding. Learn more
about vision models.

claude-4-
sonnet

Anthropic
Great at content creation, summarization, and nuanced
reasoning across a wide range of tasks. Recommended
with GPT for Word.

gemini-2.5-
flash

Google
Cost-effective model ideal for lightweight tasks and rapid
responses. Supports reasoning, web search, and web
scraping (enabled from the model settings).

sonar Perplexity
Cost-effective search model optimized for simple queries.
Grounded in recent web search data.

sonar-
reasoning

Perplexity
Advanced search model designed for complex queries.
Grounded in recent web search data with enhanced
reasoning for more accurate answers.

To learn more about a model, hover over the model name in the model switcher. A tooltip opens
with detailed information about the model.

https://gptforwork.com/help/ai-providers-and-models#vision-models
https://gptforwork.com/help/ai-providers-and-models#vision-models
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What's next

Learn more about models:

List of supported models

LiveBench (a good model benchmark)

Put your selected model to use:

MS Excel

Use bulk AI tools to run prompts on entire spreadsheet columns at once without writing any
formulas.

Use GPT functions to run prompts from inside spreadsheet cells.

MS Word

Author text with AI.

https://gptforwork.com/help/ai-providers-and-models
https://livebench.ai/
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions
https://gptforwork.com/help/gpt-for-word/author-text
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Set and manage API keys
Using API keys offers several benefits:

More models. Access a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage your AI usage and costs directly on the AI provider's
platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key.
For more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

If you're on a subscription plan, using an API key is mandatory since you do not have access to
models without a key.

API key levels

API keys in GPT for Work can be set at two different levels:

For a specific user: When you set API keys for your own use, they work only for you. Only you
have access to models associated with the keys, and only you can set and manage the keys.

For all space users: When you set API keys for your space, they work for all users in the space.
Space users automatically have access to models associated with the keys, but only the space
owner and admins can set and manage the keys. Billing for a space key reflects its usage by all
space users. Learn more.

If keys are set at both levels for the same AI provider, the specific user key overrides the space key.

Create API keys

INFO

Make sure your keys belong to an organization or project with the following rate limits:

RPM (requests per minute) ≥ 1,000

TPM (tokens per minute) ≥ 1,000,000

The actual limits required depend on your workload requirements.

To create an API key, go to the AI provider's platform and follow their instructions:

https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/security-privacy-faq#how-is-my-data-processed
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
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OpenAI Platform for GPT models, fine-tuned models, and OpenAI Assistants

Anthropic Console for Claude models

DeepSeek Platform for DeepSeek models

Google AI Studio for Gemini models

Mistral AI for Mistral models

OpenRouter for access to various models from different AI providers using a single API key

Perplexity for Perplexity models

xAI Cloud Console for xAI models

Set your own API keys

NOTE

You can set your own API keys only if your space allows it.

TIP

If you want to share an API key with your space users, set it at space level.

MS Excel

Open a Microsoft Excel workbook.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

https://platform.openai.com/api-keys
https://console.anthropic.com/settings/keys
https://platform.deepseek.com/api_keys
https://aistudio.google.com/app/apikey
https://admin.mistral.ai/organization/api-keys
https://openrouter.ai/settings/keys
https://www.perplexity.ai/account/api/keys
https://console.x.ai/
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space#control-whether-users-can-set-api-keys
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
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In the sidebar menu, select API keys & endpoints.3
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You have set the API key. You can now use any model available with the key in GPT for Excel.

MS Word

In the Your API keys tab, enter your API key in the appropriate field and click Save.

NOTE

If the AI provider already has a space API key set, you can override the key with your own
API key by clicking Set your own and entering and saving your key.

4

Open a Microsoft Word document.1
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

In the sidebar menu, select Manage API keys.3
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You have set the API key. You can now use any model available with the key in GPT for Word.

In the Your API keys tab, enter your API key in the appropriate field and click Save.

NOTE

If the AI provider already has a space API key set, you can override the key with your own
API key by clicking Set your own and entering and saving your key.

4
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Manage API keys

Check which level of API key you're using

You can check whether you're using your own API key or a space API key for a specific AI provider.

MS Excel

In the sidebar menu, select API keys & endpoints.1
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Check the text in the AI provider's API key field:

Field text What it means Example

Using space
key

You're using the space API key for
the AI provider.

xxxxx...
You're using your own API key for
the AI provider.

2
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MS Word

In the sidebar menu, select Manage API keys.1

Check the text in the AI provider's API key field:

Field text What it means Example

Using space
key

You're using the space API key for
the AI provider.

2
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Switch to a space API key

The space owner has set the space API key.

If you're currently using your own API key for an AI provider but want to switch to using the space
API key for the same provider, delete the your own key from GPT for Work.

Field text What it means Example

xxxxx...
You're using your own API key for
the AI provider.

Prerequisites

https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
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MS Excel

In the sidebar menu, select API keys & endpoints.1

Click Remove for the API key you want to delete.2
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You're now using the space API key for the AI provider.

MS Word

Click Remove API key to verify.

The API key defaults to the space API key.

3

In the sidebar menu, select Manage API keys.1
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You're now using the space API key for the AI provider.

Switch to your own API key

If you're currently using the space API key for an AI provider but want to switch to using your own
API key for the same provider, simply set the your own key in GPT for Work. A user key always
overrides a space key.

Troubleshoot OpenAI API keys

You can use our API key checker to verify that your OpenAI API key is working.

Click Remove for the API key you want to delete.2

Click Remove API key to verify.

The API key defaults to the space API key.

3
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The results show the status of your OpenAI API key and the models and Assistants available
through the key.

If your API key is not working, check on the OpenAI Platform that the key's permissions aren't
restricted. The following permissions are required:

Permission Description

Models List available models.

Model capabilities Use model capabilities, such as chat completion.

Assistants Connect OpenAI Assistants to Google Sheets or Microsoft Excel.

Fine-tuning Connect OpenAI fine-tuned models to Google Sheets or Microsoft Excel.

Files Use OpenAI Assistants with file search.

What's next

Check which models you can use with an API key.

Select a model with an API key.

Open the OpenAI API key checker and click Use template.

Google Sheets creates a copy of the spreadsheet in your Google drive and opens the
spreadsheet for editing.

1

Enter your OpenAI API key in cell B12.2

https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/ai-models/connect-to-openai-assistants-from-excel-and-sheets
https://platform.openai.com/api-keys
https://gptforwork.com/help/train-gpt-for-work-on-files
https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/ai-models/select-model#select-byok
https://docs.google.com/spreadsheets/d/1l9MjOcNJH5PDWAeJUvSHfPGNYp3xCRRJNk1WolSReo0/template/preview
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Need to use your own LLM service endpoint for models?

Connect to an OpenAI-compatible endpoint.

Connect to an Ollama server.

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
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Connect to Azure OpenAI from Excel and
Word
GPT for Excel and Word can connect to Azure AI to use OpenAI models. You can connect to and use
a single model at a time.

Your space allows users to set up their own API endpoints.

You have an Azure subscription with Azure AI service access.

You have deployed a model in an Azure OpenAI resource.

Get your Azure OpenAI endpoint details

To connect to Azure AI from GPT for Excel and Word, you need the endpoint URL, name, and API
key for the Azure OpenAI model you want to use.

Prerequisites

Sign in to Azure AI Foundry.1

Select the Azure OpenAI resource that has the model you want to use.2

In the sidebar, select My assets > Models + endpoints.3

https://azure.microsoft.com/en-us/products/ai-services
https://learn.microsoft.com/en-us/azure/ai-foundry/foundry-models/concepts/models-sold-directly-by-azure
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space#control-whether-users-can-set-up-api-endpoints
https://azure.microsoft.com/en-us/pricing/purchase-options/azure-account
https://learn.microsoft.com/en-us/azure/ai-foundry/openai/how-to/create-resource
https://ai.azure.com/
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In Model deployments, in the models list, click the name of the model you want to use.4
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Set up the Azure OpenAI endpoint

MS Excel

In the model details, copy the Target URI, Key, and Model name.5

Open a Microsoft Excel workbook.1
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

In the sidebar menu, select API keys & endpoints.3
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You have set up the Azure OpenAI endpoint in GPT for . You can now select the model available
through the endpoint.

MS Word

Select the endpoints tab.4

In the Azure endpoint section, define the endpoint settings:5

Endpoint URL: Enter the endpoint URL for the model.

Model ID: Enter the model name. GPT for Excel uses the name as the model's display name
in the model switcher.

API key: Enter the API key for accessing the endpoint.

Click Check to validate the settings, and click Save.6

Open a Microsoft Word document.1
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

In the sidebar menu, select API keys & endpoints.3

Select the endpoints tab.4

In the Azure endpoint section, define the endpoint settings:5

Endpoint URL: Enter the endpoint URL for the model.
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You have set up the Azure OpenAI endpoint in GPT for . You can now select the model available
through the endpoint.

Model ID: Enter the model name. GPT for Word uses the name as the model's display name
in the model switcher.

API key: Enter the API key for accessing the endpoint.

Click Check to validate the settings, and click Save.6
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Select the Azure OpenAI model

MS Excel

GPT for Excel now uses the selected model to generate all responses.

MS Word

GPT for Word now uses the selected model to generate all responses.

Expand the model switcher. You can find the model under Use your API key or endpoint.1

Select the model.2

Expand the model switcher. You can find the model under Use your API key or endpoint.1

Select the model.2
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Connect to OpenRouter from Excel, Sheets,
and Word
Connecting GPT for Excel, GPT for Sheets, or GPT for Word to OpenRouter allows you to access a
wide range of AI models without having to manage multiple API keys from different providers.

Create your OpenRouter API key

Use an OpenRouter model in GPT for Work

The GPT for Work add-on now uses OpenRouter for executing bulk tools and GPT functions. You
can access a wide range of AI models from different providers through your OpenRouter account.

Sign in to your OpenRouter account.1

Open the API Keys page.2

Click Create Key.3

Enter a key name and click Create.4

Copy and save the key.5

Set your OpenRouter API key in GPT for Excel, GPT for Sheets, or GPT for Word.1

Select the OpenRouter model in the model switcher.2

https://openrouter.ai/
https://openrouter.ai/
https://openrouter.ai/keys
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set


GPT for Work Help (Microsoft) 2025-10-22

100 / 366

TIP

Visit the OpenRouter playground to test different models and compare their capabilities
before using them in your spreadsheets.

https://openrouter.ai/playground
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Connect to OpenAI Assistants from Excel
and Sheets
OpenAI Assistants provide a powerful way to customize OpenAI models for specific tasks.

This guide shows how to create an Assistant if you don't have one yet, and how to use it in GPT for
Excel or GPT for Sheets.

Create an OpenAI Assistant

The following steps show how to create an Assistant from scratch. If you already have an Assistant,
you can skip to Use an Assistant in GPT for Work.

Go to the OpenAI platform and click Create.1

Configure your Assistant:2

Name: Give your Assistant a name that describes its purpose.

Instructions: Provide detailed instructions for the Assistant's behavior and capabilities.

Model: Choose an appropriate model, typically gpt-4o . Learn more.

If you want your Assistant to use specific files for reference, use the File search feature to3

https://platform.openai.com/docs/assistants
https://platform.openai.com/assistants
https://gptforwork.com/help/ai-models/select-model
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You have created an Assistant. You can now use the Assistant in GPT for Work.

Use an OpenAI Assistant in GPT for Work

After you've created your Assistant, you can use it in GPT for Work.

attach them:

i. Enable File search and click Files.1

ii. In the file attachment screen, select the files and click Attach.2

Set your OpenAI API key in GPT for Excel or GPT for Sheets.1

https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set
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The GPT for Work add-on now uses your Assistant for executing bulk tools and GPT functions. The
Instructions as well as Temperature and Top P settings defined during the Assistant creation are
taken into account in GPT for Work.

What's next

Train GPT for Work on your files.

Select the Assistant in the model switcher.2

https://gptforwork.com/help/train-gpt-for-work-on-files
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Connect to custom GPTs from Sheets and
Excel
While custom GPTs are only available inside ChatGPT, you can easily replicate a custom GPT as an
OpenAI Assistant, which you can then use outside ChatGPT. The only difference between custom
GPTs and Assistants is that Assistants cannot search the web.

This guide shows you how to create an Assistant that replicates your custom GPT, and use it in GPT
for Excel or GPT for Sheets.

Create an Assistant based on a custom GPT

To use a custom GPT configuration in GPT for Work, you need to recreate it as an Assistant.

Edit your custom GPT in ChatGPT.1

Copy the instructions from your custom GPT.2

https://openai.com/index/introducing-gpts/
https://platform.openai.com/docs/assistants
https://chatgpt.com/gpts/mine
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Go to the OpenAI platform and create a new Assistant.3

Configure the Assistant:4

Name: Enter your custom GPT name.

Instructions: Enter your custom GPT instructions.

Model: Select gpt-4o , which is the model used by all custom GPTs.

If your custom GPT uses knowledge files, upload the same files for the Assistant:5

i. Enable File search and click Files.1

https://platform.openai.com/assistants
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You have created an Assistant that replicates your custom GPT configuration. You can now use the
Assistant in GPT for Work.

Use an Assistant in GPT for Work

After you've created your Assistant, you can use it in GPT for Work.

ii. In the file attachment screen, select the files and click Attach.2

Set your OpenAI API key in GPT for Excel or GPT for Sheets.1

https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set


GPT for Work Help (Microsoft) 2025-10-22

107 / 366

The GPT for Work extension now uses your Assistant for executing bulk tools and GPT functions,
with the same instructions and knowledge as your original custom GPT.

What's next

Train GPT for Work on your files.

Select the Assistant in the model switcher.2

https://gptforwork.com/help/train-gpt-for-work-on-files
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Connect to OpenAI-compatible API
endpoints from Excel and Word
On Microsoft Excel and Word, GPT for Work can connect to any LLM service that provides an
OpenAI-compatible API endpoint. You can connect to two main types of services: cloud-based
platforms, which provide access to models over the internet with no software installation or setup
required on your part, and local servers, which you run on a local machine, such as your own
computer or another computer on a local network. Once connected, all models available through
the service become available to use in GPT for Excel and Word.

Here are some popular services that provide an OpenAI-compatible API endpoint:

Cloud-based platforms:

Anyscale

Fireworks AI

Together AI

Local servers:

LM Studio

LocalAI

Open WebUI

Connecting to an OpenAI-compatible API endpoint in GPT for Work means configuring the
endpoint and selecting one of the models available through the endpoint.

Your space allows users to set up their own API endpoints.

You have an endpoint URL and, if needed, an API key for accessing the service.

The endpoint must support the following OpenAI-compatible API resource paths:

/v1/models

/v1/completions

NOTE

Depending on the model you use, the model settings defined in GPT for Work (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

Prerequisites

https://platform.openai.com/docs/api-reference/introduction
https://gptforwork.com/help/concepts#cloud-hosted-model
https://gptforwork.com/help/concepts#cloud-hosted-model
https://gptforwork.com/help/concepts#local-model
https://www.anyscale.com/
https://fireworks.ai/
https://www.together.ai/
https://lmstudio.ai/
https://localai.io/
https://github.com/open-webui/open-webui
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space#control-whether-users-can-set-up-api-endpoints
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Set up the API endpoint

MS Excel

Open a Microsoft Excel workbook.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2
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In the sidebar menu, select API keys & endpoints.3

Select the endpoints tab.4

In the OpenAI-compatible endpoints section, define the endpoint settings:5

Endpoint URL: Enter the URL of the service that provides the endpoint.

API key (optional): If required, enter the API key for accessing the service.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom".
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You have set up the endpoint in GPT for . You can now select models available through the
endpoint.

MS Word

Click Check to validate the settings, and click Save.

TIP

If you get an error saying that the URL is invalid, make sure that the endpoint supports:

6

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

Open a Microsoft Word document.1

https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-windows#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#enable-https-for-the-lm-studio-server
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In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

In the sidebar menu, select API keys & endpoints.3

Select the endpoints tab.4

In the OpenAI-compatible endpoints section, define the endpoint settings:5

Endpoint URL: Enter the URL of the service that provides the endpoint.
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You have set up the endpoint in GPT for . You can now select models available through the
endpoint.

API key (optional): If required, enter the API key for accessing the service.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom".

Click Check to validate the settings, and click Save.

TIP

If you get an error saying that the URL is invalid, make sure that the endpoint supports:

6

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-windows#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#enable-https-for-the-lm-studio-server
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Select a model

MS Excel

GPT for Excel now uses the selected model to generate all responses.

MS Word

Expand the model switcher. You can find the available models under Use your API key or
endpoint.

NOTE

The available models depend on the models provided by the service.

1

Select a model.2

Expand the model switcher. You can find the available models under Use your API key or1
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GPT for Word now uses the selected model to generate all responses.

endpoint.

NOTE

The available models depend on the models provided by the service.

Select a model.2
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Set up LM Studio on macOS
This guide walks you through the main steps of setting up LM Studio for use in GPT for Work on
macOS.

This guide assumes that you use GPT for Work on the same machine that hosts LM Studio.

System requirements

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up LM Studio on macOS:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

(Optional) Enable HTTPS for the LM Studio server.3

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

1

Run LM Studio.2

On the welcome screen, click Skip onboarding.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5

https://lmstudio.ai/
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://lmstudio.ai/docs/app/system-requirements
https://curl.se/
https://brew.sh/
https://openssl-library.org/
https://lmstudio.ai/download
https://lmstudio.ai/download
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3

https://lmstudio.ai/docs/app/basics
https://huggingface.co/hugging-quants/Llama-3.2-3B-Instruct-Q8_0-GGUF
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the minimum setup required to access LM Studio from GPT for Work on
the same machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for
Work provided the add-in is not running on Safari or on Microsoft Excel or Word.

If you use GPT for Work on Safari, or on Microsoft Excel or Word, enable HTTPS for the LM
Studio server.

Click the Enable CORS toggle to enable the setting.

NOTE

By default, the LM Studio server only accepts same-origin requests. Since GPT for Work
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word#set-up-the-api-endpoint
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word#set-up-the-api-endpoint
https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
http://127.0.0.1:1234/v1/models
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Enable HTTPS for the LM Studio server

The LM Studio server uses HTTP to serve models, while GPT for Work runs on HTTPS. By default,
therefore, any request from GPT for Work to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the LM Studio server accessible over HTTPS if you use GPT
for Work from:

Excel Online or Word Online on Safari

Excel for Mac (uses Safari)

Word for Mac (uses Safari)

You make the LM Studio server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the LM Studio server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \

https://developer.mozilla.org/en-US/docs/Web/Security/Mixed_content
http://127.0.0.1/
http://localhost/
https://en.wikipedia.org/wiki/Reverse_proxy
https://nginx.org/
https://developers.cloudflare.com/cloudflare-one/connections/connect-networks/
https://ngrok.com/
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The command generates two files in the current directory:

  -nodes \
  -sha256 \
  -days 365 \
  -keyout lm-studio.key \
  -out lm-studio.crt \
  -subj '/CN=127.0.0.1' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=127.0.0.1\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

lm-studio.crt : Public self-signed certificate

lm-studio.key : Private key used to sign the certificate
iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./lm-studio.crt

Create a site configuration for the LM Studio server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       127.0.0.1:1235 ssl;
        server_name  127.0.0.1;

        http2 on;

        ssl_certificate      lm-studio.crt;
        ssl_certificate_key  lm-studio.key;

        location / {
            proxy_pass  http://127.0.0.1:1234;

            # Keep connection to backend alive.
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You have enabled HTTPS for the LM Studio server.

The configuration uses port 1235  for HTTPS. Requests to https://127.0.0.1:1235  are
forwarded to the LM Studio server running at http://127.0.0.1:1234 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf 
syntax is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /v1/models  endpoint of the LM Studio server works over the HTTPS
connection:

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

4

curl -k https://127.0.0.1:1235/v1/models

{
  "data": [
    {
      ...
    },
  ],
  "object": "list"
}
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WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Work on the same
machine. You can now set https://127.0.0.1:1235  as the endpoint URL in GPT for Work,
including when the add-in is running on Safari or on Microsoft Excel or Word.

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word#set-up-the-api-endpoint
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Set up LM Studio on Windows
This guide walks you through the main steps of setting up LM Studio for use in GPT for Work on
Windows.

This guide assumes that you use GPT for Work on the same machine that hosts LM Studio.

System requirements

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up LM Studio on Windows:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer sets LM Studio to start automatically as a background service on system boot.

1

Run LM Studio.2

On the welcome screen, click Skip onboarding.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5

https://lmstudio.ai/
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://lmstudio.ai/docs/app/system-requirements
https://curl.se/windows/
https://learn.microsoft.com/en-us/powershell/scripting/install/installing-powershell-on-windows
https://lmstudio.ai/download
https://lmstudio.ai/download
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3

https://lmstudio.ai/docs/app/basics
https://huggingface.co/hugging-quants/Llama-3.2-3B-Instruct-Q8_0-GGUF
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Work on the same
machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for Work.

Click the Enable CORS toggle to enable the setting.

NOTE

By default, the LM Studio server only accepts same-origin requests. Since GPT for Work
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word#set-up-the-api-endpoint
https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
http://127.0.0.1:1234/v1/models
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Connect to Ollama from Excel and Word
On Microsoft Excel and Word, GPT for Work can connect to an Ollama server to use locally running
open-source models. Ollama is an open-source platform that allows you to easily install, run, and
serve models from a local machine, keeping your prompting entirely offline. You can use any
model from the Ollama library.

NOTE

Depending on the model you use, the model settings defined in GPT for Work (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

Connecting to Ollama in GPT for Work means setting the URL for the Ollama server and selecting
one of the models available on the server.

Your space allows users to set up their own API endpoints.

You have an Ollama server running with one or more models. For instructions on how to
set up the server, see:

Set up Ollama on macOS

Set up Ollama on Windows

Set up the Ollama endpoint

MS Excel

Prerequisites

Open a Microsoft Excel workbook.1

In the Home tab, click GPT for Excel Word.2

https://ollama.com/
https://gptforwork.com/help/concepts#local-model
https://gptforwork.com/help/concepts#local-model
https://ollama.com/library
https://gptforwork.com/help/manage-available-models/manage-api-endpoints-for-your-space#control-whether-users-can-set-up-api-endpoints
https://gptforwork.com/help/ai-models/api-endpoints/set-up-ollama-on-macos
https://gptforwork.com/help/ai-models/api-endpoints/set-up-ollama-on-windows
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INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

In the sidebar menu, select API keys & endpoints.3

Select the endpoints tab.4

In the Ollama endpoint section:5

i. Enter the URL of the Ollama server.1

ii. Click Check to validate the URL, and click Save.2
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You have set up the Ollama endpoint in GPT for . You can now select Ollama models.

MS Word

TIP

If you get an error saying that the URL is invalid, make sure that the Ollama server
supports:

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

Open a Microsoft Word document.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-windows#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#enable-https-for-the-lm-studio-server
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In the sidebar menu, select API keys & endpoints.3

Select the endpoints tab.4

In the Ollama endpoint section:5

i. Enter the URL of the Ollama server.1

ii. Click Check to validate the URL, and click Save.2
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You have set up the Ollama endpoint in GPT for . You can now select Ollama models.

Select an Ollama model

MS Excel

GPT for Excel now uses the selected model to generate all responses.

TIP

If you get an error saying that the URL is invalid, make sure that the Ollama server
supports:

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

Expand the model switcher. You can find the available models under Use your API key or
endpoint.

NOTE

The available models depend on the models installed on the Ollama server. If an Ollama
model you need is not available, install it.

1

Select a model.2

https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-windows#start-and-configure-the-lm-studio-server
https://gptforwork.com/help/ai-models/api-endpoints/set-up-lm-studio-on-macos#enable-https-for-the-lm-studio-server
https://ollama.com/library
https://ollama.com/library
https://github.com/ollama/ollama/blob/main/README.md#cli-reference
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MS Word

GPT for Word now uses the selected model to generate all responses.

Expand the model switcher. You can find the available models under Use your API key or
endpoint.

NOTE

The available models depend on the models installed on the Ollama server. If an Ollama
model you need is not available, install it.

1

Select a model.2

https://ollama.com/library
https://ollama.com/library
https://github.com/ollama/ollama/blob/main/README.md#cli-reference


GPT for Work Help (Microsoft) 2025-10-22

132 / 366

Set up Ollama on macOS
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Work on macOS.

This guide assumes that you use GPT for Work on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for recommendations)

macOS 11 Big Sur or newer

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up the Ollama server on macOS:

Install the Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

(Optional) Enable HTTPS for the server.4

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1

https://ollama.com/
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://github.com/ollama/ollama/blob/main/README.md
https://github.com/ollama/ollama/blob/main/README.md
https://curl.se/
https://brew.sh/
https://openssl-library.org/
https://ollama.com/download
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You have installed the Ollama server.

Install a model

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Enable CORS for the Ollama server

By default, the Ollama server only accepts same-origin requests. Since GPT for Work always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Open Terminal and verify that the server is running:

Response if the server is running:

2

curl http://localhost:11434

Ollama is running

Install a model from the Ollama library:

For example, to install the Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:1

https://github.com/ollama/ollama/blob/main/README.md
https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
https://ollama.com/library
https://ollama.com/library/llama3.2
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You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the minimum setup required to access the Ollama server from GPT for
Work on the same machine. You can now set http://localhost:11434  as the Ollama server
URL in GPT for Work provided the add-in is not running on Safari or on Microsoft Excel or
Word.

If you use GPT for Work on Safari, or on Microsoft Excel or Word, enable HTTPS for the Ollama
server.

For example:

# Set a single origin
launchctl setenv OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
launchctl setenv OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "*"

Allow only GPT for Work to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

Restart the server for the variable to take effect.2

Verify that the /api/tags  endpoint of the server works:

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [
    {
      ...
    }
  ]
}

https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
https://github.com/ollama/ollama/blob/main/docs/api.md#list-local-models
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Enable HTTPS for the Ollama server

The Ollama server uses HTTP to serve models, while GPT for Work runs on HTTPS. By default,
therefore, any request from GPT for Work to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the Ollama server accessible over HTTPS if you use GPT
for Work from:

Excel Online or Word Online on Safari

Excel for Mac (uses Safari)

Word for Mac (uses Safari)

You make the Ollama server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the Ollama server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \

https://developer.mozilla.org/en-US/docs/Web/Security/Mixed_content
http://127.0.0.1/
http://localhost/
https://en.wikipedia.org/wiki/Reverse_proxy
https://nginx.org/
https://developers.cloudflare.com/cloudflare-one/connections/connect-networks/
https://ngrok.com/
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The command generates two files in the current directory:

  -nodes \
  -sha256 \
  -days 365 \
  -keyout ollama.key \
  -out ollama.crt \
  -subj '/CN=localhost' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=localhost\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

ollama.crt : Public self-signed certificate

ollama.key : Private key used to sign the certificate
iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./ollama.crt

Create a site configuration for the Ollama server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       11435 ssl;
        server_name  localhost;

        http2 on;

        ssl_certificate      ollama.crt;
        ssl_certificate_key  ollama.key;

        location / {
            proxy_pass  http://localhost:11434;

            # Keep connection to backend alive.
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You have enabled HTTPS for the Ollama server.

The configuration uses port 11435  for HTTPS. Requests to https://localhost:11435
are forwarded to the Ollama server running at http://localhost:11434 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf 
syntax is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /api/tags  endpoint of the Ollama server works over the HTTPS connection:

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

4

curl -k https://localhost:11435/api/tags

{
  "models": [
    {
      ...
    }
  ]
}

https://github.com/ollama/ollama/blob/main/docs/api.md#list-local-models
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WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Work on the
same machine. You can now set https://localhost:11435  as the Ollama server URL in GPT
for Work, including when the add-in is running on Safari or on Microsoft Excel or Word.

https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
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Set up Ollama on Windows
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Work on Windows.

This guide assumes that you use GPT for Work on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for recommendations)

Windows 10 or newer (see the Ollama documentation for detailed system requirements)

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up the Ollama server on Windows:

Install the Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1

Open PowerShell as an administrator and verify that the server is running:2

curl http://localhost:11434

https://ollama.com/
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://github.com/ollama/ollama/blob/main/README.md
https://github.com/ollama/ollama/blob/main/README.md
https://github.com/ollama/ollama/blob/main/docs/windows.md
https://curl.se/windows/
https://learn.microsoft.com/en-us/powershell/scripting/install/installing-powershell-on-windows
https://ollama.com/download
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You have installed the Ollama server.

For more information about installing and managing the server on Windows, see the Ollama
documentation.

Install a model

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Response if the server is running:

NOTE

Make sure you're using curl and not an aliased command, such as Invoke-WebRequest :

If curl  has an alias, the command removes it for the current terminal session, ensuring
that subsequent curl  commands in this guide work as expected.

Ollama is running

Remove-Item alias:curl

Install a model from the Ollama library:

For example, to install the Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'

https://github.com/ollama/ollama/blob/main/docs/windows.md
https://github.com/ollama/ollama/blob/main/docs/windows.md
https://github.com/ollama/ollama/blob/main/README.md
https://ollama.com/library
https://ollama.com/library/llama3.2
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Enable CORS for the Ollama server

By default, the Ollama server only accepts same-origin requests. Since GPT for Work always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:

For example:

NOTE

By default, the setx  command sets a user variable. If you want to set a system variable,
which applies to all users of the current machine, run the command (as an administrator)
with the /m  parameter. For example:

1

# Set a single origin
setx OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
setx OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

setx OLLAMA_ORIGINS "*"

Allow only GPT for Work to make requests to the server:

setx OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

setx OLLAMA_ORIGINS "*" /m

Start the server from the Windows Start menu.2

Verify that the /api/tags  endpoint of the server works:

GPT for Work uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [

https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
https://github.com/ollama/ollama/blob/main/docs/api.md#list-local-models
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You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Work on the
same machine. You can now set http://localhost:11434  as the Ollama server URL in GPT
for Work.

    {
      ...
    }
  ]
}

https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word#set-up-the-ollama-endpoint
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Train GPT for Work on your files
INFO

Currently, only GPT for Excel and GPT for Sheets support this method.

OpenAI Assistants can be used as models in GPT for Work to tailor your results based on specific
instructions and data.

This guide shows how to generate product descriptions using customer reviews and marketing
briefs uploaded to an Assistant.

Create and set up an Assistant

To create and set up an Assistant to use your files as context for generating responses:

On the OpenAI platform, click Create to create an Assistant.1

https://platform.openai.com/docs/assistants
https://gptforwork.com/help/concepts#model
https://platform.openai.com/assistants
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You have created an Assistant and set it up to use your files as context for generating responses.

INFO

We recommend trying executions in the OpenAI Playground to understand the cost before
using it massively.

Prompt an Assistant from GPT for Work

You have set your OpenAI API key in GPT for Excel or GPT for Sheets.

To prompt an Assistant from GPT for Work:

Upload the files that you want the Assistant to use as context when generating responses:2

i. Enable File search and click Files.1

ii. In the file attachment screen, select the files and click Attach.2

Prerequisites

https://platform.openai.com/playground/assistants
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set
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In GPT for Excel or GPT for Sheets, select the Assistant in the model switcher.1

Select Bulk AI tools, and click Custom prompt.2

Enter the following prompt:3

Write a description for this product: {{A}}

In Put results in column, select B.4
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The Assistant searches for information in the files uploaded and uses it to generate content in the
selected column. The Instructions as well as Temperature and Top P settings defined during the
Assistant creation are taken into account in GPT for Work.

Click Run rows.5
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GPT for Excel
Use GPT for Excel to integrate the power and intelligence of generative AIs directly into Microsoft
Excel.

To get started with GPT for Excel, see Quickstart for spreadsheets.

Overview

GPT for Excel is a Microsoft Excel add-in that integrates the power and intelligence of generative AIs
directly into the Excel user interface.

Agent

Describe your task in plain language, and the Agent analyzes your spreadsheet data and executes the task.

Bulk AI tools

Run any operation on a whole column at once, or on a specific section of your data.

GPT functions

Use GPT functions to prompt AI from inside spreadsheet cells in Microsoft Excel.

Configuration

Save GPT for Excel parameters along with your workbook.

Search the web

Learn how to use web search models to get up-to-date information from the web.

Use images in prompts

Include images in prompts using bulk AI tools or GPT functions in Microsoft Excel.

https://gptforwork.com/help/quickstart-for-spreadsheets
https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/agent
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions
https://gptforwork.com/help/gpt-for-excel/configuration
https://gptforwork.com/help/gpt-for-excel/search-web
https://gptforwork.com/help/gpt-for-excel/use-images-in-prompts
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Troubleshooting

Troubleshoot common issues in GPT for Excel.

FAQ

How do I install GPT for Excel? ...and other questions.

Remove Microsoft account access

Remove Microsoft account access from the GPT for Excel Word add-in.

Uninstall

Remove the GPT for Excel add-in from Microsoft Excel.

https://gptforwork.com/help/gpt-for-excel/troubleshooting
https://gptforwork.com/help/gpt-for-excel/faq
https://gptforwork.com/help/gpt-for-excel/remove-microsoft-account-access
https://gptforwork.com/help/gpt-for-excel/uninstall
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Overview of GPT for Excel

Install GPT for Excel and Word

GPT for Excel is a Microsoft Excel add-in that integrates the power and intelligence of generative
AIs directly into the Excel user interface. Use your favorite AI to generate, rewrite, translate,
categorize, extract, and otherwise process text in bulk – at machine-powered scale and speed.

GPT for Excel can execute up to 1,000 prompts per minute and reliably process up to a million rows
in one go.

Use cases

Here are a few common use cases that you can easily handle with GPT for Excel:

Analyze customer sentiment by categorizing reviews and support requests based on criteria
relevant to you.

Clean up your customer relationship management (CRM) data with deduplication,
recategorization, and reformatting.

Generate SEO-optimized product descriptions from product specifications.

Grade, score, and qualify sales leads in a consolidated prospecting spreadsheet.

https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-gpt-for-excel-overview&src=website&mktcmpid=help-gpt-for-excel-overview
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Rewrite website copy to conform to copywriting best practices.

Translate product descriptions to multiple target languages while observing appropriate
localization conventions.

Write and understand spreadsheet formulas like a pro.

Features

GPT for Excel provides the following main features for using AI in spreadsheets:

Bulk AI tools

GPT functions

Formula assistant

Bulk AI tools

Bulk AI tools allow you to run prompts on an entire spreadsheet column at once without writing
any formulas. You configure and run bulk tools from the add-in sidebar.

GPT for Excel provides dedicated bulk tools for selected use cases, such as classification,
generation, and translation, as well as a generic bulk tool for custom prompts.
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Use bulk AI tools if:

You want AI responses saved as plain text in cells.

You want better tracking information about the progress of AI requests.

Your formulas regularly become stuck in the #BUSY! state.

You do not want to write formulas.

The following video shows you how to translate text with the Translate bulk tool. You simply select
the column you want to translate, enter the target language, and select the column where you
want to place the translations. You do not need to define any other settings if the default setup
meets your needs.

GPT functions

GPT functions are custom spreadsheet functions that allow you to prompt AI from inside
spreadsheet cells. GPT functions work exactly like native functions in that you can use them on
their own or combine them with other functions when creating formulas.

https://gptforwork.com/help/gpt-for-excel/troubleshooting/gpt-functions#functions-are-stuck-on-busy
https://gptforwork.com/help/concepts#function-spreadsheet
https://gptforwork.com/help/concepts#formula-spreadsheet
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GPT for Excel provides dedicated GPT functions for selected use cases, such as classification,
summarization, translation, and web search, as well as a generic GPT function for all other use
cases. You can define function-specific parameters to further refine how the AI generates
responses. You can find a list of all available functions with usage examples in the add-in sidebar.

Use GPT functions if:

You're comfortable using spreadsheet formulas and functions.

You're experimenting and exploring what you can do with GPT for Excel.
You're working with up to a few hundred cells.
You need the precise control provided by the GPT function parameters.
You need the flexibility of nested formulas or of combining GPT functions with native functions.

The following video shows you how to translate text in bulk with the GPT_TRANSLATE function.

Formula assistant

The formula assistant allows you to generate spreadsheet formulas based on plain-language
descriptions of what you want to achieve. You can also use the formula assistant to explain
existing formulas (in English).

https://gptforwork.com/help/quickstart-for-spreadsheets#use-the-formula-assistant
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The formula assistant is available in the add-in sidebar, both under Bulk AI tools and GPT
functions.

Use the formula assistant if:

You need help with creating formulas.

You want to understand what an existing formula does.

Benefits

Prompt AIs directly from inside your spreadsheets. No more copy-pasting between Excel and
AI chatbots like ChatGPT.

Run prompts in bulk, at scale, and at lightning speed. Execute up to 1,000 prompts per
minute and reliably process up to a million rows in one bulk operation.

Apply ready-made tools to specific use cases. Translate, classify, extract, reformat, and more.
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Choose from a large selection of AI models. Use models from OpenAI, Anthropic, Google, xAI,
Perplexity, or OpenRouter. You can also use your own OpenAI Assistants and even connect to
local models with Ollama or any LLM server that provides an OpenAI-compatible API.

Bring an API key to get more features at reduced cost. You do not need an API key to use
GPT for Excel, but using a key gives you access to more models, affords you more control and
privacy, and you pay a reduced service fee.

What's next

Install GPT for Excel if you have not already.

Select an AI model that best meets your needs.

Get going with bulk AI tools.

Get going with GPT functions.

Try out example use cases for different business applications and product capabilities.

https://gptforwork.com/help/install
https://gptforwork.com/help/ai-models
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/start-using-gpt-functions
https://gptforwork.com/help/use-cases-spreadsheets/business-applications
https://gptforwork.com/help/use-cases-spreadsheets/product-capabilities
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Agent in GPT for Excel
The Agent is an AI-powered chat interface that helps you accomplish spreadsheet tasks at scale.
Just describe what you need in plain language, and the Agent analyzes your spreadsheet data and
executes the task automatically.

You can use the Agent to perform bulk tasks like:

Translate to multiple languages

Search the web

Generate and autofill formulas

Learn more about what the Agent can and cannot do.

Agent in Excel for bulk processing DemoAgent in Excel for bulk processing Demo

How to use the Agent

To use the Agent in GPT for Excel:

In the Home tab, click GPT for Excel Word.1

https://www.youtube.com/watch?v=kp-eioeNUXk
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Next, the Agent:

Examples

Find out what the Agent can do with the examples below. You can try these examples, and many
more, directly from the sidebar.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

In the sidebar menu, select Agent, if not already selected.2

Type your prompt and click Send.3

Analyzes your request and drafts a plan.1

Processes the data in the current sheet according to the plan.2
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Translate to multiple languages

Translate spreadsheet content to multiple languages in bulk.

TIP

The Agent can also use a glossary to stick to your brand's language and conventions.

Search the web

When necessary, the Agent searches the web to find the information you need. Learn more about
the models used by the Agent.

Translate the descriptions in column B to the languages provided in row 1

Translate into French, using the following glossary: "Macchiato: 
Macchiato (Café noisette), Espresso: Expresso, Latte: Café crème (Latte)"

Fill out this table
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TIP

The Agent can also scrape specific URLs, using Gemini 2.5 models with URL context.

Generate and autofill formulas

Describe what you need in natural language, and the Agent generates the appropriate Excel
formula, inserts it in the starting cell, and autofills the formula across the range.

Calculate the revenue for each row

https://gptforwork.com/help/gpt-for-excel/search-web?model=google-gemini#model-specific-settings
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TIP

The Agent can also fix formulas and explain them.

What the Agent can and cannot do

The Agent excels at data processing and analysis tasks. You can use it to:

Process data in bulk: Translate, categorize, tag, or prep your data across multiple rows.

Enrich your data: Search the web to fill in missing information or gather additional context.

Generate content: Generate or rewrite text, generate lists or tables.

Analyze and summarize: Summarize multiple cells at once.

Work with formulas: Create, fix, or explain spreadsheet formulas using natural language.

The Agent cannot yet:

Apply formatting (such as colors or text formatting).

Create visual elements like charts, pivot tables, or dashboards.

Fix the formula in H2
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Modify spreadsheet structure (add/remove columns or rows).

Take images or documents as input.

FAQ

How much does it cost?

On average, the Agent consumes 7 cents of your balance per message, excluding the cost of the
bulk tools used to perform the task.

What models does the Agent use?

By default, the Agent uses different models for different tasks. You can configure the model used
for some tasks.

Task Default model Model configuration

Read and
plan

gpt-4.1  without an
API key

To use gpt-4.1  with an API key, contact support.

Apply the
plan

gpt-4o  without an
API key

Set the default model in the GPT for Work
dashboard.

Search the
web

sonar  without an API
key

Set the default web search model in the GPT for
Work dashboard.

https://support.gptforwork.com/hc/en-us/requests/new
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space#set-a-default-model
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space#set-a-default-model
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Bulk AI tools
Run any type of operation on an entire spreadsheet column at once, or on a specific section of
your data.

Custom prompt

Run high-volume prompts directly in Microsoft Excel.

Generate

Generate multiple entities at once from each cell in a column.

Rewrite

Rewrite text in each cell in a column.

Translate

Translate an entire column based on your instructions and glossary.

Classify / Categorize

Classify all cells in a column according to the specified categories and instructions.

Extract

Extract multiple entities at once from each cell in a column.

Reformat

Convert text in a column into a consistent format.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/generate
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/rewrite
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/translate
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/classify-categorize
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/extract
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/reformat
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/prompt-images
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Prompt images

Prompt images in Excel using AI vision.

Select which rows to process

Let GPT for Excel process only the relevant rows in your spreadsheet, or target a specific section of your
data.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/prompt-images
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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Custom prompt bulk tool in Excel
Use GPT for Excel to perform high-volume prompting directly in Microsoft Excel. For example, if
you have product specifications in one column, you can generate a unique product description for
each row based on the specification column value for that row.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Custom prompt.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Prompt to run
for each row

Enter the prompt you want to run
for each row. You can use column,
cell, and range variables to
reference content in other
columns and cells in the
spreadsheet. You must define at
least one column variable for
context. Learn more.

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

B: Description

3

Write an SEO-
optimized 
description for 
a bike based on 
its 
specifications: 
{{Bike 
specifications}}

Run the Custom prompt bulk tool starting from the first empty cell in the results columns:4

i. Select a specific number of rows to run or select All rows. Learn more.1

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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You have set up and run the Custom prompt bulk tool. If needed, try improving the results.

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2
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Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Use multiple variables

You must define at least one column variable in the prompt for context, for example {{A}} , or
{{Bike specifications}} . To generate more accurate results, provide more context by using

additional variables in the prompt.

You can insert variables to reference columns, cells, and ranges in the prompt:

https://gptforwork.com/help/ai-models
https://gptforwork.com/help/ai-models/select-model
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Variable Description Example

Column

Reference a column to include row-
specific information from an adjacent
column.

Column variables work like relative
references and are highlighted in
blue.

To add a column variable, use the
Insert variables menus above the
prompt. You can add a variable either
by column label or column letter.

Write a product description for
{{Product name}} that costs
{{Price}} and is made by
{{Manufacturer}}.

Cell or range
from the
current
sheet

Reference a specific cell or range to
include the same content as context
for each row.

Cell and range variables work like
absolute references and are
highlighted in green.

To add a cell or range variable, type it
directly in the prompt.

Create a tagline for {{Company
name}}.

Follow these rules: {{A1}}

Use 1 term from this list:
{{A2:A100}}

Cell or range
from
another
sheet

Reference a cell or a range from
another sheet in the same
spreadsheet. The content can be, for
example, reference data or other
shared information.

Translate {{Source text}} to
Japanese.

Use the glossary:
{{Glossary!A1:B100}}

Provide additional instructions

Provide context and specific rules for the AI to follow. For example, you can add instructions to
follow SEO best practices:

You are writing copy for a retail website. Take SEO into account.
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INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. Use a
high level for a creative writing task.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Use web search capabilities

To generate more up-to-date content, select a model with web search capabilities (indicated by the
🌐 icon in the model switcher). The available web search options vary depending on the model you
select. Learn more about web search options.

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/search-web
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TIP

Enable Show sources to write the source references in the column to the right of the results
column. This helps you understand the origin of the content and assess its reliability.

Include images in your prompts

To include images in your prompts, select a vision model in the model switcher. Then, choose the
columns that contain image URLs so they can be attached to the prompt for each corresponding
row. Learn more about vision options.

https://gptforwork.com/help/ai-providers-and-models#vision-models
https://gptforwork.com/help/gpt-for-excel/use-images-in-prompts
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What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Generate in bulk in Excel
Use GPT for Excel to generate content by combining cells from multiple columns in Microsoft Excel.
For example, you can generate product descriptions based on specifications from different
columns.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Generate.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Using cells in
column(s)

Select one or more columns
containing the cells you want to
use as context for the generation.

A: Model name, B: 
Type, C: Price, D: 
Weight, E: Frame

Generate for
each row

Select the type of content you
want to generate, such as a title
or description. You can also enter
a custom content type to
generate, such as Social media 
ad  or Email body .

Description

With these
instructions

Customize the output by setting
the language, tone, writing style,
audience, format, length, and
custom instructions specific to
this generation task.

Language: English

Tone: Optimistic

Custom instructions: 
Use a few emojis

3
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You have set up and run the Generate bulk tool. If needed, try improving the results.

Field Description Example

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

F: Description

Get 2 variants
per row (optional)

Enable this option to generate
two variants for each row. The
variants are placed in adjacent
columns.

Disabled

Run the Generate bulk tool starting from the first empty cell in the results column:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Provide additional instructions

You can improve generation quality by providing specific instructions that help the AI more closely
follow your requirements for tone, writing style, format, and other aspects.

https://gptforwork.com/help/ai-models
https://gptforwork.com/help/ai-models/select-model
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You can define the following types of instructions for the AI:

Custom instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both custom instructions and global instructions are defined, the AI uses both as a combined set
of instructions. For consistent results, make sure both sets of instructions are aligned and do not
contradict each other.

For example, set the current run to use a few emojis and instruct the AI to be concise in all runs:

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. Use a
high level for a creative writing task.

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
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INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Use web search capabilities

If you need more up-to-date information in your generated content, select a model with web
search capabilities (indicated by the 🌐 icon in the model switcher). The available web search
options vary depending on the model you select. Learn more about web search options.

TIP

Enable Show sources to write the source references in the column to the right of the results
column. This helps you understand the origin of the content and assess its reliability.

What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/search-web
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Rewrite in bulk in Excel
Use GPT for Excel to rewrite existing content in Microsoft Excel to match your desired tone and
style. For example, you can transform casual product descriptions into professional ones.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Rewrite.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Rewrite each cell
in column

Select the column that contains
the text you want to rewrite. F: Description

With these
instructions

Customize how the text should be
rewritten by setting the tone,
writing style, audience, format,
length, and custom instructions,
and whether to fix grammar and
spelling errors.

Tone: Professional

Writing style: 
Business

Custom instructions: 
Remove emojis and 
casual language

Add context
(optional)

Select additional columns to
provide context for the rewrite.

A: Model name, B: 
Type, C: Price

Put results in
column

Select the column to put the
rewritten text in. Cells in this
column won't be overwritten if
they contain text.

G: Rewrite 
description

3
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You have set up and run the Rewrite bulk tool. If needed, try improving the results.

Field Description Example

Get 2 variants
per row (optional)

Enable this option to generate
two rewrite variants for each row.
The variants are placed in
adjacent columns.

Disabled

Run the Rewrite bulk tool starting from the first empty cell in the results column:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Provide additional instructions

You can improve rewrite quality by providing specific instructions that help the AI more closely
follow your requirements for tone, writing style, format, and other aspects.

https://gptforwork.com/help/ai-models
https://gptforwork.com/help/ai-models/select-model
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You can define the following types of instructions for the AI:

Custom instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both custom instructions and global instructions are defined, the AI uses both as a combined set
of instructions. For consistent results, make sure both sets of instructions are aligned and do not
contradict each other.

For example, set the current run to use professional language and instruct the AI to maintain
technical accuracy in all runs:

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in rewriting content. Use a
lower level to stay closer to the original text.

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
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INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Translate in bulk in Excel
Use GPT for Excel to translate product catalogs, website copy, customer reviews, or any other
content directly in Microsoft Excel, and optimize your translations by adding specific instructions
and a glossary to guide the AI in the process. For example, you can translate a list of product
names for a shoe store into French.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Translate.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Translate each
cell in column

Select the column that contains
the text you want to translate. A: Product Name

From (optional)

Enter the source language, or
leave the field empty if you want
the AI to detect the source
language for each cell.

Empty

To Enter the target language. French

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

B: Product Name - 
FR

3
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Field Description Example

Translation
instructions
(optional)

Enter specific instructions for the
translation.

Translation
glossary
(optional)

Enter a list of word pairs where
the first word is the source
language word and the second
word is the target language
translation of the first word.

Use the following syntax for each
pair:

<Source word>: <Target 
Word>

Enter one pair per line.

If your glossary is in the current
document, you can import it by
clicking Import from sheet.

We are 
translating a 
shoe store 
catalog.

Sneakers: 
Sneakers
Running: 
Chaussures de 
course

Run the Translate bulk tool starting from the first empty cell in the results column:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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You have set up and run the Translate bulk tool. If needed, try improving the results.

Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

https://gptforwork.com/help/ai-models
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Set the source language

The AI can automatically detect the source language, but manually defining it helps if the source
text contains short, ambiguous phrases, which can confuse the AI. For example, "Trainers" in
British English means "Sports shoes", whereas in American English, it means "People who train
others".

Provide additional instructions

You can improve translation quality by providing specific instructions that help the AI more closely
follow your requirements for tone, audience, and terminology.

https://gptforwork.com/help/ai-models/select-model
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You can define the following types of instructions for the AI:

Translation instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both translation instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

For example, omit the global instructions and only define translation instructions:

Create a glossary

Glossaries ensure that translations are consistent, respect corporate terminology, and remain on-
brand. If your glossary is in the current spreadsheet, you can import it by clicking Import from
sheet.

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
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Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in translating text. For
example, if you're translating marketing copy, set a high creativity level to generate more engaging
and imaginative translations. If you're translating technical specifications, set a low creativity level
to ensure the translations are precise and factual.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Classify / Categorize in bulk in Excel
Use GPT for Excel to classify your catalog items, press articles, customer reviews, social media
comments, or any other text directly in Microsoft Excel. The Classify / Categorize bulk tool
classifies the content of each cell into one of the categories you provide if a match is found. For
example, you can improve your lifecycle inventory management by classifying apparel products
according to the activity they are used for.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Classify / Categorize.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Classify each cell
in column

Select the column that contains
the text you want to classify. B: Product Name

Into one of these
categories

Enter the categories to classify the
text into. If the categories are
listed in the current document,
you can import them by clicking
Import from sheet.

3

Running
Workout
Casual
Yoga
Golf
Tennis
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Field Description Example

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

C: Activity

Classify
instructions
(optional)

Enter specific instructions for the
classification. Learn more.

Polos fall into 
the Golf 
category.
Do not classify 
items with 
technical 
properties as 
Casual.

Run the Classify / Categorize bulk tool starting from the first empty cell in the results column:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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You have set up and run the Classify / Categorize bulk tool on a column. If needed, try improving
the results.

Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

Check the result for each cell:5

The category name if a match is found.

#N/A  if no match is found.

https://gptforwork.com/help/ai-models
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

Provide additional instructions

You can improve classification quality by providing specific instructions that help the AI more
closely follow your requirements for categorization rules and context.

You can define the following types of instructions for the AI:

Classify instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both classify instructions and global instructions are defined, the AI uses both as a combined set
of instructions. For consistent results, make sure both sets of instructions are aligned and do not
contradict each other.

For example, omit the global instructions and only define classify instructions:

Set Creativity to 0

Ensure Creativity is set to 0. This setting helps the AI follow instructions more closely.

https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
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INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
document.

Use full path for categories

If your categories form a hierarchy, use their full path instead of their name. This helps avoid
ambiguity and ensures that the classification is as precise as possible.

Using only the category names can lead to ambiguity. For instance, T-shirts  and Tops  could be
considered as very largely overlapping categories. By specifying Casual/T-shirts  and
Workout/Tops , you provide a clear context, ensuring that the AI classifies the items accurately

according to the intended category.

For example, instruct the AI to classify items according to these category paths:

Casual/T-shirts
Casual/Jeans
Workout/Tops
Workout/Bottoms/Shorts
Workout/Bottoms/Pants

https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
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What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Extract in bulk in Excel
Use GPT for Excel to extract key information like names, email addresses, and product attributes
from unstructured text directly in Microsoft Excel. For example, you can extract name, weight, and
price from bike model descriptions to create a catalog.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Extract.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Extract
Enter the entities you want to
extract.

From each cell in
column

Select the column that contains
the text from which you want to
extract entities.

A: Description

Put results in
column

Select the column or columns to
put the results in. Cells in these
columns won't be overwritten
with the results if they contain
text.

B, C, D

3

Name
Weight
Price
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You have set up and run the Extract bulk tool. If needed, try improving the results.

Field Description Example

Extraction
instructions
(optional)

Enter specific instructions for the
extraction.

Name: Extract 
only the model 
name, without 
manufacturer or 
year

Run the Extract bulk tool starting from the first empty cell in the results columns:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

https://gptforwork.com/help/ai-models
https://gptforwork.com/help/ai-models/select-model
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Provide additional instructions

You can improve extraction quality by providing specific instructions that help the AI more closely
follow your requirements for text identification and formatting rules.

You can define the following types of instructions for the AI:

Extraction instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both extraction instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

For example, omit the global instructions and only define extraction instructions:

The following table provides examples of extraction instructions for different goals:

Goal Description Example

Remove
irrelevant
information

Define what should be
excluded from the extraction
to get cleaner results.

Name: Extract only the model 
name, without manufacturer 
or year

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
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Goal Description Example

Normalize
entities

Set a consistent output for
variations of the same entity
in your text.

Extract numerical
values and units

Separate numbers from units
to simplify their manipulation.

Add Price value  and Price 
currency  as entities in the Extract
field, then instruct:

Perform open-ended extraction

Open-ended extraction helps you gather a wide range of information without specifying each
entity. This approach works well when entities vary from one cell to another or when you want to
avoid missing any extraction. For example, enter the following in the Extract field:

What's next

Try another bulk AI tool.

Weight: Extract weight in 
kilograms

Price value: Extract only 
the numerical value
Price currency: Extract only 
the currency code (for 
example USD, or EUR)

All relevant product details as a comma-separated list.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Reformat in bulk in Excel
Use GPT for Excel to standardize dates, phone numbers, or any other text to a consistent format
directly in Microsoft Excel. For example, you can reformat product names before you include them
in your catalog.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

In the sidebar, select Bulk AI tools, and click Reformat.2

https://gptforwork.com/help/gpt-for-excel/overview
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

2

Reformat each
cell in column

Select the column that contains
the text to reformat.

A: Name

To
Describe the format to which you
want to convert the text.

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

B: Standard format

3

Color | Model | 
Size (S, M, or 
L)
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You have set up and run the Reformat bulk tool. If needed, try improving the results.

Field Description Example

Reformatting
instructions
(optional)

Enter specific instructions for the
reformatting.

Use title case

Run the Reformat bulk tool starting from the first empty cell in the results column:4

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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Improve results

Try different models

Find out which models work best for different use cases in our AI models overview. You can try
different models by selecting them in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
spreadsheet.

https://gptforwork.com/help/ai-models
https://gptforwork.com/help/ai-models/select-model
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Provide additional instructions

You can improve reformatting quality by providing specific instructions that help the AI more
closely follow your requirements for formatting rules and consistency.

You can define the following types of instructions for the AI:

Reformatting instructions are defined for the current bulk tool run.

Global instructions can also be defined in Model settings and apply to all bulk tools and GPT
functions in the current spreadsheet.

If both reformatting instructions and global instructions are defined, the AI uses both as a
combined set of instructions. For consistent results, make sure both sets of instructions are
aligned and do not contradict each other.

For example, omit the global instructions and only define reformatting instructions:

Set Creativity to 0

Ensure Creativity is set to 0. This setting helps the AI follow instructions more closely.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
document.

https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level


GPT for Work Help (Microsoft) 2025-10-22

208 / 366

What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Prompt images in bulk in Excel
Use GPT for Excel to generate content based on images directly in Microsoft Excel. For example,
you can generate descriptions for your product images to improve your listings.

INFO

Custom prompt and Prompt images (Vision) are the only bulk AI tools that accept images
as input.

To use Prompt images (Vision), you must select a vision model.

Run the bulk tool

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/ai-providers-and-models#vision-models
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In the sidebar, select Bulk AI tools, and click Prompt images (Vision).2

In the model switcher, select a vision model.3

https://gptforwork.com/help/ai-providers-and-models#vision-models
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Set up your bulk tool run.

Field Description Example

Header row
(optional)

If your column headers aren't in
the first row, select the number of
the row that contains the headers.
The bulk tool will run on the rows
below this one.

4

Prompt

Describe the task you want the AI
to perform based on the target
images. For example, ask a
question about the images or
request content based on the
images.

4

Write a short 
description of 
this product 
based on how it 
looks, how it's 
used, and its 
build quality.
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Field Description Example

Columns
containing
image URLs

Select up to five columns that
contain image URLs. For each row,
the tool processes all images
present in the selected columns.
URLs must be publicly accessible.

Supported image formats:

B: Front image, C: 
In-use image, D: 
Material detail 
image

Image resolution
(optional)

Choose the level of detail for
image processing:

Low

Put results in
column (optional)

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

E: Description

PNG
JPEG
WebP
Non-animated GIF

High: Better image
understanding, higher latency
and cost

Low: Faster processing, lower
cost
Auto: Let the model decide
(default)

Run the Prompt images (Vision) bulk tool starting from the first empty cell in the results
column:

5

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.2

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/select-which-rows-to-process
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You have set up and run the Prompt images (Vision) bulk tool. If needed, try improving the
results.

Improve results

Try different models

Try different vision models to find the one that works best for your use case. We recommend using
gpt-4.1 for most vision tasks.

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. For
example, if you're generating marketing copy, set a high creativity level to generate more
engaging and imaginative text. If you're generating technical specifications, set a low creativity
level to ensure the generated text is precise and factual.

INFO

GPT for Work saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

https://gptforwork.com/help/ai-providers-and-models#vision-models
https://gptforwork.com/help/ai-models/select-model#recommended
https://gptforwork.com/help/ai-models/select-model#recommended
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Refine your prompt

Be specific about what you want the AI to focus on. For example, specify which kind of description
you want the AI to generate.

Adjust image resolution

Choose the appropriate image resolution setting based on your needs:

High: Use for detailed analysis where image quality and understanding are critical. This setting
provides better image understanding but increases latency and cost.

Low: Use for faster processing and lower cost when basic image recognition is sufficient.

Auto: Let the model decide the optimal resolution (default).

For product descriptions and detailed analysis, consider using High resolution to ensure the AI
captures all important visual details.

What's next

Try another bulk AI tool.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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Select which rows to process with bulk AI
tools
The bulk AI tools in GPT for Excel are designed to process only the relevant rows in your
spreadsheet. You can additionally control where to start and how many rows to process, making it
easy to test on a small sample before processing your entire dataset.

Bulk tools automatically skip:

In the figure below, all rows with a green background will be processed by the Translate bulk tool.

Try a bulk tool on a few rows, then run all rows

The default settings for bulk tool runs is ideal for starting with a quick test:

Setting Value Description

Header
row

1 Row 1 contains the column headers.

The header row1

Rows with content in the result column2

Rows where all input columns are empty3

Hidden or filtered rows4

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/translate
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Setting Value Description

Start from
row

Auto
The tool processes the first 3 rows after the header row. If a row has a
non-empty cell in the result column, the tool skips to the next row.

X rows 3 The tool processes 3 rows after the header row.

To run a bulk tool with the default settings, simply click Run 3 rows.

The following video shows you how to run the Extract tool on 3 rows to check that the
specifications for your product descriptions are extracted correctly.

When you're ready to run the tool on the whole spreadsheet, change the row setting to All rows
and click Run all rows. The tool skips the first 3 rows as they have already been processed.

Run a bulk tool on new content only

If you've already run a bulk tool on a spreadsheet and then add new data, you don't need to filter
the new rows to process them. Just run the tool again on all rows. It skips the rows that have
already been processed.

Setting Value Description

Start from
row

Auto The tool starts on the first empty cell in the result column.

X rows
All
rows

The tool processes all remaining rows, skipping the rows that have
already been processed.

The following video shows how to run the Classify / Categorize tool to process only new rows in a
product list. Even if the list is already sorted so that the new rows are not all at the end, the tool
only processes the new rows.

Run a targeted test

You can target a specific section of rows in a spreadsheet by explicitly defining the start row and
the number of rows to process:

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/extract
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/classify-categorize
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Setting Value Description

Start from
row

Fixed:
5

The tool starts on the first empty cell in the result column on or after
row 5.

X rows 2
The tool processes 2 rows, starting from the first empty cell in the
result column on or after row 5.

The following video shows you how to run the Translate tool on 2 rows to check that your glossary
is taken into account when translating your product names from English to French.

Rerun a bulk tool on a few cells

To rerun a bulk tool on a few cells, simply delete the cell content and rerun the tool. This allows you
to easily update a few selected rows without affecting the rest of the results:

Setting Value Description

Start from row Auto The tool starts at the first empty cell in the result column.

X rows All rows The tool processes all rows with empty cells in the result column.

The following video shows how to rerun the Custom tool on a few cells to update the results after
tweaking your prompt.

TIP

To rerun a bulk tool on the same rows, you can select a new column to write the results to.
This way, you can keep the original results and compare them with the new ones.

What's next

Learn more about the bulk AI tools.

If you encounter issues with bulk AI tools, see the troubleshooting guide.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/translate
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/troubleshooting/bulk-ai-tools
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GPT functions in GPT for Excel
Build formulas with GPT functions to prompt AI from inside spreadsheet cells. Use the GPT for
Excel sidebar to manage your GPT formulas.

Start using GPT functions

Learn the basics of using GPT functions — from enabling GPT functions for a workbook to building
formulas that combine GPT functions with native functions.

Create GPT formulas

Create GPT formulas in Microsoft Excel and control the execution of GPT formulas.

Manage GPT formulas from the sidebar

Manage your GPT formulas and avoid unexpected changes and costs.

All GPT functions

All the GPT functions, with simple examples and an extensive list of parameters.

https://gptforwork.com/help/gpt-for-excel/overview#gpt-functions
https://gptforwork.com/help/gpt-for-excel/gpt-functions/start-using-gpt-functions
https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
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Start using GPT functions in Excel
GPT functions are custom spreadsheet functions in GPT for Excel that allow you to prompt AI from
inside spreadsheet cells. GPT functions work exactly like native functions in that you can use them
on their own or combine them with other functions when creating formulas.

This guide walks you through the basics of using GPT functions — from enabling GPT functions for
a workbook through building formulas with GPT functions to using functions for web search and
image processing. The focus is on the GPT  function, the simplest function included in GPT for
Excel, but the same rules apply to all GPT functions.

TIP

To try out the examples in this guide, download our GPT function starter examples template,
and open it in Excel as a new workbook.

Enable GPT functions

GPT for Excel must be running before you can use GPT functions for the first time in a workbook.

To start GPT for Excel:

Use GPT functions

Learn the basics of using GPT functions, from how you type a function through how you use
functions in formulas to how you search the web and process images with functions.

Open the workbook where you want to use GPT functions.1

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

2

https://gptforwork.com/help/concepts#function-spreadsheet
https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/concepts#formula-spreadsheet
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://drive.google.com/file/d/11tBtv4PMzaXKqim240uVwwuZOqfOtGrU/view
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GPT function syntax

Each GPT function follows a specific syntax that consists of a function name and one or more
parameters (also called "arguments") enclosed in parentheses. The parameters together tell the
function what to do. Some parameters are required, while others are optional. The syntax of a
function is presented as follows:

The order of the parameters matters, so always write them in the order required by the function
syntax. Optional parameters are in square brackets.

For example, the GPT  function has the following syntax:

The GPT  function takes the following four parameters:

Parameter Required Description

prompt Yes

The prompt for the AI. The prompt can be:

Text: "Write a tagline for a tea house"

Cell reference: A1

Range reference: A1:A3

FUNCTION_NAME(parameter_1, parameter_2, [parameter_3])

GPT(prompt, [value], [temperature], [model])

https://gptforwork.com/help/concepts#prompt
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Parameter Required Description

value No

Input that you want to combine with the prompt. The input can
be:

Text: "Tone: Calm and serene"

Cell reference: B1

Range reference: B1:B3

If you provide value , GPT for Excel uses the following template
to build the final prompt sent to the AI:

For example, if prompt  is Write a tagline for a tea 
house  and value  is Tone: Calm and serene , the final
prompt is:

INFO

The Output  line serves as a structural anchor that helps
constrain the model into returning a clean, direct, and well-
formatted response.

If you do not provide value , GPT for Excel sends prompt  as is.

temperature No

Number between 0  and 1  that specifies how creative the AI
should be in generating the response:

0  sets minimum creativity. Responses to the same prompt
are predictable and very similar.

1  sets maximum creativity. Responses to the same prompt
can vary wildly. Highest risk of hallucination.

<prompt>
Input: <value>
Output:

Write a tagline for a tea house
Input: Tone: Calm and serene
Output:
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Parameter Required Description

model No
Name of the AI model that you want to use. You can find the
model names in the model switcher in the add-in sidebar. Learn
more.

The first parameter of the GPT  function is required, so you always have to provide it. The
remaining three parameters are optional, so you only need to provide them when you want
additional control over how the function operates. You can provide one, two, or all three optional
parameters, depending on your needs.

DOUBLE QUOTES

If a parameter takes a text value, always enclose the text in double quotation marks. For
example:

✅ GPT("Write a tagline for a tea house")

❌ GPT(Write a tagline for a tea house)

The latter fails with an error because the function cannot interpret the words as valid
parameters.

EMPTY PARAMETERS

If you skip an optional parameter other than the last one, always provide a lone comma
("empty parameter") as a placeholder to maintain the correct syntax. For example:

✅ GPT("Write a tagline for a tea house", , 0.5, "claude-4-sonnet")

❌ GPT("Write a tagline for a tea house", 0.5, "claude-4-sonnet")

The latter fails with an error because the function treats 0.5  as the second parameter
( value , which expects text or a reference) and "claude-4-sonnet"  as the third parameter
( temperature , which expects a number).

Run a GPT function

To use the GPT  function:

Select a cell where you want the response to appear.1

Type the equal sign =  followed by the function. For example, to use the GPT  function with
just the prompt  parameter, type:

2

https://gptforwork.com/help/concepts#model
https://gptforwork.com/help/ai-models/select-model
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The function runs: It sends the prompt to the AI, receives a response, and displays the response in
the selected cell.

CALCULATED VALUES AND CONSTANTS

The text you see in the cell is the result of the formula — a dynamically calculated value. The
actual value of the cell is the formula expression: =GPT("Write a tagline for a tea 
house") . You cannot edit the result; you can only edit the formula. If you want to set the
result as the actual value of the cell, that is, if you want to turn the calculated value into a
constant that you can edit, replace the formula with its result.

Reference other cells from a GPT function

You can reference other cells and ranges from a GPT function. You can use relative, absolute, and
mixed references as you would with any function.

For example, to retrieve the prompt for the GPT  function from another cell:

=GPT("Write a tagline for a tea house")

Press ENTER.3

Select a cell and enter the prompt:

TIP

You do not need double quotation marks around the prompt here because Excel
automatically returns the value as text.

1

Write a tagline for a tea house

Select another cell and enter the GPT  function with the prompt cell as the only parameter. For
example, if the prompt is in cell B12 , enter:

2

=GPT(B12)

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/replace-gpt-formulas-with-results
https://support.microsoft.com/en-us/office/overview-of-formulas-in-excel-ecfdc708-9162-49e8-b993-c311f47ca173#ID0EDN
https://support.microsoft.com/en-us/office/overview-of-formulas-in-excel-ecfdc708-9162-49e8-b993-c311f47ca173#ID0EDN
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Both GPT(B12)  and GPT("Write a tagline for a tea house")  work the same way — they
send the exact same prompt to the AI. The only difference is that the former retrieves the prompt
from a cell, while the latter provides it directly as a text constant in the function.

Apply the same prompt to multiple cells

You can apply the same GPT function and prompt to adjacent cells by filling the formula across a
range.

For example, suppose you want to generate unique taglines for multiple businesses. The
businesses are listed in one column of your sheet, and you want to fill another column with the
corresponding taglines. You can generate the taglines by using the GPT  function with the prompt
and value  parameters, where prompt  specifies the basic instructions and value  specifies a
specific business as a cell reference:

To see how absolute references work, let's move the prompt to its own cell:

The function runs and returns the AI's response in the selected cell.

Select the first tagline cell and enter the GPT  function. For example, if the business whose
tagline you're generating is specified in cell B7 , enter:

The function combines the two parameters into a single prompt, based on the underlying
prompt template, which is then sent to the AI. For example, if B7  contains the text antique 
store , the final prompt sent to the AI is:

The function runs and returns the AI's response in the selected cell.

1

=GPT("Write a tagline", B7)

Write a tagline
Input: antique store
Output:

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the cell reference in the
function so that each row receives a tailored response based on its business. The formula in
row 8 will reference B8 , the formula in row 9 will reference B9 , and so on.

2

Select an empty cell and enter the prompt:1

Write a tagline

Select the first tagline cell and update the GPT  function to reference the prompt cell. For
example, if the prompt is in cell C8  and the business whose tagline you're generating is now
specified in cell B11 , enter:

2

https://support.microsoft.com/en-us/office/fill-a-formula-down-into-adjacent-cells-041edfe2-05bc-40e6-b933-ef48c3f308c6
https://support.microsoft.com/en-us/office/fill-a-formula-down-into-adjacent-cells-041edfe2-05bc-40e6-b933-ef48c3f308c6
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Create a prompt by combining text from multiple cells

You can use concatenation to combine text from two or more cells into a single text string. This
allows you to create advanced prompts, where different parts of the prompt come from different
cells in the sheet.

For example, suppose you want to further customize the taglines of the previous example, so that
they follow a specific tone and target a specific customer age range. The businesses are listed in
the first column, the tone in the second, and the age range in the third, with the fourth column
now reserved for the taglines.

To build the prompt by combining the information from the different columns:

$C$8  is an absolute reference to C8 , which you need here since you do not want Excel to
automatically adjust the reference when you fill the formula to adjacent cells.

TIP

Since you're only filling vertically across a single column, it would be enough to fix the
prompt cell row using a mixed reference:

=GPT($C$8, B11)

=GPT(C$8, B11)

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill, overwriting the existing formulas. Excel automatically
updates the value cell reference for each row, while keeping the prompt cell reference fixed.

3

Select the first tagline cell and enter the GPT  function. For example, if the business whose
tagline you're generating is specified in cell B11 , with the tone in cell C11  and age range in
cell D11 , enter the following in cell E11 :

The function uses the &  operator to concatenate the different parts, which include literal text
values and cell references, into a single text string. For example, if B11  contains the text
antique store , C11  contains nostalgic and refined , and D11  contains 35-65 , the

final prompt sent to the AI is:

1

=GPT("Write a tagline for " & B11 & ", the tone is " & C11 & ", the 
audience is aged " & D11)

Write a tagline for antique store, the tone is nostalgic and refined, the 
audience is aged 35-65

https://support.microsoft.com/en-us/office/combine-text-from-two-or-more-cells-into-one-cell-81ba0946-ce78-42ed-b3c3-21340eb164a6
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Combine a GPT function with a native function

You can combine GPT functions with native functions like you would any other function.

For example, suppose you want to run the GPT  function from above only when the current row
has a business specified. If the business cell is empty, you want to skip the row. You can do this by
combining the GPT  function with the native IF  function:

TIP

Instead of the &  operator, you can also use the native CONCAT  function:

The GPT  function uses the CONCAT  function as a nested function. Learn more.

If you want to concatenate without having to worry about white spaces and newlines, use
the GPT_CREATE_PROMPT  function:

=GPT(CONCAT("Write a tagline for ", B11, ", the tone is ", C11, ", the 
audience is aged ", D11))

=GPT(GPT_CREATE_PROMPT("Write a tagline for", B11, ", the tone is", 
C11, ", the audience is aged", D11))

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the cell references in the
function so that each row receives a tailored response based on its business. The formula in
row 12 will reference B12 , C12 , and D12 ; the formula in row 13 will reference B13 , C13 ,
and D13 ; and so on.

2

Select the first tagline cell and enter a formula that wraps GPT  inside an IF  function. For
example, if the business whose tagline you're generating is specified in cell B11  and the GPT
function for that is GPT($C$8, B11) , enter:

The GPT  function runs only if cell B11  is not empty. If B11  is empty, the formula leaves the
current cell empty, too.

1

=IF(B11="", "", GPT($C$8, B11))

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill, overwriting the existing formulas. Excel automatically
updates the value cell reference for each row, while keeping the prompt cell reference fixed.

2

To see the conditional logic in action, empty one of the business cells. The formula for that row
reruns and removes the tagline.

3

https://support.microsoft.com/en-us/office/if-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2
https://support.microsoft.com/en-us/office/concat-function-9b1a9a3f-94ff-41af-9736-694cbd6b4ca2
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_create_prompt-helper-function
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Search the web with a GPT function

You can search the web with a GPT function simply by using a web search model. You can either
select the model in the model switcher or specify the model with the model  parameter.

For example, suppose you want to do a search for company CEOs. The companies are listed in one
column of your sheet, and you want to fill the next column with the CEO names.

In the sidebar, expand the model switcher and select a web search model (indicated by the 🌐
icon).

INFO

If you select a Gemini model, make sure web search is enabled for Gemini models.

1

Select the first CEO cell and enter the GPT function. For example, if the company whose CEO
you're fetching is specified in cell B13 , enter:

2

=GPT("Give me this company's current CEO. I only want the name of the CEO, 
no citations.", B13)

https://gptforwork.com/help/gpt-for-excel/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/gpt-for-excel/search-web#model-specific-settings


GPT for Work Help (Microsoft) 2025-10-22

228 / 366

For more information about web search, see Search the web with GPT for Excel.

Process images with GPT_VISION

You can apply a text prompt to an image using the GPT_VISION  function with a vision model. You
can either select the model in the model switcher or specify the model with the model  parameter.

For example, suppose you want to extract the brand name from product images featuring coffee
bean packs. The image URLs are listed in one column of your sheet, and you want to fill the next
column with the brand names.

TIP

If you want to override the model switcher selection, specify the model in the GPT
function with the model  parameter. For example, if you want to use the Sonar model,
enter:

=GPT("Give me this company's current CEO. I only want the name of the 
CEO, no citations.", B13, , "sonar")

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the company cell reference
for each row.

3

In the sidebar, expand the model switcher and select a vision model.

To determine whether a model supports vision, check its info popup. For a list of available
vision models, see AI providers & models and filter the tables by Vision.

1

https://gptforwork.com/help/gpt-for-excel/search-web
https://gptforwork.com/help/gpt-for-excel/search-web
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_vision-function
https://gptforwork.com/help/ai-providers-and-models#vision-models
https://gptforwork.com/help/ai-providers-and-models


GPT for Work Help (Microsoft) 2025-10-22

229 / 366

Select the first image URL cell and enter the GPT function. For example, if the image URL that
you want to process is in cell C13 , enter:

TIP

If you want to override the model switcher selection, specify the model in the GPT
function with the model  parameter. For example, if you want to use the Claude Sonnet 4
model, enter:

2

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.", C13)

=GPT_VISION("Extract the coffee brand from this image. Normalize the 
brand name to title case.", C13, , , "claude-4-sonnet")
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For more information about AI vision, see Use images in prompts in Excel.

Set the model for a GPT function

You can run a GPT function with a specific model by providing the model  parameter. The function
will ignore what's currently selected in the model switcher and use the provided model instead.

For example, if you want the Perplexity Sonar model to answer a query about current events,
provide sonar  as the model:

INFO

If the model is available both with and without an API key in GPT for Excel, the function uses
the model with the API key.

Use the model  parameter when:

You want to lock a formula to a specific model. For example, if you have a web search
formula, you want it to consistently use the same web search model.

You want to compare how a specific model compares with other models. For example, use
the same GPT function and prompt in two formulas — the first with the model  parameter, the
second without — and then use the model switcher to change the model used by the second
formula, regenerating its response after each change.

Set the creativity level for a GPT function

You can run a GPT function with a specific creativity level by providing the temperature
parameter. The function will ignore the creativity level defined in the model settings and use the
provided level instead.

For example, if you're working on a creative task and want to experiment with highly creative
responses, set the temperature close to 1 :

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the image URL cell reference
for each row.

3

=GPT("What was the previous month's inflation rate in the US?", , , "sonar")

=GPT("Write a tagline for a tea house", , , "claude-4-sonnet")

=GPT("Write a tagline for a tea house")

https://gptforwork.com/help/gpt-for-excel/use-images-in-prompts
https://gptforwork.com/help/gpt-for-excel/use-images-in-prompts
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/regenerate-gpt-formula-results
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
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For more information about temperature, see our temperature guide for OpenAI models.

GPT functions: Defaults, settings, behavior

Default model

By default, GPT functions use the currently selected model. If you want a GPT function to use a
specific model regardless of what's currently selected in the model switcher, use the model
parameter to explicitly set the model.

INFO

If you provide the model  parameter, and if the model is available both with and without an
API key in GPT for Excel, the function uses the model with the API key.

Default creativity level

By default, GPT functions use the creativity level defined in the model settings. If you want a GPT
function to use a specific creativity level regardless of what's defined the model settings, use the
temperature  parameter to explicitly set the creativity level.

Global instructions and advanced settings

The global instructions and advanced settings defined in the GPT for Excel sidebar apply to GPT
functions. If you find that a function is not working as expected, check the model settings for a
possible cause.

Regional settings

The default characters used by Excel for parameter and decimal separators depend on your
currently selected region:

Parameters: Some regions use the comma ( , ) as the default parameter separator, while others
use the semicolon ( ; ).

Decimals: Some regions use the period ( . ) as the default decimal separator, while others use
the comma ( , ). As a rule, regions that use the period for decimals use the comma for

=GPT("Write a three-sentence horror story about a teahouse.", , 0.9);

=GPT("Write a tagline", B7)

=GPT("Write a tagline"; B7)

https://gptforwork.com/guides/openai-gpt-ai-temperature
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
https://gptforwork.com/help/gpt-for-excel/configuration/adjust-advanced-settings
https://en.wikipedia.org/wiki/Locale_(computer_software)
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parameters, whereas regions that use the comma for decimals use the semicolon for
parameters.

The examples in the current documentation use the comma as the parameter separator and the
period as the decimal separator. If the examples fail with syntax errors in your workbook, check
your regional settings to verify which punctuation to use.

Formula auto-refresh

When your sheet auto-refreshes, Excel automatically recalculates some or all formulas on the
sheet, including GPT formulas. For each GPT formula:

If the GPT formula cache is enabled for the workbook, Excel reuses the formula's previously
generated result from the cache.

If the cached result has expired, or if you have the cache disabled, Excel runs the formula
normally.

In Excel, the following triggers cause a sheet to auto-refresh:

Recalculation trigger What gets recalculated

Insert, move, or delete a column All formulas on the sheet

Insert, move, or delete a row All formulas on the sheet

Filter rows by column All formulas on the sheet

Hide and unhide rows Formulas in the selected rows

Sort rows Formulas in the selected rows

Move a formula to a different cell All formulas on the sheet

Undo the deletion of a formula from a cell Restored formula

To prevent GPT formulas from being recalculated, replace the formulas with their results.

=GPT("Write a tagline for a tea house", , 0.5)

=GPT("Write a tagline for a tea house"; ; 0,5)

https://support.microsoft.com/en-us/office/change-the-windows-regional-settings-to-modify-the-appearance-of-some-data-types-in-access-databases-edf41006-f6e2-4360-bc1b-30e9e8a54989
https://support.microsoft.com/en-us/office/change-the-windows-regional-settings-to-modify-the-appearance-of-some-data-types-in-access-databases-edf41006-f6e2-4360-bc1b-30e9e8a54989
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/replace-gpt-formulas-with-results
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When to use bulk AI tools

Consider using bulk AI tools instead of GPT functions if:

You want AI responses saved as plain text in cells. Bulk AI tools fill cells with static text
values, or constants, so you don't need to replace any formulas. You also avoid formula auto-
refresh, reducing the risk of unintended data changes.

You want better tracking information about the progress of AI requests. Bulk AI tools
provide a live progress tracker that shows you how many rows have been successfully
processed, how many have resulted in an error, and how much time has elapsed.

Your formulas regularly become stuck in the #BUSY! state.

What's next

Discover all GPT functions available in GPT for Excel.

Learn how to use each GPT function with a real-world example.

Try out example use cases for different business applications and product capabilities.

Browse all our GPT function resources.

Select the model that best fits your needs.

Configure the model settings to customize how the currently selected model operates.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/troubleshooting/gpt-functions#functions-are-stuck-on-busy
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
https://gptforwork.com/help/use-cases-spreadsheets/business-applications
https://gptforwork.com/help/use-cases-spreadsheets/product-capabilities
https://gptforwork.com/help/gpt-for-excel/gpt-functions/
https://gptforwork.com/help/ai-models/select-model
https://gptforwork.com/help/gpt-for-excel/configuration
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Create GPT formulas with GPT for Excel
Delay and chain GPT functions, and learn how to use different GPT functions by example.

Control GPT formula execution

Delay or sequence the execution of GPT formulas in Microsoft Excel.

GPT formula examples

Examples for all the functions in the GPT for Excel.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/control-gpt-formula-execution
https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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Control GPT formula execution in Excel
You might want to delay the execution of your GPT for Excel functions until your workbook is
ready. Or you might want to sequence the execution of multiple chained calls. Avoid running into
errors or going over your rate limits by learning how to keep control over the executions of your
GPT functions in Microsoft Excel in this video.

How to control the execution of your GPT for Sheets functiHow to control the execution of your GPT for Sheets functi……

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/rate-limits
https://www.youtube.com/watch?v=Eq441-o8z48
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GPT formula examples for Excel
See GPT functions in action with real-world examples using some of the functions included in GPT
for Excel.

TIP

To try out the examples, download our GPT for Excel examples template, and open it in Excel.

Rewrite and generate

Use GPT functions to rewrite or create content adapted to your goals:

Rephrase existing text by adjusting length, style, grammar or tone.

Create content that matches your audience needs using the perfect level of creativity.

Rewrite or rephrase content

Shorten product names:

Clean up text:

Change tone:

Learn more on GPT.

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/overview
https://drive.google.com/file/d/1JsiR_cAIbuBi-O53VmfNLsXlW0v8SXPS/view
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt-function
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Create content

Generate button labels (CTAs):

Make your content more or less creative:

Generate sales marketing emails:

Learn more on GPT.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt-function
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Generate multiple outputs (vertical vs. horizontal)

Generate SEO keywords:

Generate content ideas side by side:

Learn more on GPT_LIST and GPT_HLIST.

Translate

Leverage large language models for your machine translation tasks and benefit from:

High performance: AI models from leading providers (such as OpenAI) support translation
across a wide range of language pairs. See all supported models.
Support for many languages: The full list of supported language pairs isn’t public, but ChatGPT
is known to work in 80+ languages, with varying accuracy depending on language and context.
Integration of your corporate terminology: For on-brand, consistent translations.

Translate with GPT_TRANSLATE

Translate descriptions:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_list--gpt_hlist-function
https://gptforwork.com/help/ai-providers-and-models
https://botpress.com/blog/list-of-languages-supported-by-chatgpt
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Translate with specific instructions

Translate with a custom dictionary:

Write a prompt and custom dictionary.1

Create the prompt instructions.2
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Your texts are translated in the target language, and the translations comply with the terminology
you provided.

Learn more on GPT_TRANSLATE.

Prepare data

Free up your teams from tedious data preparation so they can concentrate on high-value data
analysis:

Basic data cleaning tasks include formatting data according to known standards or by following
examples you set.
More advanced tasks like named entity extraction, which traditionally demanded a specific
pattern-based approach, are also an option.

Format data with GPT_FORMAT

Standardize dates:

Standardize cases:

Standardize phone numbers:

Translate your texts.3

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_translate-function
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Standardize currencies:

Learn more on GPT_FORMAT.

Extract data with GPT_EXTRACT

Extract postal addresses:

Extract email addresses:

Extract emails and URLs:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_format-function
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Learn more on GPT_EXTRACT.

Analyze

Get instant insights from large volumes of content through automated summarizing,
categorization, tagging, and sentiment analysis.

Summarize data with GPT

Summarize customer tickets across languages:

Summarize long descriptions:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_extract-function
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Learn more on GPT.

Categorize or classify data with GPT_CLASSIFY

Categorize customer feedback:

Analyze sentiment:

Categorize customer feedback with examples:

Learn more on GPT_CLASSIFY.

Assign tags with GPT_TAG

Tag products:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt-function
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_classify-function
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Learn more on GPT_TAG.

Analyze images with GPT_VISION

Applies a prompt to an image. GPT_VISION is the only function that can process images. For
example, you can ask a question about the image, generate a description or generate alt text for
images.

INFO

To use GPT_VISION, you need to select a model that supports images (Vision).

Create content from an image

Write product descriptions:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_tag-function
https://gptforwork.com/help/ai-providers-and-models#vision-models
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Extract information from an image

Extract amounts from invoices:

Extract info from an ID:

Explain elements in an image

Identify elements of an image:

Understand an image:
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Explain formulas:

Learn more on GPT_VISION.

Search the web

Get answers from the web with GPT

INFO

To search the web with a GPT function, select a model with web search capabilities.

Get average hotel prices:

Get most-spoken languages:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_vision-function
https://gptforwork.com/help/ai-providers-and-models#web-search-models
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Fetch top newspaper website URLs:
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Manage GPT formulas from the sidebar in
GPT for Excel
Use the GPT for Excel sidebar to manage your GPT formulas and avoid unexpected changes and
costs.

Retry GPT formulas on error

Re-execute all formulas on error in your current sheet.

Regenerate GPT formula results

Re-execute selected formulas in your current sheet.

Replace GPT formulas with their results

Replace GPT formulas with their results to prevent recalculation permanently.

Manage GPT formula cache for your workbook

Minimize costs by reusing previous results.

Disable GPT formulas for your workbook

Prevent the execution of GPT formulas in your workbook for an indefinite period of time.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/retry-gpt-formulas-on-error
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/regenerate-gpt-formula-results
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/replace-gpt-formulas-with-results
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/disable-gpt-formulas-for-workbook
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Retry GPT formulas on error in GPT for
Excel
After troubleshooting GPT for Excel errors, you can recalculate all GPT formulas in cells tagged
with #ERROR!  or #VALUE! .

All GPT formulas that were on error in the current sheet are recalculated. If some errors persist, let
us know by submitting a support request.

TIP

Replace GPT formulas with their results in the selected cells to prevent any further
recalculation.

In the sidebar, select GPT functions.1

Check that the GPT formulas aren't disabled for your workbook.2

Click Retry errors.3

https://gptforwork.com/help/gpt-for-excel/troubleshooting
https://support.gptforwork.com/hc/en-us/requests/new
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/replace-gpt-formulas-with-results
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/disable-gpt-formulas-for-workbook


GPT for Work Help (Microsoft) 2025-10-22

250 / 366

Regenerate GPT formula results in GPT for
Excel
Re-execute GPT formulas to update results in selected cells.

In the sidebar, select GPT functions, and click Model settings.1

Check that the GPT formulas are not disabled and that caching is disabled for your workbook.2

Select cells with active GPT formulas in the current sheet. Ensure all cells generated by
formulas like GPT_LIST are included to prevent data loss.

3

Click Regenerate selection.4

(Optional) Disable the formulas to prevent recalculations in this sheet and the rest of the
document.

5

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/disable-gpt-formulas-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_list--gpt_hlist-function
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/disable-gpt-formulas-for-workbook
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GPT formula results within the selected cells are regenerated.
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Replace GPT formulas with their results in
GPT for Excel
Convert GPT formulas to static values and prevent any further recalculation, either on a selected
number of cells or across an entire sheet. If you need to recover the original formulas later, you
can use the version history of your Microsoft workbook.

Replace formulas manually

GPT formulas within the manually selected cells are replaced by their respective results.

Replace formulas in selection

GPT formulas within the selected cells are replaced by their respective results.

Select the cells that contain the GPT formulas.1

Copy them by pressing Ctrl+C (or Cmd+C on Mac).

NOTE

For GPT formulas with multi-row results, copy all rows with results, not just the formula
row.

2

Paste the results as values by pressing Ctrl+Shift+V (or Cmd+Shift+V on Mac).3

Select cells with active GPT formulas in the current sheet, ensuring all cells generated by
formulas like GPT_LIST are included to prevent data loss.

1

In the sidebar, select GPT functions.2

Choose In selection in the Replace formulas dropdown.3

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_list--gpt_hlist-function
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Replace formulas in entire sheet

All GPT formulas within the sheet are replaced by their corresponding results.

In the sidebar, select GPT functions.1

Refresh the formula count to see the number of active GPT formulas in the current sheet.
Formulas on error won't be replaced.

2

Choose In sheet in the Replace formulas dropdown.3
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Manage GPT formula cache for your
workbook in GPT for Excel
Cache the results of your GPT formulas to minimize costs by reusing previous results, or disable
caching to experiment with sidebar settings.

Enable cache to save costs and reuse previous results when
reloading a formula

You can enable cache usage to avoid being charged for reusing formulas. This mode ensures that
results for the same formula are retrieved from the cache instead of generating new results.

Caching is enabled for GPT formula results in your workbook. You can now save costs and reuse all
future results of your GPT formulas.

Disable cache to experiment with sidebar settings

If you want to quickly experiment with various settings, you can disable cache usage. Disabling
your cache doesn’t clear its content. It stops storing new executions and fetching existing ones
from it.

In the sidebar, select GPT functions, and click Model settings.1

Click on the Enable cache switch to start saving results.2

(Optional) Replace GPT formulas with their results if you want to preserve the current results.1

In the sidebar, select GPT functions, and click Model settings.2

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/replace-gpt-formulas-with-results
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Caching is disabled for GPT formula results in your workbook. Each time the formulas are
reloaded, they will be executed again, incur costs, and may return new results.

Click on the Enable cache switch to put it in disabled state.3
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Disable GPT formulas for your workbook in
GPT for Excel
If the GPT for Excel cache is disabled, reloading active GPT formulas triggers their re-execution,
which incurs costs and potentially returns new results. To preserve your results and avoid
additional costs, disable GPT formula execution in your workbook.

In the sidebar, select GPT functions, and click Disable.

The button label changes to Run.

The GPT formulas in your workbook will not be executed until you click Run. If your workbook
contains multiple sheets, the GPT formulas across all these sheets are prevented from executing.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
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All GPT functions in GPT for Excel
Discover all custom functions in GPT for Excel, along with simple examples and an extensive list of
parameters. If you're looking for more examples, download our GPT for Excel examples template,
and open it in Excel as a new workbook.

GPT for Excel functions speedrun!GPT for Excel functions speedrun!

TIP

To generate responses based on fresh web search data, use a model with web search
capabilities (indicated by the 🌐 icon in the model switcher).

GPT function

The simplest function included in GPT for Microsoft Excel. Outputs the result in a single cell.

INFO

To process images, use GPT_VISION.

How to use

Syntax =GPT(prompt, [value], [temperature], [model])

Copy/paste
example

=GPT("Write a tagline for an ice cream shop.")

https://gptforwork.com/help/gpt-for-excel/overview
https://drive.google.com/file/d/1JsiR_cAIbuBi-O53VmfNLsXlW0v8SXPS/view
https://www.youtube.com/watch?v=q_9YN1nPP_E
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Syntax =GPT(prompt, [value], [temperature], [model])

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A response to your prompt in a single cell

Parameters

Parameter Definition

prompt (cannot be empty)

Instruction provided to the AI to generate a result in a single
cell.

The prompt parameter can be:

A string: "Write a tagline for an ice cream 
shop."

A cell: A1
A range of cells: A1:C3

(optional) value Text, cell or range you want your prompt to apply to

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_CLASSIFY function

Classifies a piece of text into a single category selected from a predefined list of categories.

How to use

Syntax
=GPT_CLASSIFY(value, categories, [examples], [temperature],
[model])

Copy/paste
example

=GPT_CLASSIFY("banana", "fruit, vegetable")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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Syntax
=GPT_CLASSIFY(value, categories, [examples], [temperature],
[model])

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The best applicable category

Parameters

Parameter Definition

value (cannot be
empty)

Input text to classify.

The value parameter can be:

A string: "banana"
A cell: A1
A range of cells: A1:C3

categories (cannot
be empty)

Comma-separated categories or range of categories to choose from.
Only the most relevant category will be returned.

(optional) examples
A table of examples in two columns. The first column should contain
the inputs and the second column should contain the outputs.

(optional)
temperature, model See temperature and model.

See more usage examples.

GPT_EDIT function

Applies the given task to the given text. The default task is to fix grammar and spelling.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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How to use

Syntax =GPT_EDIT(text, [task], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The edited text in a single cell

Parameters

Parameter Definition

text (cannot be
empty)

Input text to edit.

The text parameter can be:

A string: "For sum reezon thoose nunsberz arnt addin 
up"

A cell: A1
A range of cells: A1:C3

(optional) task

Text, cell or range specifying how the text should be edited. Defaults
to fixing grammar and spelling. Other examples:

"Make it funnier"

"Make it shorter"
"Make it sound formal"
"Add an ending"

(optional)
temperature, model See temperature and model.

See more usage examples.

=GPT_EDIT("For sum reezon thoose nunsberz arnt addin 
up")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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GPT_EXTRACT function

Extracts specific elements from text, such as names, dates, email addresses, URLs, or product
attributes. Outputs as comma-separated values.

How to use

Syntax GPT_EXTRACT(text, to_extract, [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters instead
of ","

Output The extracted entities as comma-separated values in a single cell

Parameters

Parameter Definition

text (cannot be empty)

Input text to extract data from.

The text parameter can be:

A string: "I worked 5 years at Amazon.com and then 3 
years at Apple"

A cell: A1
A range of cells: A1:C3

to_extract (cannot be
empty)

Text, cell or horizontal range specifying what you want to
extract.

Examples:

"companies"
B3:E3

(optional) temperature,
model See temperature and model.

=GPT_EXTRACT("I worked 5 years at Amazon.com and then 3 
years at Apple", "companies")
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See more usage examples.

GPT_FORMAT function

Formats dates, currencies, addresses, names, etc. Fixes capitalization. And so much more.

How to use

Syntax
=GPT_FORMAT(input, target_format, [source_format], [temperature],
[model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output
The converted input in a single cell unless it is converted a table, which
outputs a table

Parameters

Parameter Definition

input (cannot be
empty)

Input text to format.

The input parameter can be:

A string: "14 February 1971"
A cell: A1
A range of cells: A1:C3

target_format
(cannot be empty)

Target format for the input. Examples: "iso", "currency iso",
"international phone number", "lowercase/uppercase/camelcase/snake
case/title case/sentence case"…

(optional)
source_format

Source format of the input. Optional, but including it can yield better
results.

=GPT_FORMAT("14 February 71", "iso")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples


GPT for Work Help (Microsoft) 2025-10-22

263 / 366

Parameter Definition

(optional)
temperature,
model

See temperature and model.

See more usage examples.

GPT_LIST / GPT_HLIST function

Like GPT, but outputs the results in a column. Very practical when the output is a list.

Use GPT_LIST to return options listed vertically.

Use GPT_HLIST to return options listed horizontally.

How to use

Syntax =GPT_LIST(prompt, [value], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output As many responses to your prompt as you asked, one response per cell

Parameters

Parameter Definition

prompt (cannot be empty)

Instruction provided to the AI to generate a list.

The prompt parameter can be:

A string: "Give me 5 good short ads about 
spreadsheets."

A cell: A1
A range of cells: A1:C3

=GPT_LIST("Give me 5 good short ads about 
spreadsheets.")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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Parameter Definition

(optional) value Text, cell or range you want your prompt to apply to

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_MATCH function

Matches the values of two columns by similarity.

INFO

Regardless of the model you select in the model switcher, this function uses text-embedding-
ada-002, for a fixed cost of $0.25 per 1M tokens.

WARNING

GPT for Excel settings do not apply to the GPT_MATCH function.

You can only match up to about 1,000 rows at a time.

How to use

Syntax
=GPT_MATCH(search_keys, lookup_range, [confidence], [stats],
[top_k])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A column of the best matches to each value in the range

=GPT_MATCH(A1:A10,B1:B4)

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
https://platform.openai.com/docs/models/text-embedding-ada-002
https://platform.openai.com/docs/models/text-embedding-ada-002
https://gptforwork.com/help/gpt-for-excel/configuration
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Parameters

Parameter Definition

search_keys (cannot be
empty)

The values that you want to look for in the range

lookup_range (cannot
be empty)

The range in which to look for values that are similar to search keys

confidence (optional)
Set a similarity threshold: only values with a superior similarity
score are matched. Must be comprised between 0 and 1

stats (optional) "true" to display similarity scores

top_k (optional)
Number of matching values to return per search_key (default: 1 -
only the best match)

GPT_SPLIT / GPT_HSPLIT function

Splits text semantically, such as by section, paragraph, sentence, customer…

Use GPT_SPLIT to return outputs listed vertically.

Use GPT_HSPLIT to return outputs listed horizontally.

How to use

Syntax =GPT_SPLIT(text, split_by, [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output Input text is split as requested, one element per cell

=GPT_SPLIT("Hello! How are you? Have you heard of GPT 
for Work?", "sentences")



GPT for Work Help (Microsoft) 2025-10-22

266 / 366

Parameters

Parameter Definition

text (cannot be empty)

Input text to split.

The text parameter can be:

A string: "Hello! How are you? Have you heard of GPT 
for Work?"

A cell: A1
A range of cells: A1:C3

split_by (cannot be empty)

How to split the text. Examples:

sections
paragraphs
sentences
punctuation

(optional) temperature,
model See temperature and model.

GPT_TABLE function

Like GPT, but outputs the results in a table. Very practical when the output is a table.

How to use

Syntax =GPT_TABLE(prompt, [head], [inputs], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The response to your prompt in the shape of a table

=GPT_TABLE("top 10 most eaten fruits and their 
nutrition data")



GPT for Work Help (Microsoft) 2025-10-22

267 / 366

Parameters

Parameter Definition

prompt (cannot be
empty)

Instruction to generate a table.

The prompt parameter can be:

A string: "top 10 most eaten fruits and their nutrition 
data"

A cell: A1
A range of cells: A1:C3

(optional) head
Range containing at least one row. the first row should be headers, the
following rows can be used to specify examples If left empty, headers
will be generated automatically.

(optional) inputs Range containing partial rows to complete with GPT_TABLE

(optional)
temperature,
model

See temperature and model.

GPT_TAG function

Applies user-defined tags to text or automatically suggests relevant tags if none are specified.

How to use

Syntax =GPT_TAG(value, [tags], [examples], [top_k], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The applicable tags as csv in a single cell

=GPT_TAG("I love chocolate", "food, positive, 
negative")
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Parameters

Parameter Definition

value (cannot be
empty)

Input text to tag.

The value parameter can be:

A string: "I love chocolate"
A cell: A1
A range of cells: A1:C3

(optional) tags
Comma-separated tags or range of tags applicable. If left empty,
GPT_TAG will automatically come up with the tags

(optional) top_k Maximum number of tags to return

(optional) examples
A table of examples in two columns. The first column should contain
the inputs and the second column should contain the outputs.

(optional)
temperature, model See temperature and model.

See more usage examples.

GPT_TRANSLATE function

Translates text from one language to another. Works better if you specify the source language.

How to use

Syntax
=GPT_TRANSLATE(text, [target_language], [source_language],
[instructions],[temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters instead
of ","

=GPT_TRANSLATE("Cool off with our delicious treats!", 
"spanish")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
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Syntax
=GPT_TRANSLATE(text, [target_language], [source_language],
[instructions],[temperature], [model])

Output The requested translation in a single cell

Parameters

Parameter Definition

text (cannot be empty)

Input text to translate.

The text parameter can be:

A string: "Cool off with our delicious treats!"
A cell: A1
A range of cells: A1:C3

(optional)
target_language

Language of the output. Examples: "spanish", "chinese",
"french". Defaults to "english".

(optional)
source_language

Language of the input. Example: "english"

(optional) instructions
Additional instructions for the translation. Can include a
dictionary of translations.

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_VISION function

Applies a prompt to an image. For example you can ask a question about the image, ask for a
description of it, or generate alt text for images. Learn more.

INFO

GPT_VISION is the only function that accepts images as input.

If you want to use GPT_VISION, you must use a vision model, like gpt-4.1 .

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
https://gptforwork.com/blog/bulk-write-alt-text-chatgpt-excel-google-sheets
https://gptforwork.com/help/ai-providers-and-models#vision-models
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How to use

Syntax =GPT_VISION(prompt, image_url, [high_res], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output
A response to your prompt according to the information extracted from
the image

Parameters

Parameter Definition

prompt
(cannot be
empty)

Instruction provided to the AI to analyze an image.

The prompt parameter can be:

A string: "Write a short description for this product"
A cell: A1
A range of cells: A1:C3

image_url

Link to the image you want the AI to analyze. Supported formats are PNG, JPEG, 
non-animated GIF.

The image_url parameter can be:

A string:
"https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:e
6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png

A cell: A4

(optional)
high_res

How the AI processes the image and generates its textual understanding. Possib
true , false , and auto  (default). Learn more.

(optional)
temperature,
model

See temperature and model.

=GPT_VISION("Write a short description for this 
product", A1, , , "gpt-4.1")

https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:eco/b5ab0a6c-6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png
https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:eco/b5ab0a6c-6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png
https://platform.openai.com/docs/guides/images-vision?api-mode=chat#specify-image-input-detail-level
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See more usage examples.

GPT_WEB function

INFO

The GPT_WEB function is deprecated. We recommend using models with web search
capabilities (indicated by the 🌐 icon in the model switcher) with any GPT function instead.
See our web search guide for more details.

If you want to use GPT_WEB, you must select the Perplexity Sonar model in the model
switcher or add it as a function parameter. See our troubleshooting guide for more details.

How to use

Syntax =GPT_WEB(prompt, [value])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A response to your prompt based on recent web search data

Parameters

Parameter Definition

prompt (cannot
be empty)

Instructions provided to the AI to generate results based on recent web
search data. Provide instructions in English for better results.

The prompt parameter can be:

A string: "Who won the last presidential elections in 
Argentina?"

A cell: A1

(optional) value Text, cell, or range you want your prompt to apply to

See more usage examples.

=GPT_WEB("Who won the last presidential elections in 
Argentina?")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/create-gpt-formulas/gpt-formula-examples
https://gptforwork.com/help/gpt-for-excel/search-web
https://gptforwork.com/help/gpt-for-excel/troubleshooting/gpt-functions#gpt_web-function-is-not-working
https://gptforwork.com/help/gpt-for-excel/search-web#web-search-with-gpt-functions
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GPT_CREATE_PROMPT helper function

Like the native CONCAT function, but inserts spaces and newlines automatically. Helps you create
a prompt from scattered, disjointed cells and ranges. You can then use that prompt in GPT
functions. This function does not call any AI provider's API and thus does not incur any cost.

How to use

Syntax =GPT_CREATE_PROMPT(arg1, [arg2], [arg3], [...argn])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A prompt ready to use in GPT, GPT_LIST or GPT_TABLE

Parameters

Parameter Definition

arg1 (cannot be empty)

Cell or range to concatenate. For example:

A1
A1:C3

(optional) arg2 - argn

Cell or range to concatenate. For example:

A2
G2:H4

temperature and model

These parameters are present in most GPT functions. They are always optional.

For example with the GPT function, you can set:

temperature to 0.1

model to "gpt-4o-mini"

=GPT_CREATE_PROMPT(A1:B1, A2, C3:D5, E1:E6)
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You can also set these values from the sidebar very easily. In this case, they become the default
values for all future executions.

Parameter Definition

(optional)
temperature

Number between 0 and 1 that governs the creativity of the output:

0 - Strictly according to the prompt

0.5 - Slightly creative

1 - Very creative

NOTE

In some locales, you might need to use "0,5" (comma) instead of
"0.5" (period).

(optional) model
Name of the model surrounded by quotes. You can find model names
in the model switcher in the sidebar.

https://gptforwork.com/help/gpt-for-excel/configuration
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Configuration of GPT for Excel
Configure the GPT for Excel settings for your workbook. Select a model, specify global instructions,
adjust the creativity level, and get even more control with advanced settings.

Select a model

Select the right AI model for your work, with or without an API key.

Add global instructions

Assign a very precise role to the AI to define its field of expertise and how it responds.

Set the creativity level

Define how standard (or not) your output is expected to be.

Adjust advanced settings

Get greater control over AI-generated output in Microsoft Excel.

https://gptforwork.com/help/ai-models/select-model?app=excel
https://gptforwork.com/help/gpt-for-excel/configuration/add-global-instructions
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-excel/configuration/adjust-advanced-settings
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Add global instructions in GPT for Excel
Provide global instructions to add preferences or requirements that you'd like the AI to consider
when generating its responses. All GPT for Excel operations in the current workbook will take these
instructions into account.

GPT for Excel uses the global instructions to generate all responses for GPT functions and bulk AI
tools in the current workbook.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
instructions when you re-execute them.

To re-execute an existing formula with the new instructions:

Change a parameter in the formula and press Enter.

Disable the cache, select the formula, and regenerate its results.

What's next

Run bulk AI tools and execute GPT functions in GPT for Excel.

Configure other settings to customize how the language model operates.

In the sidebar, select GPT functions, and click Model settings.1

Select the type of instructions you'd like to add and edit them if needed.2

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/regenerate-gpt-formula-results
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/configuration
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Set the creativity level in GPT for Excel
Set the creativity level that will be used for all GPT for Excel operations in your workbook to
define how standard (or not) your output is expected to be. You can find out more about the
temperature setting, used by OpenAI to set a creativity level, in our Temperature guide.

GPT for Excel uses the creativity level to generate all responses for GPT functions and bulk AI tools.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
creativity level when you re-execute them.

To re-execute an existing formula with the new creativity level:

What's next

Run bulk AI tools and execute GPT functions in GPT for Excel.

Configure other settings to customize how the language model operates.

In the sidebar, select GPT functions, and click Model settings.1

Use the slider to set Creativity between 0  and 1 .2

Set the temperature  parameter directly in the formula.1

Press Enter to re-execute the formula.2

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/guides/openai-gpt3-temperature
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/configuration
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#temperature-and-model
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Adjust advanced settings in GPT for Excel
Adjust the advanced settings in GPT for Excel to have greater control over generated output in
Microsoft Excel. You can learn more in the OpenAI API documentation.

Term Definition

Token

Tokens can be thought of as pieces of words. During processing, the
language model breaks down both the input (prompt) and the output
(completion) texts into smaller units called tokens. Tokens generally
correspond to ~4 characters of common English text. So 100 tokens are
approximately worth 75 words. See how text is split into tokens.

Top P
Helps adjust creativity level – Lower values result in more focused
output, while higher values allow for more creative responses.

Frequency
penalty (not
available for
Claude models)

Penalizes tokens based on their frequency in the text so far – Higher
values discourage the model from repeating the same tokens too
frequently, as the more they appear in the text, the more penalized they
get.

Presence penalty
(not available for
Claude models)

Penalizes new tokens based on whether they appear in the text so far –
Higher values encourage the model to use new tokens that are not
penalized.

In the sidebar, select GPT functions, and click Model settings.1

Open the View advanced settings dropdown.2

Use the corresponding sliders to set the values for:3

Top P: Adjust creativity by setting the value between 0  and 1 .

Set the creativity level to 1 when the value for Top P is lower than 1.

https://gptforwork.com/help/gpt-for-excel/overview
https://platform.openai.com/docs/api-reference/chat/create
https://gptforwork.com/tools/tokenizer
https://gptforwork.com/help/gpt-for-excel/configuration/set-creativity-level
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GPT for Excel uses the selected model to generate all responses for GPT functions and bulk AI
tools.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
advanced settings when you re-execute them.

To re-execute an existing formula with the new advanced settings:

Change a parameter in the formula and press Enter.

Disable the cache, select the formula, and regenerate its results.

What's next

Run bulk AI tools and execute GPT functions in GPT for Microsoft Excel.

Configure other settings to customize how the language model operates.

Frequency penalty: Set a penalty between 0  and 2  to apply to tokens each time they are
repeated in the result.

Presence penalty: Set a one-time penalty between 0  and 2  for tokens that appear more
than once in the result.

https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/regenerate-gpt-formula-results
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/configuration
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Search the web with GPT for Excel
Search the web directly in GPT for Excel using web search models. These models use fresh web
search data, which allows you to generate up-to-date responses about companies, current events,
facts, and more, directly in your workbook. You can also fetch content from specific URLs to extract
information from web pages.

Choose the right web search model

Choose a web search model that best fits your use case.

Web search

Get information that is not in the model's built-in knowledge:

Example: Finding the current CEO of a company.

How it works:

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific focus.

Web search models do not fetch full page content. Instead, they read search result snippets, like
you would see on a Google search results page. The snippets are added to the context of the
models, so they can use the information to generate a response.

Recommended models:

Sonar for quick results (cheapest).

Sonar Pro or Sonar Reasoning or GPT-4o Search models for high quality results.

Gemini models with Web search for Google search quality (most expensive).

Content fetching

Focus on specific URLs and extract content from them:

Example: Extracting the product name and price from the URL of a product page.

How it works: Some web search models can access the full content from specific URLs. The full
content is added to the context of the models, so they can use it to answer questions about the
content or extract information from it.

Recommended models:

Gemini 2.5 models with URL context

https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/overview
https://gptforwork.com/help/gpt-for-excel/search-web?model=perplexity-sonar#model-specific-settings
https://gptforwork.com/help/gpt-for-excel/search-web?model=perplexity-sonar#model-specific-settings
https://gptforwork.com/help/gpt-for-excel/search-web?model=openai-gpt-4o-search#model-specific-settings
https://gptforwork.com/help/gpt-for-excel/search-web?model=google-gemini#model-specific-settings
https://gptforwork.com/help/gpt-for-excel/search-web?model=google-gemini#model-specific-settings
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Provider Model
Without API

key
With API key

Perplexity

sonar ✅ ✅

sonar-pro ❌ ✅

sonar-reasoning ✅ ✅

sonar-reasoning-pro ❌ ✅

Google

gemini-2.0-flash ❌ ✅

gemini-2.0-flash-lite ❌ ✅

gemini-2.5-flash ✅ ✅

gemini-2.5-flash-lite ❌ ✅

gemini-2.5-pro ❌ ✅

OpenAI

gpt-4o-mini-search-preview ✅ ✅

gpt-4o-search-preview ✅ ✅

gpt-5-search-api ✅ ✅

For detailed pricing, see AI providers and models.

Use web search models

Bulk tools

Use bulk tools to perform web searches with any model that has web search capabilities (🌐).

Click here for a list of all web search models supported by GPT for Excel.

Open GPT for Excel.1

In the sidebar, select Bulk AI tools and click the tool you want to use.2

https://gptforwork.com/help/ai-providers-and-models#web-search-models
https://gptforwork.com/help/open?app=excel
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Your search results appear in the output column. If you enabled source references, they appear in
the adjacent column.

Expand the model switcher and select a web search model (indicated by the 🌐 icon).3

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

4

Set up your bulk tool run. For example, to set up a Custom prompt run:

Field Description Example

Prompt to run
for each row

Enter the prompt you want to run
for each row.

Find and summarize 
reviews for: 
{{Event}}.

Put results in
column

Select the column to put the
results in. Cells in these columns
won't be overwritten with the
results if they contain text.

B: Information

Show sources
Enable this option to write source
references in the column to the
right of the results column.

Enabled

5

Click Run rows.6

https://gptforwork.com/help/gpt-for-excel/search-web?model=google-gemini#model-specific-settings
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For instructions on how to use the tools, see Bulk AI tools.

GPT functions

Use GPT functions to perform web searches with any model that has web search capabilities (🌐).

Using the model switcher

Specifying the model in the formula

Open GPT for Excel.1

In the sidebar, select GPT functions.2

Expand the model switcher and select a web search model (indicated by the 🌐 icon).3

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

4

In the workbook, select a cell and write your formula:

The formula uses the web search model selected in the model switcher.

5

=GPT("Find the Instagram handle for 'Berlin Salsa Festival 2025'.")

Open GPT for Excel.1

In the sidebar, select GPT functions.2

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

3

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/gpt-for-excel/search-web?model=google-gemini#model-specific-settings
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For instructions on how to write formulas with GPT functions, see GPT functions.

Model-specific settings

Use the model-specific settings to configure the web search model for your use case.

Google Gemini

Setting Description Example

Web search

Let Gemini decide when a Google search can
improve the answer. This allows Gemini to provide
more accurate answers and cite verifiable sources
beyond its built-in knowledge. Enabling Web
search incurs an additional search cost.

URL context

(Gemini 2.5 only)

Provide up to 20 URLs (pages, images, PDFs) to
focus your search. No search cost is incurred, but
the content retrieved from URLs counts as input
tokens.

In the workbook, select a cell and write your formula, specifying a web search model directly
in the formula, for example the Perplexity Sonar model:

The formula uses the web search model regardless of what's currently selected in the model
switcher.

4

=GPT("Find the Instagram handle for 'Berlin Salsa Festival 2025'.", , , 
"sonar")

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/ai-providers-and-models#web-search-models
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Perplexity Sonar

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

Domains

(Bulk tools only)

Specify up to 20 domains to generate responses
based only on search results from these domains.
Use simple domain names (e.g., wikipedia.org )
without additional elements like https://  or
www.  prefixes.

OpenAI GPT-4o Search

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

https://gptforwork.com/help/ai-providers-and-models#web-search-models
http://www/
https://gptforwork.com/help/ai-providers-and-models#web-search-models


GPT for Work Help (Microsoft) 2025-10-22

285 / 366

Use images in prompts in Excel
Use images in your prompts with GPT for Excel and vision models, which are multimodal and can
process both text and images as input. For example, you can prompt images to describe them, or
prompt images with additional text input from your spreadsheet to create product descriptions
based on their photos and names.

TIP

Don't have image URLs yet? Learn how to host images on Google Drive for AI processing.

INFO

Supported image formats: PNG, JPEG, WebP, non-animated GIF.

Models that support vision

We recommend using gpt-4.1 to analyze images, but you can use any vision model supported by
GPT for Excel.

https://gptforwork.com/help/ai-providers-and-models#vision-models
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Provider Model
Without API

key
With API key

OpenAI

gpt-4.1 ✅ ✅

gpt-4.1-mini ✅ ✅

gpt-4.1-nano ✅ ✅

gpt-4o ✅ ✅

gpt-4o-mini ✅ ✅

gpt-5 ✅ ✅

gpt-5-chat ✅ ✅

gpt-5-mini ✅ ✅

gpt-5-nano ✅ ✅

o3 ✅ ✅

o4-mini ✅ ✅

Anthropic

claude-3.5-haiku ❌ ✅

claude-3.7-sonnet ❌ ✅

claude-4-sonnet ✅ ✅

claude-4.5-sonnet ✅ ✅

Prompt images only

TIP

Want to use both text and images in your prompt? Skip to Prompt images with additional text
input.

Click here for a list of all vision models supported by GPT for Excel.
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Bulk AI tools vs. GPT functions

To apply a prompt to images in your spreadsheet, you can either use the Prompt images (Vision)
bulk AI tool or the GPT_VISION function. Choose the method that best fits your needs:

Use the Prompt images (Vision) bulk AI tool if:

You want to apply a prompt to images in bulk (row-by-row).

You are working with thousands of rows.

You want to include up to 5 images per prompt.

A low image resolution is sufficient for your needs.

Use the GPT_VISION function if:

You're comfortable using spreadsheet formulas.

You're working with up to a few hundred cells or you want to prompt images for individual
cells.

You need the flexibility of nested formulas or of combining GPT functions with native
functions.

You only need to include a single image per prompt.

You want to control the image resolution.

Prompt images (Vision) bulk AI tool

Use the Prompt images (Vision) bulk AI tool to apply a prompt to images in your spreadsheet.

Open GPT for Excel.1

https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
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In the sidebar, select Bulk AI tools and click Prompt images (Vision).2

Expand the model switcher and select a vision model.3

Set up your bulk tool run.

Field Description Example

Prompt
Enter the prompt you want to
apply to each image.

Write a short 
description of this 
product based on how 
it looks, how it's 
used, and its build 
quality.

Columns
containing
image URLs

Select up to five columns that
contain image URLs. For each row,
the tool processes all images
present in the selected columns.
URLs must be publicly accessible.

C: Front image, D: 
In-use image, E: 
Material detail 
image

4
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You have set up and run the Prompt images (Vision) bulk tool to apply a prompt to images in
your spreadsheet.

For instructions on how to improve the results, see Prompt images (Vision) bulk AI tool.

GPT_VISION function

Use the GPT_VISION function to describe or analyze images in individual cells.

Using the model switcher

Field Description Example

Image resolution

Choose the level of detail for
image processing:

Low

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

F: Description

High: Better image
understanding, higher latency
and cost
Low: Faster processing, lower
cost
Auto: Let the model decide
(default)

Click Run rows.5

Open GPT for Excel.1

In the sidebar, select GPT functions.2

Expand the model switcher and select a vision model.3

In the workbook, select a cell and write your formula:4

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/prompt-images#improve
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
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Specifying the model in the formula

For instructions on how to write formulas with the GPT_VISION function and set the image
resolution, see GPT_VISION.

Prompt images with additional text input

Custom prompt bulk AI tool

Use the Custom prompt bulk AI tool to combine a prompt with text and images from your
spreadsheet.

INFO

In the Custom prompt bulk AI tool, the image resolution is fixed to Low and cannot be
changed.

The formula uses the vision model selected in the model switcher.

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.",C9)

Open GPT for Excel.1

In the workbook, select a cell and write your formula, specifying a vision model directly in the
formula:

The formula uses the vision model regardless of what's currently selected in the model
switcher.

2

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.",C9, , , "gpt-4.1")

Open GPT for Excel.1

In the sidebar, select Bulk AI tools and click Custom prompt.2

Expand the model switcher and select a vision model.3

Write your prompt and include any variables to be replaced with values from your
spreadsheet.

4

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_vision-function
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
https://gptforwork.com/help/open?app=excel
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You have set up and run the Custom prompt bulk tool to include images and text from your
spreadsheet.

For instructions on how to improve the results, see Custom prompt bulk AI tool.

Host images on Google Drive for AI processing

To process an image in GPT for Excel, you need the direct URL of the image and the URL must be
publicly accessible.

To host an image on Google Drive so that GPT for Excel can access and process it:

Write a short description of {{Product name}} based on how it looks, how 
it's used, and its build quality.

Click Configure image columns to show the Columns containing image URLs dropdown,
and select the columns that contain image URLs.

5

Click Run rows.6

Upload the image to Google Drive.1

Share the image publicly using the Anyone with the link option. For more information, see
Google Drive Help.

TIP

To prevent other users from commenting or editing the image, set the access role to
Viewer.

2

Copy the link.3

Get the image file ID from the link URL, and build the following new URL with the ID:

For example:

4

https://drive.google.com/uc?id=<image-file-id>

# Original share URL from "Copy link"
https://drive.google.com/file/d/1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux/view

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt#improve
https://support.google.com/drive/answer/2494822
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You now have a direct image URL that you can access and process in GPT for Excel.

# Direct image URL
https://drive.google.com/uc?id=1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux
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Troubleshooting GPT for Excel
Find solutions and advice for troubleshooting various scenarios, including installation issues, API
key validation, billing and subscription, bulk processing errors, formula syntax issues, and rate
limits.

Billing issues

Troubleshoot balance issues and unexpected costs.

Installation issues

Troubleshoot installation issues and Microsoft account sign-in issues.

GPT function issues

Troubleshoot GPT function loading issues, error messages, and incomplete results.

Bulk AI tool issues

Troubleshoot ownership permissions, stuck processes, and custom prompt issues.

API key issues

Troubleshoot API key setup issues.

Rate limit issues

Troubleshoot token and request limit issues.

Add-in not working

Troubleshoot multiple accounts errors, blank sidebars, and menu visibility problems.

If none of the listed solutions addresses your issue, reach out to our support team for further
assistance.

https://gptforwork.com/help/gpt-for-excel/troubleshooting/billing
https://gptforwork.com/help/gpt-for-excel/troubleshooting/installation
https://gptforwork.com/help/gpt-for-excel/troubleshooting/gpt-functions
https://gptforwork.com/help/gpt-for-excel/troubleshooting/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/troubleshooting/api-keys
https://gptforwork.com/help/gpt-for-excel/troubleshooting/rate-limits
https://gptforwork.com/help/gpt-for-excel/troubleshooting/add-in-not-working
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CONTACT SUPPORT

https://support.gptforwork.com/hc/en-us/requests/new
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Billing issues (GPT for Excel)

I have a ChatGPT Plus / Pro / Teams / Enterprise subscription, but
my balance is empty

Problem: You have a ChatGPT Plus / Pro / Teams / Enterprise subscription, but GPT for Excel still
says that your balance is empty.

SOLUTION

OpenAI's ChatGPT Plus / Pro / Teams / Enterprise subscription is neither necessary nor
sufficient for using the GPT for Work add-ons.

Buy a pack to add money to your balance in GPT for Excel.

I bought a pack but my balance is empty

Problem: You have bought a pack but your balance in GPT for Excel is still empty.

SOLUTION

Click on your balance in GPT for Excel and check that you are using the Microsoft account with
which you have purchased your pack. Switch to another account if needed.

My packs have disappeared from the tracking screen

Problem: You have bought packs and used GPT for Excel but now all your packs have disappeared
from the usage tracking screen.

SOLUTION

Click on your balance in GPT for Excel and check that you are using the Microsoft account with
which you have bought your packs. Switch to another account if needed.

The costs are too high

Problem: Your consumption is higher than you expected and you wish to spend less money on
GPT function executions.

https://help.openai.com/en/articles/6950777-what-is-chatgpt-plus
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/buy-pack?platform=microsoft
https://gptforwork.com/help/sign-in/switch-to-another-account
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/track-purchases-and-consumption
https://gptforwork.com/help/sign-in/switch-to-another-account
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SOLUTIONS

Estimate your costs with the Token counter before executing GPT functions on a large
number of cells. Select Token counter from the add-in menu to access it.

Select a cheaper model after comparing their costs with the Cost estimator.

Set up an API key to save on total cost.

https://gptforwork.com/help/ai-models/select-model?app=excel
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/cost-estimator
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
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Installation issues (GPT for Excel)

I can't sign in after installing

Problem: You have installed GPT for Excel and you have trouble signing in with Microsoft.

SOLUTIONS

Check which versions of Excel and which browsers are supported by this add-in.

Try using the web version of Excel instead of the desktop version.

Try using Excel in a private/incognito window.

I signed in with the wrong Microsoft account

Problem: You signed in with the wrong Microsoft account while installing GPT for Excel and need
to switch to the correct one.

SOLUTION

Open the sidebar menu and click Log out to sign out, then sign in again with the correct
account. Learn more.

I want to uninstall

Problem: You are not using the add-in in Excel or Word, and you want to uninstall it.

SOLUTION

To remove the add-in from Excel and Word, follow our uninstallation guide.

I can't uninstall GPT for Excel

Problem: GPT for Excel prompts you to be activated every time you open Excel, which may be
caused by remaining GPT formulas in your workbook.

https://gptforwork.com/help/gpt-for-excel/faq#which-versions-of-excel-are-compatible-with-this-add-in
https://gptforwork.com/help/gpt-for-excel/faq#which-versions-of-excel-are-compatible-with-this-add-in
https://gptforwork.com/help/gpt-for-excel/faq#which-browsers-are-compatible-with-gpt-for-excel
https://gptforwork.com/help/sign-in/sign-out-from-gpt-for-excel-and-word
https://gptforwork.com/help/gpt-for-excel/uninstall


GPT for Work Help (Microsoft) 2025-10-22

298 / 366

SOLUTION

To find and remove all GPT formulas in your workbook (the experience might be slightly
different on Web version and Mac desktop version):

You can now locate all GPT formulas and delete them.

Problem: You want to uninstall the add-in, but the Remove option is not available in the add-in
Options menu in the Office Add-ins popup.

SOLUTION

Clear the Microsoft Office cache:

Add-in not supported

This add-in is only supported with your Microsoft 365 subscription license and 
is not supported with your Office license.

The following table lists the minimum versions of Microsoft Excel compatible with the GPT for
Excel add-in on different Microsoft Office platforms.

Press CTRL + F to open the Find and Replace window.1

Click Options.2

In Find what, enter =GPT .3

Set Within to Workbook, and Look in to Formulas.4

Click Find All.5

Close all Office applications.1

Follow Microsoft's instructions for clearing the cache.2

Open Excel and try removing the add-in again.3

https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache
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Windows Mac Online

Microsoft 365 subscription:

Version 2002 (Build
12527.20092)

Retail perpetual:

Version 2002 (Build
12527.20092)

Volume-licensed perpetual:

Excel 2021: Version 2108 (Build
12527.20092)

Version 16.35 (Build
20030802)

Supported on:

Google Chrome (latest
version)

Microsoft Edge (latest
version)

Which version of Excel am I using?

https://gptforwork.com/help/gpt-for-excel/faq#my-excel
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GPT function issues (GPT for Excel)

Invalid name

#NAME? Invalid Name Error. The formula contains unrecognized text.

Problem: The GPT functions aren't recognized by Excel.

SOLUTIONS

Check that GPT for Excel is installed on the current Microsoft account.

Click GPT for Excel Word in the Home tab to enable the GPT functions.

If the problem persists, try activating the add-in (the experience might be slightly different
for Mac users):

Use the add-in on the Web version of Excel (see supported versions).

Invalid parameter

Error: Invalid xxx parameter.

Problem: The error indicates a formatting issue or an unreadable parameter within the formula.

SOLUTIONS

Check that your parameters are in the correct order. See the function list.
Check that all parameters (even optional ones) are added as empty when there is another

parameter coming after them:
    ✅ GPT_TRANSLATE(A2, "french",  , "Avoid passive voice")

Check that you are using the right parameter separator for your locale: ,  or ; ?

Check that you are using the correct number formats for temperature for your locale: 0.8
or 0,8 ?

i. Click Add-ins in the Home tab.1

ii. Click More Add-ins.2

iii. Select GPT for Excel Word in the My Add-ins tab.3

iv. Click Add.4

v. Click GPT for Excel Word in the Home tab and click Retry errors in GPT for Excel
sidebar.

5

https://gptforwork.com/help/install#?platform=microsoft
https://gptforwork.com/help/gpt-for-excel/troubleshooting/installation#add-in-not-supported
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
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Missing parameter

#ERROR: Missing required arguments categories for function GPT_XXX.

Problem: One of the parameters in your GPT formula is required and hasn't been set.

SOLUTION

Check which parameters are required for the GPT function you are using and adjust the
formula as needed.

Text values limited to 255 characters

Text values in formulas are limited to 255 characters.

Problem: The text value in your formula is too long and exceeds Excel's 255-character limit.

SOLUTION

Insert the text into another cell and reference it in your formula, for example, =GPT(A1) ,
where A1  contains the text value.

Functions are stuck on #BUSY

Problem: GPT functions fail to execute and remain in a #BUSY! state, even after reopening your file
or restarting Excel.

SOLUTIONS

Open the GPT for Excel sidebar before using any GPT functions:

Click GPT for Excel Word in the Home tab.

Wait for the sidebar to fully load before entering your first GPT formula.

Delete the GPT formula and undo the deletion to run the formula again.

Enter a new GPT formula in a different cell. Subsequent functions typically work correctly.

Use bulk AI tools to avoid this issue in the future, if your use case allows it.

GPT_WEB function is not working

If you're using the GPT_WEB function and experiencing issues, this is likely because:

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
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The GPT_WEB function only works with the Perplexity Sonar model.

If you've selected a non-Perplexity model that uses an API key, GPT_WEB fails because it tries to
use that API key with Perplexity Sonar.

SOLUTIONS

(Recommended)

Select a web search model (🌐) from the model switcher and then use the GPT function.
Learn more.

You can also use a web search model as a parameter in the GPT function. Learn more.

If you want to keep using the GPT_WEB function, make sure you first select the Sonar
model from the model switcher.

=GPT("your prompt")

=GPT("your prompt", , , "sonar")

https://gptforwork.com/help/gpt-for-excel/search-web#using-the-model-switcher
https://gptforwork.com/help/gpt-for-excel/search-web#specifying-the-model-in-the-formula
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Bulk AI tool issues (GPT for Excel)

The Custom prompt tool is not working

Problem: The Custom prompt bulk tool does not give the desired result, often because the prompt
is incomplete or the variables are incorrectly formatted.

SOLUTION

Review the Custom prompt article for guidance on creating effective prompts and using the
tool. If the issue persists, contact support.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://support.gptforwork.com/hc/en-us/requests/new
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API key issues (GPT for Excel)

Your API key is invalid or revoked

Problem: You are trying to set an API key but GPT for Excel won't save it.

SOLUTIONS

Make sure that you copied it correctly, or create a new one and try again.

Solution for immediate use: If immediate use is needed and using your API key is not a
priority, select a model without an API key.

I've entered my API key but it's not working

Problem: You have entered an API key in the GPT for Excel sidebar but you cannot use it.

SOLUTION

Even though you have entered an API key, you also need to purchase a pack in GPT for Excel.
Learn more.

I can't enter my API key

Problem: You can't enter an API key in the GPT for Excel sidebar because you don't have
permission to do so.

SOLUTIONS

Request your space administrator to allow users to set their own API keys. Check the GPT for
Work dashboard to see who the administrator or owner of your team is.

https://gptforwork.com/help/ai-models/set-and-manage-api-keys?app=excel
https://gptforwork.com/help/ai-models/select-model?app=excel
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/faq
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space#control-whether-users-can-set-api-keys
https://dashboard.gptforwork.com/
https://dashboard.gptforwork.com/
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Rate limit issues (GPT for Excel)

Token limit reached

Problem: You are facing a rate limit error message from your AI provider that indicates you've
reached your tokens per minute limit.

SOLUTIONS

Temporary: Choose a different model, or wait until your token limit resets.

Permanent: Use models that don't require an API key or use your own OpenAI API key if
you belong to a Tier 5 organization.

Request limit reached

Problem: You are facing a rate limit error message from your AI provider that indicates you've
reached your requests per minute limit.

SOLUTIONS

Temporary: Choose a different model, or wait until your request limit resets: one minute or
24 hours.
Permanent: Use models that don't require an API key or use your own OpenAI API key if
you belong to a Tier 5 organization.

https://gptforwork.com/help/ai-providers-and-models#tk
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set
https://gptforwork.com/help/ai-providers-and-models#tk
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set
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Add-in not working (GPT for Excel)

Sidebar is blank, or fails to load

Error loading Add-Ins

Problem: GPT for Excel sidebar fails to load, or remains blank.

SOLUTIONS

In the desktop version of Excel, open the menu to the right of the sidebar (Windows) or
click the info icon (macOS), then click Reload.

Restart Excel, create a new workbook, and launch the add-in again by clicking GPT for Excel
Word in the Home tab.

Refresh the add-ins in the Office Add-ins pop-up:

Uninstall and reinstall the add-in.

Clear the Office cache, and then uninstall and reinstall the add-in again:

If the issue persists, contact support.

i. In Excel, select Add-ins in the Home tab.1

ii. Click More Add-ins.2

iii. In the Office Add-ins pop-up, click Refresh.3

i. Clear the Office cache:1

For Windows: Follow the Microsoft instructions to clear the Office cache on
Windows.

For Mac: Follow the Microsoft instructions to clear the Office cache on Mac.

ii. Uninstall the add-in.2

iii. Reinstall the add-in.3

https://gptforwork.com/help/gpt-for-excel/uninstall
https://gptforwork.com/help/install?platform=microsoft
https://support.gptforwork.com/hc/en-us/requests/new
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-windows
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-windows
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-mac
https://gptforwork.com/help/gpt-for-excel/uninstall
https://gptforwork.com/help/install?platform=microsoft
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FAQ (GPT for Excel)

How do I install the GPT for Excel add-in?

Install from Microsoft AppSource:

Learn more.

Which versions of Excel are compatible with this add-in?

The following table lists the minimum versions of Microsoft Excel compatible with the GPT for
Excel add-in on different Microsoft Office platforms.

Windows Mac Online

Microsoft 365 subscription:

Version 2002 (Build
12527.20092)

Retail perpetual:

Version 2002 (Build
12527.20092)

Volume-licensed perpetual:

Excel 2021: Version 2108 (Build
12527.20092)

Version 16.35 (Build
20030802)

Supported on:

Google Chrome (latest
version)

Microsoft Edge (latest
version)

Which version of Excel am I using?

To check your desktop Excel version, see What version of Office am I using? at Microsoft Support.

If you're using Excel Online, your version is always the latest.

Go to the installation page.1

Click Open in Excel.2

Follow the steps until the end.3

https://gptforwork.com/help/install?platform=microsoft
https://support.microsoft.com/en-us/topic/what-version-of-office-am-i-using-d21c5935-40b1-b117-122d-5e5f05a1a263
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-gpt-for-excel-faq&src=website&mktcmpid=help-gpt-for-excel-faq
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Which browsers are compatible with GPT for Excel?

GPT for Excel is compatible with the following browsers:

Google Chrome (recommended for the best experience)

Microsoft Edge (only for Windows users, recommended for the best experience)

Mozilla Firefox

Safari (only for Mac users)

What permissions are required by the GPT for Excel add-in?

See Security and privacy FAQ.

What is the pricing of GPT for Excel?

Our pricing options include a consumption-based plan, which is proportional to your usage, and a
subscription-based plan, which has a fixed monthly fee.

Can GPT for Excel analyze PDF files?

Yes. You can analyze PDF files using GPT for Excel and Google Gemini 2.5 models with URL context.

Can I scrape webpages in Excel?

Yes. You can scrape specific webpages using GPT for Excel and Google Gemini 2.5 models with URL
context.

How can I add users?

You can add users from the dashboard.

How is my data processed? Is it used to train models?

We do not read or store any data from your document that you do not use as an input.

If you use a model with an API key, we do not log or store any of the inputs submitted or
outputs received.

Whether you use a model with or without an API key, Talarian does not use your inputs and
outputs to train language models.

https://gptforwork.com/help/security-privacy-faq#microsoft-permissions-for-gpt-for-excel-word
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/gpt-for-excel/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/gpt-for-excel/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/gpt-for-excel/search-web#choose-the-right-web-search-model
https://dashboard.gptforwork.com/
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For more information, see the Security and privacy FAQ.

Do I need my own API key?

Yes, if you are on a subscription plan.

No, if you use prepaid packs, many models are available without any API key.

NOTE

If you're using GPT for Excel as part of a team space, your space admin can control which
models are available in the model switcher, regardless of your subscription or API key setup.
Learn more.

Can I use my own API key?

Yes.

Using API keys offers several benefits:

More models. Access a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage your AI usage and costs directly on the AI provider's
platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key.
For more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

INFO

Using API keys is mandatory if you're on a subscription plan.

INFO

If you are a user in a space that does not allow users to set their own API keys, you will still
benefit from any space API keys set by the space owner or admins.

Is gpt-4o supported?

Yes, gpt-4o and gpt-4o-mini are supported with and without an API key.

https://gptforwork.com/help/security-privacy-faq
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/ai-providers-and-models#tk
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/security-privacy-faq#how-is-my-data-processed
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/ai-providers-and-models
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Is GPT for Excel connected to the web?

Yes, all bulk AI tools and functions in GPT for Excel can access up-to-date information using models
with web search capabilities (indicated by the 🌐 icon in the model switcher).

Is web browsing available with gpt-4 and gpt-4o?

No, but you can use models with web search capabilities (indicated by the 🌐 icon in the model
switcher).

Where can I find the list of available GPT functions?

The list along with full documentation and video tutorials is available here. To try out some
examples, download our GPT for Excel examples template, and open it in Excel as a new workbook.

Do formulas reload each time the file is opened?

If you have enabled GPT for Excel cache in your workbook, GPT formulas do not reload. Instead,
the results are retrieved from the cache, preventing any extra cost or loss of results.

When the cache is not enabled, GPT formulas follow Excel calculation rules and typically reload
each time you move, insert, or delete rows or columns in your workbook. This causes extra costs
and can lead to loss of results.

Can GPT for Excel process images?

Yes, GPT for Excel supports multiple vision models that you can use with the following features:

Custom prompt bulk AI tool

Prompt images (Vision) bulk AI tool

GPT_VISION function

Can I use OpenRouter?

Yes, you can use the OpenRouter service in GPT for Work with an API key. With OpenRouter, you
can access AI models from multiple providers through a single API key.

For API key setup instructions, check out Connect OpenRouter.

https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-excel/gpt-functions
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://drive.google.com/file/d/1A0Y5aev3-ssnPCd2VDHLU_iGKxrWKGSp/view
https://gptforwork.com/help/gpt-for-excel/gpt-functions/manage-gpt-formulas-from-sidebar/manage-gpt-formula-cache-for-workbook
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/prompt-images
https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions#gpt_vision-function
https://openrouter.ai/
https://gptforwork.com/help/ai-models/connect-to-openrouter-from-excel-sheets-and-word
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Can I use my OpenAI Assistants and custom GPTs?

Yes. You can use OpenAI Assistants and custom GPTs in GPT for Excel:

Set your OpenAI API key and your Assistants will become available in the model switcher.

You can replicate your custom GPTs as Assistants to make them available in the model switcher.

Can I reference data located in another sheet in bulk tools?

Yes, in the prompt field of the Custom prompt bulk tool, you can reference cells located in another
sheet within the same spreadsheet. Use the following syntax for the reference:
{{SheetName!Cell}}  or {{SheetName!Range}}

For example, to reference cells A1 to B5 in a sheet named Categories, use:
{{Categories!A1:B5}}

Can I transfer my balance between GPT for Sheets and GPT for
Excel or Word?

Packs are not directly transferable between platforms, but you can request a balance transfer
between GPT for Sheets and GPT for Excel or Word. Here's what you need to know:

Packs purchased for Microsoft Excel can be used on Microsoft Word and vice versa.

Packs purchased for Google Sheets are separate and can only be used on Google Sheets.

If you need to transfer your balance between Google Sheets and Microsoft Excel or Word, contact
our support team.

Is there a limit to the number of requests I can send?

AI providers enforce rate limits in order to ensure a smooth and fair access to everyone. Learn
more.

How do I uninstall the GPT for Excel add-in?

The uninstallation process is described here.

Which models can I use?

Check our list of supported models.

https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models/connect-to-custom-gpts-from-sheets-and-excel
https://support.gptforwork.com/hc/en-us/requests/new
https://support.gptforwork.com/hc/en-us/requests/new
https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/gpt-for-excel/uninstall
https://gptforwork.com/help/ai-providers-and-models
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NOTE

If you're using GPT for Excel as part of a team space, your space admin can control which
models are available in the model switcher. Learn more.

Can I use local models with GPT for Excel?

Yes. GPT for Excel supports integration with Ollama and any LLM server that provides an OpenAI-
compatible API, allowing you to use locally running open-source models:

Connect to Ollama from Excel and Word

Connect to OpenAI-compatible local servers from Excel and Word

Which languages can I use?

Models work in many languages, but deliver the best results in English. All we can say is, try it. It is
usually better to prompt in the language you want the response to be in. In any case, avoid mixing
languages in a prompt.

How do I get support?

We recommend checking our troubleshooting and FAQ pages.

If that doesn't help, submit a support request and we'll get back to you.

Our support hours are from Monday to Friday:

7:30 PM - 12:00 PM (New York)

1:30 AM - 6:00 PM (Paris)

5:00 AM - 9:30 PM (India)

8:30 AM - 1:00 AM (Tokyo)

https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/gpt-for-excel/troubleshooting
https://gptforwork.com/help/gpt-for-excel/faq
https://support.gptforwork.com/hc/en-us/requests/new
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Remove Microsoft account access from GPT
for Excel

WARNING

Removing Microsoft account access from GPT for Excel means removing access from the GPT
for Excel Word add-in, which also removes access from GPT for Word.

NOTE

The following instructions only apply to personal accounts. If you have a school or work
account, contact your organization administrator about add-in access.

The GPT for Excel Word add-in no longer has access to your Microsoft account.

NOTE

Removing account access does not uninstall the add-in from Microsoft Excel. The next time
you open the add-in, Excel displays a welcome screen in the sidebar, after which you can sign
in with your Microsoft account and grant access again.

In your browser, log in to the Microsoft account you use in GPT for Excel.1

Open the privacy dashboard for your Microsoft account.2

In the Empower your productivity section, select App access.3

In the Manage your app access section, click Don't Allow for GPT for Excel Word.4

https://gptforwork.com/help/gpt-for-excel/uninstall
https://account.microsoft.com/privacy
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Uninstall GPT for Excel
PREREQUISITES

Remove all GPT formulas from all of your workbooks before uninstalling the add-in. Leaving
any GPT formulas in a workbook causes Excel to reinstall the add-in automatically when you
open the workbook.

CAUTION

Uninstalling GPT for Excel means removing the GPT for Excel Word add-in from both Excel
and Word.

The GPT for Excel Word add-in is removed from Excel and Word. If you ever need to use the add-in
again, follow the installation process.

In Excel, select Add-ins in the Home tab.

NOTE

If you're on a Mac, select Get Add-ins in the Insert tab.

1

Click More Add-ins.

The Office Add-ins pop-up opens.

2

Select the MY ADD-INS tab, hover over GPT for Excel Word, and click the Options menu icon.3

Select Remove.

A confirmation pop-up opens.

TIP

If the Remove option is not available in the menu, clear the Microsoft Office cache:

4

i. Close all Office applications.1

ii. Follow Microsoft's instructions for clearing the cache.2

iii. Open Excel and try removing the add-in again.3

Click Remove to confirm.5

https://gptforwork.com/help/gpt-for-excel/troubleshooting/installation#i-cant-uninstall-gpt-for-excel
https://gptforwork.com/help/install
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache
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NOTE

Removing the add-in does not remove its app access permissions from your Microsoft
account. You can remove access manually.

https://gptforwork.com/help/gpt-for-excel/remove-microsoft-account-access
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GPT for Word
GPT for Word turns generative AIs into your personal writing assistants available directly in
Microsoft Word.

To get started with GPT for Word, see Quickstart for documents.

Overview

GPT for Word is a Microsoft Word add-in that turns generative AIs into your personal writing assistants
available directly in the Word user interface. Like ChatGPT inside Word.

Author text

Use AI to plan, create, edit, and review your Word documents.

Manage text formatting

Manage how GPT for Word handles formatting in your documents.

Configuration

Save GPT for Word parameters along with your document.

Example prompts

Examples of using GPT for Word to translate, review, and summarize your Word documents.

Search the web

Learn how to use web search models to get up-to-date information from the web.

Troubleshooting

Troubleshoot common issues in GPT for Word.

https://gptforwork.com/help/quickstart-for-documents
https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/author-text
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
https://gptforwork.com/help/gpt-for-word/configuration
https://gptforwork.com/help/gpt-for-word/examples
https://gptforwork.com/help/gpt-for-word/search-web
https://gptforwork.com/help/gpt-for-word/troubleshooting
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FAQ

How can I ask questions about my document? ...and other questions.

Remove Microsoft account access

Remove Microsoft account access from the GPT for Excel Word add-in.

Uninstall

Remove the GPT for Word add-in from Microsoft Word.

https://gptforwork.com/help/gpt-for-word/faq
https://gptforwork.com/help/gpt-for-word/remove-microsoft-account-access
https://gptforwork.com/help/gpt-for-word/uninstall
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Overview of GPT for Word

Install GPT for Excel and Word

GPT for Word is a Microsoft Word add-in that turns generative AIs into your personal writing
assistants available directly in the Word user interface. Think of it as ChatGPT inside Word. Use
your favorite AI to edit, rewrite, correct, review, translate, summarize, draft, write, and more.

Use cases

Here are a few common use cases that you can easily handle with GPT for Word:

Rewrite or rephrase content in a different style, tone, or voice.

Check and correct the grammar and spelling in your document.

Generate a document template, or a document draft or outline that you can then flesh out.

Translate content to multiple target languages while observing appropriate localization
conventions.

https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-gpt-for-word-overview&src=website&mktcmpid=help-gpt-for-word-overview
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Summarize a document into a few bullet points.

Explain individual words, phrases, and paragraphs in your document.

Review your document for logical structure, clarity and consistency of content, and other
aspects that you want to validate.

Features

Prompt an AI as you would in ChatGPT or another AI chatbot.

Use a highlighted selection or the whole document as context for your prompts.

Preserve common formatting elements such as headings, lists, tables, and basic text styles
when inserting generated content.

Preview and refine content in a chat interface before inserting the content into your document.

Enable Word's Track changes mode to keep track of your AI edits.

The following video shows you how to translate selected text and replace the selection with the
translation while preserving formatting.

Benefits

Integrate AI into your content workflow. Prompt your favorite AI directly from inside your
documents. No more copy-pasting between Word and AI chatbots like ChatGPT.

Choose your preferred AI model. Use models from OpenAI, Anthropic, Google, xAI, Perplexity,
or OpenRouter. You can also use your own OpenAI Assistants and even connect to local models
with Ollama or any LLM server that provides an OpenAI-compatible API.

Bring an API key to get more features at reduced cost. You do not need an API key to use
GPT for Word, but using a key gives you access to more models, affords you more control and
privacy, and you pay a reduced service fee.

What's next

Install GPT for Word if you have not already.

Select an AI model that best meets your needs.

Author text with GPT for Word.

Learn how to use GPT for Word effectively through practical examples.

https://gptforwork.com/help/install
https://gptforwork.com/help/ai-models
https://gptforwork.com/help/gpt-for-word/author-text
https://gptforwork.com/help/gpt-for-word/examples
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Author text with GPT for Word
GPT for Word is an AI assistant that helps you plan, create, edit, and review content directly in
Microsoft Word documents, whether you're drafting from scratch, refining existing text, or
analyzing content.

How it works

To use GPT for Word:

Here are some common ways to use GPT for Word:

Translate content to other languages.

Fix grammar and spelling errors.

Summarize document content.

Prompt the AI

Configure the AI and send prompts to generate AI responses for your document.

Prompt the AI with your request.1

(Optional) Use the AI's response in your document.2

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

https://gptforwork.com/help/gpt-for-word/overview
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The AI generates responses based on your settings, selected context, and prompts.

Use AI responses in your document

Once you are satisfied with the AI-generated content, you can:

Insert the AI response at the cursor position or under the selected text.

Replace the selected text with the AI response.

Copy the AI response to clipboard.

INFO

You can also Replace, Insert, or Copy part of the AI response by selecting the text in the
response. When Plain text mode is disabled, you can only Copy part of the AI response.

TIP

To include AI-generated responses as suggestions in your documents with Microsoft Word,
you can activate Track Changes. Learn more

(Optional) Select an AI model.

INFO

To customize how the AI responds, you can set Custom instructions.

2

In the document, select the text you want to work with and, in the sidebar, select Use
selection as context. If no text is selected, GPT for Word uses the entire document as context.

3

Type your prompt in the chat. For example: Translate to French4

Click Send. GPT for Word generates a response.5

(Optional) Refine the AI-generated response and click Send. For example: Make it shorter6

https://support.microsoft.com/en-us/office/track-changes-in-word-197ba630-0f5f-4a8e-9a77-3712475e806a#:~:text=only%20your%20changes.-,Go%20to%20Review%20%3E%20Track%20Changes.,all%20users%2C%20select%20For%20Everyone.
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
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What's next

Choose between formatted or plain text responses.

Guide how the AI responds with custom instructions.

Choose the model that works best for you.

Select a model.

Explore practical use cases with examples.

https://gptforwork.com/help/gpt-for-word/manage-text-formatting
https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/ai-models/select-model#select-byok
https://gptforwork.com/help/gpt-for-word/examples
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Manage text formatting in GPT for Word
GPT for Word generates formatted AI responses in a sidebar. By default, the add-in analyzes and
extracts common formatting elements from your document, including headings, lists, tables, and
basic text styles, then applies similar formatting to the generated content. If you don't need
formatting, you can generate plain text responses.

INFO

The generating formatted text is slightly slower and uses about 20% more tokens than
generating plain, unformatted text.

Formatted text vs. plain text

Use formatted text mode (default) when:

You want the add-in to analyze your document's formatting and apply similar formatting to the
generated content. This is particularly useful for translations.

You want to preserve formatting elements when inserting or replacing text from the sidebar
into your document.

INFO

When using formatted text mode, GPT for Word cannot generate or preserve:

Font properties (family, size, color)

Text alignment and spacing

Background colors

Text decorative effects (shadows, glow, reflection)

Media and embedded objects (images, charts, icons)

Use plain text mode when:

You don't need to preserve formatting in responses. This is particularly useful when drafting or
summarizing content or analyzing text.

You want to increase speed and/or reduce token consumption.

Enable and disable plain text mode

To manage the text formatting mode in GPT for Word:

https://gptforwork.com/help/gpt-for-word/overview
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CAUTION

Changing the plain text mode setting clears your chat history.

What's next

To assign a specific role to the AI and more closely define how it responds, add custom
instructions.

See more GPT for Word examples.

Click GPT for Excel Word in the Home tab. If you don't see it, go to Home > Add-ins > My add-
ins > GPT for Excel Word.

1

Choose the mode that best suits your needs:2

Enable Plain text mode to process text without formatting.

Disable Plain text mode to preserve and work with formatting.

https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
https://gptforwork.com/help/gpt-for-word/examples
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Configuration of GPT for Word
Configure the GPT for Word settings for your document. Select a model, specify custom
instructions, adjust the creativity level, and reduce repetitions.

Select a model

Select the right AI model for your work, with or without an API key.

Add custom instructions

Assign a very precise role to the AI to define its field of expertise and how it responds.

Set the creativity level

Define how standard (or not) your output is expected to be.

Reduce AI response repetition

Configure settings to reduce repetitive language in AI responses.

https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
https://gptforwork.com/help/gpt-for-word/configuration/set-creativity-level
https://gptforwork.com/help/gpt-for-word/configuration/reduce-ai-response-repetition
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Add custom instructions in GPT for Word
Provide custom instructions in GPT for Word to specify preferences or requirements that you'd like
the AI to consider when you chat with your Word document.

Your custom instructions are now taken into account when you chat with your Word document.
They are active until you choose to Reset to default.

What's next

Select other settings to customize how the language model operates.

In the GPT for Word sidebar, click Settings.1

Select the type of instructions you'd like to add and edit them if needed.2

Click Save.3

https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/configuration
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Set the creativity level in GPT for Word
Control how creative the AI model is in GPT for Word by setting the temperature and top-p
parameters. These parameters work together to influence model output:

Parameter Description How to use

Temperature Controls randomness in the output
• Possible values: 0-1
• Keep at 1 if adjusting Top P
• Lower for factual, higher for creative

Top P Controls diversity of word choices
• Possible values: 0-1
• Keep at 1 for most use cases
• Only lower if Temperature is 1

You've set the creativity level. GPT for Word now uses the new temperature and top-p values for
generating all responses.

What's next

Configure other settings to customize how the language model operates.

In the GPT for Word sidebar, click the Settings icon.1

Use the slider to set Creativity between 0  and 1 .2

(Optional) Use the slider to set Top P between 0  and 1 .3

Click Save.4

https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/configuration
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Reduce AI response repetition in GPT for
Word
Set frequency and presence penalties in GPT for Word to reduce the tendency of OpenAI and xAI
models towards repetition.

Parameter Description How to use

Frequency
penalty

Controls how much to penalize new tokens based
on their frequency in the text so far

• Possible values: 0-2
• Keep at 0 by default
• Higher values
reduce repetition

Presence
penalty

Controls how much to penalize new tokens based
on whether they appear in the text so far

• Possible values: 0-2
• Keep at 0 by default
• Higher values
increase diversity

You've set the penalties. GPT for Word now uses the new Frequency penalty and Presence
penalty values for generating all responses.

What's next

Select other settings to customize how the language model operates.

In the GPT for Word sidebar, click the Settings icon.1

Use the slider to set Frequency penalty and Presence penalty between 0  and 2 .2

Click Save.3

https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/configuration
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Example prompts for GPT for Word
Learn how to use GPT for Word effectively through practical examples. Each example
demonstrates a common use case and includes step-by-step instructions.

Translate a document

You can follow along using either your own Word document or our translation example template.

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Choose the Copywriter pre-defined instruction.2

iii. Click Save.3

In the document, select the text you want to translate and, in the sidebar, select Use selection
as context.

4

Type your prompt:5

Translate to French

Make sure plain text mode is disabled.6

Click Send. GPT for Word generates a response.7

https://drive.google.com/file/d/1FteTvMDYNj8tJdUu_v_Mj2rYI9s5sYQh/view
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
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GPT for Word has replaced the original text with the AI-generated translation, while preserving all
formatting.

Correct grammar or spelling errors of a document

You can follow along using either your own Word document or our grammar correction template.

Refine the AI-generated response:8

i. Type the prompt:1

Make it shorter

ii. Click Send. GPT for Word generates a new response.2

To replace the selected text with the response, click Replace.9

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Select Write custom instructions.2

iii. Replace the existing instructions with:3

Act as a professional editor focusing on grammar, spelling, and 
clarity

iv. Click Save.4

https://drive.google.com/file/d/1YfwQfJyymx7wsMwM16KLQfrMb5cdN2Gs/view
https://gptforwork.com/help/ai-models/select-model?app=word
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GPT for Word has replaced the original text with the AI-generated corrected response.

TIP

To review the AI's corrections, enable Track Changes in Word. Go to Review > Track Changes
or press Ctrl/Cmd+Shift+E.

Summarize a document into a table

You can follow along using either your own Word document or our summarization example
template.

In the document, select the text you want to improve and, in the sidebar, select Use selection
as context.

4

Type your prompt:5

Correct grammar or spelling errors

Make sure plain text mode is disabled.6

Click Send. GPT for Word generates a response.7

To replace the selected text with the response, click Replace.8

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

https://drive.google.com/file/d/1hKwb95kfhpIzKvgXYoCO2JTQKs5W6_62/view
https://drive.google.com/file/d/1hKwb95kfhpIzKvgXYoCO2JTQKs5W6_62/view
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
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GPT for Word has inserted the AI-generated table into the Word document.

Summarize a document into one paragraph

You can follow along using either your own Word document or our summarization example
template.

Select the model of your choice.2

In the document, select the text you want to summarize into a table and, in the sidebar, select
Use selection as context.

3

Type your prompt:4

Summarize this document into a table

Make sure plain text mode is disabled.5

Click Send. GPT for Word generates a response.6

To add the table at the cursor position or under the selected text, click Insert.7

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

Select the model of your choice.2

https://drive.google.com/file/d/1hKwb95kfhpIzKvgXYoCO2JTQKs5W6_62/view
https://drive.google.com/file/d/1hKwb95kfhpIzKvgXYoCO2JTQKs5W6_62/view
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
https://gptforwork.com/help/ai-models/select-model?app=word
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GPT for Word has generated a one-paragraph summary of the document. You can now Copy or
Insert the summary.

Create a job description draft

You can follow along using your own Word document.

Select Use full document as context.3

Type your prompt:4

Create a concise summary of this document

Make sure plain text mode is enabled.5

Click Send. GPT for Word generates a response.6

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Choose the HR Consultant pre-defined instruction.2

iii. Click Save.3

(Optional) Deselect Use selection or document for context. Since you're starting from a
blank document, there's nothing to use as context.

4

https://gptforwork.com/help/gpt-for-word/manage-text-formatting
https://gptforwork.com/help/ai-models/select-model?app=word
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GPT for Word has inserted the AI-generated job description into the Word document.

Analyze a text selection

You can follow along using either your own Word document or our product review template.

Type your prompt:5

Write a job description for a Senior Software Engineer position, including 
qualifications, responsibilities, and benefits

Make sure plain text mode is disabled.6

Click Send. GPT for Word generates a response.7

Refine the AI-generated response:8

i. Type the prompt:1

Add more emphasis on collaboration skills and remote work experience

ii. Click Send. GPT for Word updates the content.2

To add the job description at the cursor position, click Insert.9

In the Home tab, click GPT for Excel Word.

INFO

You can also select Home > Add-ins > My Add-ins > GPT for Excel Word.

1

https://drive.google.com/file/d/1Y8puDUJ2EF76mFWDTiMxd5PXBCNeBfk1/view
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
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GPT for Word has generated an analysis of the selected text. You can now Copy or Insert the
analysis.

Select the model of your choice.2

In the document, select the text you want to analyze and, in the sidebar, select Use selection
as context.

3

Type your prompt:4

What are the pros and cons mentioned here?

Make sure plain text mode is enabled.5

Click Send. GPT for Word generates a response.6

https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
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Search the web with GPT for Word
Search the web directly in GPT for Word using web search models. These models use fresh web
search data, which allows you to generate up-to-date responses about companies, current events,
facts, and more, directly in your document. You can also fetch content from specific URLs to extract
information from web pages.

Choose the right web search model

Choose a web search model that best fits your use case.

Web search

Get information that is not in the model's built-in knowledge:

Example: Writing a report about the latest AI trends in your business.

How it works:

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific focus.

Web search models do not fetch full page content. Instead, they read search result snippets, like
you would see on a Google search results page. The snippets are added to the context of the
models, so they can use the information to generate a response.

Recommended models:

Sonar for quick results (cheapest).

Sonar Pro or Sonar Reasoning for high quality results.

Gemini models with Web search for Google search quality (most expensive).

Content fetching

Focus on specific URLs and extract content from them:

Example: Extracting key requirements from a job posting URL and writing a tailored cover letter.

How it works: Some web search models can access the full content from specific URLs. The full
content is added to the context of the models, so they can use it to answer questions about the
content or extract information from it.

Recommended models:

Gemini 2.5 models with URL context

https://gptforwork.com/help/gpt-for-word/overview
https://gptforwork.com/help/gpt-for-word/search-web?model=perplexity-sonar#model-specific-settings
https://gptforwork.com/help/gpt-for-word/search-web?model=perplexity-sonar#model-specific-settings
https://gptforwork.com/help/gpt-for-word/search-web?model=google-gemini#model-specific-settings
https://gptforwork.com/help/gpt-for-word/search-web?model=google-gemini#model-specific-settings
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Provider Model
Without API

key
With API key

Perplexity

sonar ✅ ✅

sonar-pro ✅ ✅

sonar-reasoning ✅ ✅

sonar-reasoning-pro ❌ ✅

Google

gemini-2.0-flash ❌ ✅

gemini-2.0-flash-lite ❌ ✅

gemini-2.5-flash ✅ ✅

gemini-2.5-flash-lite ❌ ✅

gemini-2.5-pro ❌ ✅

For detailed pricing, see AI providers and models.

Use web search models

Click here for a list of all web search models supported by GPT for Word.

Open GPT for Word.1

Expand the model switcher and select a web search model (indicated by the 🌐 icon).2

(Optional) Click the settings icon and configure the model-specific settings in the sidebar. For
Gemini models, make sure web search is enabled.

3

Type your search prompt in the chat. For example:4

What are the latest trends in AI technology?

Click Send. The model generates a response using up-to-date web search data.5

Once you're satisfied with the response, you can:6

Insert the response at your cursor position

https://gptforwork.com/help/ai-providers-and-models#web-search-models
https://gptforwork.com/help/open?app=word
https://gptforwork.com/help/gpt-for-word/search-web?model=google-gemini#model-specific-settings
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Model-specific settings

Use the model-specific settings to configure the web search model for your use case.

Google Gemini

Setting Description Example

Web search

Let Gemini decide when a Google search can
improve the answer. This allows Gemini to provide
more accurate answers and cite verifiable sources
beyond its built-in knowledge. Enabling Web
search incurs an additional search cost.

URL context

(Gemini 2.5 only)

Provide up to 20 URLs (pages, images, PDFs) to
focus your search. No search cost is incurred, but
the content retrieved from URLs counts as input
tokens.

Perplexity Sonar

Setting Description Example

Search context
size

Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

What's next

Choose between formatted or plain text responses.

Guide how the AI responds with custom instructions.

Explore practical use cases with examples.

Replace the selected text with the response

Copy the response to your clipboard

https://gptforwork.com/help/ai-providers-and-models#web-search-models
https://gptforwork.com/help/ai-providers-and-models#web-search-models
https://gptforwork.com/help/gpt-for-word/manage-text-formatting
https://gptforwork.com/help/gpt-for-word/configuration/add-custom-instructions
https://gptforwork.com/help/gpt-for-word/examples
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Troubleshooting GPT for Word
Find solutions and advice for troubleshooting various scenarios, from API key and empty balance
issues to cut responses and rate limits.

Billing issues

Troubleshoot balance and pack issues.

Installation issues

Troubleshoot installation issues and Microsoft account sign-in issues.

Output issues

Troubleshoot responses cut or incomplete and responses that don't make sense.

API key issues

Troubleshoot API key setup issues and OpenAI free trial limitations.

Rate limit issues

Troubleshoot token and request rate limit issues.

Add-in not working

Troubleshoot multiple accounts errors, blank sidebars, and menu visibility problems.

If none of the listed solutions addresses your issue, reach out to our support team for further
assistance.

CONTACT SUPPORT

https://gptforwork.com/help/gpt-for-word/troubleshooting/billing
https://gptforwork.com/help/gpt-for-word/troubleshooting/installation
https://gptforwork.com/help/gpt-for-word/troubleshooting/output
https://gptforwork.com/help/gpt-for-word/troubleshooting/api-keys
https://gptforwork.com/help/gpt-for-word/troubleshooting/rate-limits
https://gptforwork.com/help/gpt-for-word/troubleshooting/add-in-not-working
https://support.gptforwork.com/hc/en-us/requests/new
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Billing issues (GPT for Word)

I have a ChatGPT Plus / Pro / Teams / Enterprise subscription, but
my balance is empty

Problem: You have a ChatGPT Plus / Pro / Teams / Enterprise subscription, but GPT for Word still
says that your balance is empty.

SOLUTION

OpenAI's ChatGPT Plus / Pro / Teams / Enterprise subscription is neither necessary nor
sufficient for using the GPT for Work add-ons.

Buy a pack to add money to your balance in GPT for Word.

I bought a pack but my balance is empty

Problem: You have bought a pack but your balance in GPT for Word is still empty.

SOLUTION

Click on your balance in GPT for Word and check that you are using the Microsoft account with
which you have purchased your pack. Switch to another account if needed.

My packs have disappeared from the tracking screen

Problem: You have bought packs and used GPT for Word but now all your packs have disappeared
from the usage tracking screen.

SOLUTION

Click on your balance in GPT for Word and check that you are using the Microsoft account with
which you have bought your packs. Switch to another account if needed.

https://help.openai.com/en/articles/6950777-what-is-chatgpt-plus
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/buy-pack?platform=microsoft
https://gptforwork.com/help/sign-in/switch-to-another-account
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/track-purchases-and-consumption
https://gptforwork.com/help/sign-in/switch-to-another-account
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Installation issues (GPT for Word)

I can't sign in after installing

Problem: You have installed GPT for Word and you have trouble signing in with Microsoft.

SOLUTIONS

Check which versions of Word and which browsers are supported by this add-in.

Try using the web version of Word instead of the desktop version.

Try using Word in a private/incognito window.

I signed in with the wrong Microsoft account

Problem: You signed in with the wrong Microsoft account while installing GPT for Word and need
to switch to the correct one.

SOLUTION

Open the sidebar menu and click Log out to sign out, then sign in again with the correct
account. Learn more.

I want to uninstall

Problem: You are not using the add-in in Word or Excel, and you want to uninstall it.

SOLUTION

To remove the add-in from Word and Excel, follow our uninstallation guide.

I can't uninstall GPT for Word

Problem: You want to uninstall the add-in, but the Remove option is not available in the add-in
Options menu in the Office Add-ins popup.

https://gptforwork.com/help/gpt-for-word/faq#which-versions-of-word-are-compatible-with-this-add-in
https://gptforwork.com/help/gpt-for-word/faq#which-versions-of-word-are-compatible-with-this-add-in
https://gptforwork.com/help/gpt-for-word/faq#which-browsers-are-compatible-with-gpt-for-word
https://gptforwork.com/help/sign-in/sign-out-from-gpt-for-excel-and-word
https://gptforwork.com/help/gpt-for-word/uninstall
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SOLUTION

Clear the Microsoft Office cache:

Close all Office applications.1

Follow Microsoft's instructions for clearing the cache.2

Open Word and try removing the add-in again.3

https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache
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Output issues (GPT for Word)

Response is cut or incomplete

Problem: The response you get from GPT for Word seems truncated.

SOLUTION

Models have a maximum token limit, which is the maximum total number of tokens that can
be used in both the input and the response. This means models may not provide complete
responses to long queries or when a large portion of text is selected as input.

To stay within the token limit, you can:

In the sidebar, click Clear chat to delete your chat history.

Break up your work into smaller parts.

Select a model with a higher limit.

Responses don't make sense

Problem: The responses you get from GPT for Word don't match your requests.

SOLUTION

Click on Clear chat to delete your chat history. This deletes previous chat messages that
might interfere with your current request.
Refine your prompt and/or select a different model. See our examples for guidance.

https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/gpt-for-word/examples
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API key issues (GPT for Word)

Your API key is invalid or revoked

Problem: You are trying to set an API key but GPT for Word won't save it.

SOLUTIONS

Make sure that you copied it correctly, or create a new one and try again.

Solution for immediate use: If immediate use is needed and using your API key is not a
priority, select a model without an API key.

I've entered my API key and it's not working

Problem: You have entered an API key in the GPT for Word sidebar but you cannot use it.

SOLUTION

Even though you have entered an API key, you also need to purchase a pack in GPT for Word.
Learn more.

I can't enter my API key

Problem: You can't enter an API key in the GPT for Word sidebar because you don't have
permission to do so.

SOLUTIONS

Request your space administrator to allow users to set their own API keys. Check the GPT for
Work dashboard to see who the administrator or owner of your team is.

https://gptforwork.com/help/ai-models/set-and-manage-api-keys?app=word
https://gptforwork.com/help/ai-models/select-model?app=word
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/faq
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space#control-whether-users-can-set-api-keys
https://dashboard.gptforwork.com/
https://dashboard.gptforwork.com/
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Rate limit issues (GPT for Word)

Token limit is reached

Problem: You are facing a rate limit error message from your AI provider that indicates you've
reached your tokens per minute limit.

SOLUTIONS

Temporary: Choose a different model, or wait until your token limit resets.

Permanent: Use models that don't require an API key or use your own OpenAI API key if
you belong to a Tier 5 organization.

Request limit is reached

Problem: You are facing a rate limit error message from your AI provider that indicates you've
reached your requests per minute limit.

SOLUTIONS

Temporary: Choose a different model, or wait until your request limit resets: one minute or
24 hours.
Permanent: Use models that don't require an API key or use your own OpenAI API key if
you belong to a Tier 5 organization.

https://gptforwork.com/help/ai-providers-and-models#tk
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set
https://gptforwork.com/help/ai-providers-and-models#tk
https://gptforwork.com/help/ai-models/set-and-manage-api-keys#set


GPT for Work Help (Microsoft) 2025-10-22

346 / 366

Add-in not working (GPT for Word)

Sidebar is blank, or fails to load

Error loading Add-Ins

Problem: GPT for Word sidebar fails to load, or remains blank.

SOLUTIONS

In the desktop version of Word, open the menu to the right of the sidebar (Windows) or
click the info icon (macOS), then click Reload.

Restart Word, create a new document, and launch the add-in again by clicking GPT for
Excel Word in the Home tab.

Refresh the add-ins in the Office Add-ins pop-up:

Uninstall and reinstall the add-in.

Clear the Office cache, and then uninstall and reinstall the add-in again:

If the issue persists, contact support.

i. In Word, select Add-ins in the Home tab.1

ii. Click More Add-ins.2

iii. In the Office Add-ins pop-up, click Refresh.3

i. Clear the Office cache:1

For Windows: Follow the Microsoft instructions to clear the Office cache on
Windows.

For Mac: Follow the Microsoft instructions to clear the Office cache on Mac.

ii. Uninstall the add-in.2

iii. Reinstall the add-in.3

https://gptforwork.com/help/gpt-for-word/uninstall
https://gptforwork.com/help/install?platform=microsoft
https://support.gptforwork.com/hc/en-us/requests/new
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-windows
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-windows
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-office-cache-on-mac
https://gptforwork.com/help/gpt-for-word/uninstall
https://gptforwork.com/help/install?platform=microsoft
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FAQ (GPT for Word)

How do I install the GPT for Word add-in?

Install from Microsoft AppSource:

Learn more.

Which versions of Word are compatible with this add-in?

The following table lists the minimum versions of Microsoft Word compatible with the GPT for
Word add-in on different Microsoft Office platforms.

Windows Mac Online

Microsoft 365 subscription:

Version 2205 (Build 15202.10000)

Retail perpetual:

Version 2205 (Build 15202.10000)

Volume-licensed perpetual:

Word 2024: Version 2205 (Build
15202.10000)

Version 16.61 (Build
22040100)

Supported on:

Google Chrome (latest
version)

Microsoft Edge (latest
version)

Which version of Word am I using?

To check your desktop Word version, see What version of Office am I using? at Microsoft Support.

If you're using Word Online, your version is always the latest.

Which browsers are compatible with GPT for Word?

GPT for Word is compatible with the following browsers:

Go to the installation page.1

Click Open in Word.2

Follow the steps until the end.3

https://gptforwork.com/help/install?platform=microsoft
https://support.microsoft.com/en-us/topic/what-version-of-office-am-i-using-d21c5935-40b1-b117-122d-5e5f05a1a263
https://pages.store.office.com/addinsinstallpage.aspx?assetid=WA200005502&utm_medium=website&utm_source=help-gpt-for-word-faq&src=website&mktcmpid=help-gpt-for-word-faq
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Google Chrome (recommended for the best experience)

Microsoft Edge (only for Windows users, recommended for the best experience)

Mozilla Firefox

Safari (only for Mac users)

What permissions are required by the GPT for Word add-in?

See Security and privacy FAQ.

I have installed GPT for Word, how do I get started?

Now that GPT for Word is installed, you can launch it from the Microsoft Word Home tab and start
chatting with your Word documents. Learn more in our quickstart guide.

What is the pricing of GPT for Word?

Our pricing options include a consumption-based plan, which is proportional to your usage, and a
subscription-based plan, which has a fixed monthly fee.

How can I add users?

You can add users from the dashboard.

How is my data processed? Is it used to train models?

We do not read or store any data from your document that you do not use as an input.

If you use a model with an API key, we do not log or store any of the inputs submitted or
outputs received.

Whether you use a model with or without an API key, Talarian does not use your inputs and
outputs to train language models.

For more information, see the Security and privacy FAQ.

Do I need my own API key?

Yes, if you are on a subscription plan.

No, if you use prepaid packs, many models are available without any API key.

https://gptforwork.com/help/security-privacy-faq#microsoft-permissions-for-gpt-for-excel-word
https://gptforwork.com/help/quickstart-for-documents
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://dashboard.gptforwork.com/
https://gptforwork.com/help/security-privacy-faq
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/ai-providers-and-models#tk
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NOTE

If you're using GPT for Word as part of a team space, your space admin can control which
models are available in the model switcher, regardless of your subscription or API key setup.
Learn more.

Can I use my own API key?

Yes.

Using API keys offers several benefits:

More models. Access a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage your AI usage and costs directly on the AI provider's
platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key.
For more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

INFO

Using API keys is mandatory if you're on a subscription plan.

INFO

If you are a user in a space that does not allow users to set their own API keys, you will still
benefit from any space API keys set by the space owner or admins.

Is gpt-4o supported?

Yes, gpt-4o and gpt-4o-mini are supported with and without an API key.

Is GPT for Word connected to the web?

Yes, GPT for Word can access up-to-date information using models with web search capabilities
(indicated by the 🌐 icon in the model switcher).

https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
https://gptforwork.com/help/ai-providers-and-models#byok
https://gptforwork.com/help/security-privacy-faq#how-is-my-data-processed
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/pricing-and-billing/pricing-options
https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/concepts#api-key
https://gptforwork.com/help/ai-providers-and-models
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Can I scrape webpages in Word?

Yes. You can scrape specific webpages using GPT for Word and Google Gemini 2.5 models with
URL context.

How can I ask questions about my document?

Select some text or the whole document to include the selection as context for your prompt in the
chat.

Can GPT for Word analyze PDF files?

Yes. You can analyze PDF files using GPT for Word and Google Gemini 2.5 models with URL context.

Why is my response cut or incomplete?

Models have a maximum token limit, which is the maximum total number of tokens that can be
used in both the input and the response. This means models may not provide complete responses
to long queries or when a large portion of text is selected as input.

To stay within the token limit, you can:

In the sidebar, click Clear chat to delete your chat history.

Break up your work into smaller parts.

Select a model with a higher limit.

Can I use my OpenAI Assistants and custom GPTs?

No. GPT for Word does not currently support OpenAI Assistants or custom GPTs.

TIP

You can use OpenAI Assistants and custom GPTs in GPT for Excel and GPT for Sheets:

Set your OpenAI API key and your Assistants will become available in the model switcher.

You can replicate your custom GPTs as Assistants to make them available in the model
switcher.

https://gptforwork.com/help/gpt-for-word/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/gpt-for-word/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/gpt-for-word/search-web#choose-the-right-web-search-model
https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/ai-models/set-and-manage-api-keys
https://gptforwork.com/help/ai-models/connect-to-custom-gpts-from-sheets-and-excel
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Can I use OpenRouter?

Yes, you can use the OpenRouter service in GPT for Work with an API key. With OpenRouter, you
can access AI models from multiple providers through a single API key.

For API key setup instructions, check out Connect OpenRouter.

Can I transfer my balance between GPT for Sheets and GPT for
Excel or Word?

Packs are not directly transferable between platforms, but you can request a balance transfer
between GPT for Sheets and GPT for Excel or Word. Here's what you need to know:

Packs purchased for Microsoft Excel can be used on Microsoft Word and vice versa.

Packs purchased for Google Sheets are separate and can only be used on Google Sheets.

If you need to transfer your balance between Google Sheets and Microsoft Excel or Word, contact
our support team.

Is there a limit to the number of requests I can send?

AI providers enforce rate limits in order to ensure a smooth and fair access to everyone. Learn
more.

How do I uninstall the GPT for Word add-in?

The uninstallation process is described here.

Which models can I use?

Check our list of supported models.

NOTE

If you're using GPT for Word as part of a team space, your space admin can control which
models are available in the model switcher. Learn more.

Can I use local models with GPT for Word?

Yes. GPT for Word supports integration with Ollama and any LLM server that provides an OpenAI-
compatible API, allowing you to use locally running open-source models:

https://openrouter.ai/
https://gptforwork.com/help/ai-models/connect-to-openrouter-from-excel-sheets-and-word
https://support.gptforwork.com/hc/en-us/requests/new
https://support.gptforwork.com/hc/en-us/requests/new
https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/rate-limits
https://gptforwork.com/help/gpt-for-word/uninstall
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/manage-available-models/manage-models-for-your-space
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Connect to Ollama from Excel and Word

Connect to OpenAI-compatible local servers from Excel and Word

Which languages can I use?

Models work in many languages, but deliver the best results in English. All we can say is, try it. It is
usually better to prompt in the language you want the response to be in. In any case, avoid mixing
languages in a prompt.

How do I get support?

We recommend checking our troubleshooting and FAQ pages.

If that doesn't help, submit a support request and we'll get back to you.

Our support hours are from Monday to Friday:

7:30 PM - 12:00 PM (New York)

1:30 AM - 6:00 PM (Paris)

5:00 AM - 9:30 PM (India)

8:30 AM - 1:00 AM (Tokyo)

https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/gpt-for-word/troubleshooting
https://gptforwork.com/help/gpt-for-word/faq
https://support.gptforwork.com/hc/en-us/requests/new
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Remove Microsoft account access from GPT
for Word

WARNING

Removing Microsoft account access from GPT for Word means removing access from the GPT
for Excel Word add-in, which also removes access from GPT for Excel.

NOTE

The following instructions only apply to personal accounts. If you have a school or work
account, contact your organization administrator about add-in access.

The GPT for Excel Word add-in no longer has access to your Microsoft account.

NOTE

Removing account access does not uninstall the add-in from Microsoft Word. The next time
you open the add-in, Word displays a welcome screen in the sidebar, after which you can sign
in with your Microsoft account and grant access again.

In your browser, log in to the Microsoft account you use in GPT for Word.1

Open the privacy dashboard for your Microsoft account.2

In the Empower your productivity section, select App access.3

In the Manage your app access section, click Don't Allow for GPT for Excel Word.4

https://gptforwork.com/help/gpt-for-word/uninstall
https://account.microsoft.com/privacy
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Uninstall GPT for Word
CAUTION

Uninstalling GPT for Word means removing the GPT for Excel Word add-in from both Word
and Excel.

The GPT for Excel Word add-in is removed from Word and Excel. If you ever need to use the add-in
again, follow the installation process.

NOTE

Removing the add-in does not remove its app access permissions from your Microsoft
account. You can remove access manually.

In Word, select Add-ins in the Home tab.

NOTE

If you're on a Mac, select Get Add-ins in the Insert tab.

1

Click More Add-ins.

The Office Add-ins pop-up opens.

2

Select the MY ADD-INS tab, hover over GPT for Excel Word, and click the Options menu icon.3

Select Remove.

A confirmation pop-up opens.

TIP

If the Remove option is not available in the menu, clear the Microsoft Office cache:

4

i. Close all Office applications.1

ii. Follow Microsoft's instructions for clearing the cache.2

iii. Open Word and try removing the add-in again.3

Click Remove to confirm.5

https://gptforwork.com/help/install
https://gptforwork.com/help/gpt-for-word/remove-microsoft-account-access
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache
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Concepts
Key concepts related to GPT for Work add-ons and the use of ChatGPT and other AIs directly from
MS Excel, and Word, Google Sheets and Docs.

AI concepts

AI provider

Company or platform that provides models to GPT for Work add-ons. GPT for Work
integrates with multiple AI providers, including OpenAI, Anthropic, and Google. See the
complete list of supported models.

API key

Unique identifier that grants access to models served by AI providers. Using an API key gives
you access to more models, and affords you more control and privacy. Using an API key can
also lower costs if you're on usage-based pricing.

API keys in GPT for Work can be set at two different levels:

For a specific user: When you set API keys for your own use, they work only for you. Only
you have access to models associated with the keys, and only you can set and manage the
keys.

For all space users: When you set API keys for your space, they work for all users in the
space. Space users automatically have access to models associated with the keys, but only
the space owner and admins can set and manage the keys. Billing for a space key reflects
its usage by all space users. Learn more.

If keys are set at both levels for the same AI provider, the specific user key overrides the
space key.

Custom instructions

Specific guidelines provided to the model to define its role, expertise, or how it should
respond to prompts. Custom instructions are set in the sidebar of the GPT for Work add-ons,
and remain active in the document or spreadsheet until you change them.

Formula (spreadsheet)

A spreadsheet formula is an expression you enter into a spreadsheet cell to calculate a value,
process text, retrieve data, or perform some other task that returns a result. Formulas can
contain functions, cell references, operators, as well as numbers, text, and other values. A

https://gptforwork.com/help/
https://gptforwork.com/help/ai-providers-and-models
https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/concepts#space
https://gptforwork.com/help/manage-available-models/manage-api-keys-for-your-space
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formula always starts with the equal sign = , which tells the spreadsheet to evaluate the
expression instead of treating the entry as plain text.

The following simple formula consists of single function, SUM , which adds values:

The following more complex formula, which consists of two functions, one nested inside the
other, runs the inner GPT  function only if the cell A1  is not blank, which is determined by
the outer IF  function. If A1  is not blank, the formula returns the result from the GPT
function; if A1  is blank, the formula returns an empty value.

Function (spreadsheet)

A spreadsheet function is a predefined formula that performs a specific task in a
spreadsheet, such as calculating values, processing text, or retrieving data. Functions always
return a result. Functions typically take one or more parameters as input, which tell them
how exactly to perform their task and generate their result. For example, the SUM  function
adds values:

Functions can be divided into native functions, which are built into the spreadsheet software,
such as SUM  in Excel and Sheets, and custom functions, which come from user scripts or
third-party software, such the GPT  function in GPT for Excel and GPT for Sheets.

You can use a function on its own (a simple formula) or combine it with other functions to
create more complex formulas, optionally with nesting and conditional logic.

Model

Large language model (LLM) used in a GPT for Work add-on. You select the model in the add-
on sidebar. The available models depend on the add-on and whether you are using an API
key or have access to cloud-hosted models or local models through API endpoints. See the
complete list of supported models.

Cloud-hosted model

Model served over the internet by a cloud-based LLM platform. This is in contrast to models
served by an LLM server running on a local machine. Compared to local models, cloud-

=SUM(A1:A5)

=IF(A1="", "", GPT("Write a tagline for", A1))

=SUM(A1:A5)

https://en.wikipedia.org/wiki/Large_language_model
https://gptforwork.com/help/ai-providers-and-models
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hosted models generally run on more powerful hardware, but require online access and
involve sending data over the internet to an external service. For using cloud-hosted models,
GPT for Work supports multiple AI providers, both model creators, such as OpenAI,
Anthropic, and Google, and model hosts, such as Anyscale, Fireworks AI, Together AI, or any
platform with an OpenAI-compatible API endpoint.

Local model

Model served by an LLM server running on a local machine, such as your own computer or
another computer on a local network. This is in contrast to models served over the internet
by cloud-based LLM platform. Compared to cloud-hosted models, local models offer
enhanced data privacy and offline access. For using local models, GPT for Work supports
Ollama and any LLM server with an OpenAI-compatible API.

Web search models

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific
focus.

Web search models do not fetch full page content. Instead, they read search result snippets,
like you would see on a Google search results page. The snippets are added to the context of
the models, so they can use the information to generate a response.

Content fetching models

Some web search models can access the full content from specific URLs. The full content is
added to the context of the models, so they can use it to answer questions about the content
or extract information from it.

Prompt

Input text given to the model to generate a response or perform a task. Prompts can be
included in the sidebar of the GPT for Work add-ons, or passed as arguments in GPT
functions. For guidance, see How to write a good prompt.

Rate limits

Restrictions on the number of tokens or on the number of requests that can be processed
within a certain time frame (minute, day, month). AI providers set rate limits on their models.
Google also enforces rate limits on the daily number of requests. Learn more.

https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-ollama-from-excel-and-word
https://gptforwork.com/help/ai-models/connect-to-openai-compatible-api-endpoints-from-excel-and-word
https://gptforwork.com/help/how-to-write-good-prompt
https://gptforwork.com/help/rate-limits
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Tokens

Small pieces of text that can represent a word or subword, a punctuation sign or a symbol.
Models split all input and output into tokens for efficient processing. The token is the basic
unit of usage of model providers. The number of tokens used in the prompt (input) and the
AI's response (output) impacts your balance if you're on usage-based pricing.

GPT for Work concepts

Bulk AI tools

Bulk AI tools allow you to run prompts on an entire spreadsheet column at once without
writing any formulas. You configure and run bulk tools from the add-on sidebar.

GPT for Work provides dedicated bulk tools for selected use cases, such as classification,
generation, and translation, as well as a generic bulk tool for custom prompts.

For more information, see Bulk AI tools in GPT for Excel and Bulk AI tools in GPT for Sheets.

https://gptforwork.com/help/pricing-and-billing/prepaid-usage-based/how-prepaid-packs-work
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools
https://gptforwork.com/help/gpt-for-sheets/bulk-ai-tools
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Formula assistant

The formula assistant allows you to generate spreadsheet formulas based on plain-
language descriptions of what you want to achieve. You can also use the formula assistant to
explain existing formulas (in English).

The formula assistant is available in the add-on sidebar, both under Bulk AI tools and GPT
functions.

GPT functions

GPT functions are custom spreadsheet functions that allow you to prompt AI from inside
spreadsheet cells. GPT functions work exactly like native functions in that you can use them
on their own or combine them with other functions when creating formulas.

GPT for Work provides dedicated GPT functions for selected use cases, such as classification,
summarization, translation, and web search, as well as a generic GPT function for all other
use cases. You can define function-specific parameters to further refine how the AI generates
responses. You can find a list of all available functions with usage examples in the add-on
sidebar.

https://gptforwork.com/help/quickstart-for-spreadsheets#use-the-formula-assistant
https://gptforwork.com/help/concepts#function-spreadsheet
https://gptforwork.com/help/concepts#formula-spreadsheet
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For more information, see GPT functions in GPT for Excel and GPT functions in GPT for
Sheets.

Sidebar

Panel in GPT for Work add-ons where users can interact with the AI, input prompts, and
adjust settings. When you launch the GPT for Work add-ons, the sidebar opens on the right
side of the screen.

MS Excel

https://gptforwork.com/help/gpt-for-excel/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-sheets/gpt-functions/all-gpt-functions
https://gptforwork.com/help/gpt-for-sheets/gpt-functions/all-gpt-functions
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MS Word

Space

A space is the administrative hub for GPT for Work. Available through the GPT for Work
dashboard, it centralizes purchases, billing, usage controls, and API keys for an individual or
a team.

If you sign in to both GPT for Sheets and Docs (Google) and GPT for Excel and Word
(Microsoft), you will have two separate spaces.These spaces are independent:
balances/subscriptions, users, and API keys do not carry over between platforms.

You can be active in only one space at a time. If you join another user's space, you lose
access to your own space balance/subscription and space API keys.

In the screenshot below, you can see the overview of a GPT for Sheets and Docs space with
three space users. If you are on a subscription plan, your dashboard will show subscription
details instead of a balance.

https://dashboard.gptforwork.com/
https://dashboard.gptforwork.com/
https://gptforwork.com/help/create-team
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft#google
https://gptforwork.com/help/sign-in/sign-in-with-google-or-microsoft#microsoft
https://gptforwork.com/help/pricing-and-billing/pricing-options
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How to write a good prompt
Write a good prompt to get the best results from our extensions. Be very specific about what you
want and prompt exactly like you would brief a person to do the job, by providing clear
instructions and ample context.

While models can sometimes process multi-lingual prompts or generate a response in a different
language from the prompt language, it is highly recommended to write your prompt in the
language that you expect your response to be in.

You can also check out our OpenAI GPT prompt generator.

Label Description Examples

Task

What you want to achieve

Note: This should be
composed of at least a verb
and a noun. You can replace
"Task" by "Question" if it
makes more sense.

Task: write a cold email

Task: write a blogpost

Task: write 5 taglines

Task: summarize in 3 paragraphs

Task: translate from English to 
Spanish

Task: create a tweet thread of 10 
tweets

Question: How can I find an SEO 
expert?

Topic

What your text is about

Note: Don't hesitate to be
highly specific.

Topic: sell a shampoo

Topic: an ice-cream shop

Topic: food in Ancient Rome

https://gptforwork.com/tools/prompt-generator
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Label Description Examples

Role
What character the AI has to
impersonate

Role: Act as a teacher. Write in very 
basic terms, and illustrate with 
examples adapted to your audience. Then 
provide links to explore the topic 
further.

Role: Act as a tech reviewer. You write 
in-depth reviews including pros, cons, 
features, and benchmarks.

Role: Act as a technical writer. Your 
writing is very structured and 
hierarchical. Instructions are provided 
step by step so the reader can apply 
them without thinking.

Style
What type of language you
want to use

Style: casual

Style: formal

Style: business

Style: creative

Style: academic

Tone
How you want your text to
sound

Tone: joyful

Tone: angry

Tone: funny

Tone: serious

Tone: excited

Tone: sad
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Label Description Examples

Audience

Who this text is for

Note: This enables the model
to select appropriate words
and the right level of
abstraction.

Audience: 5-year old

Audience: teenager who likes rock 
music

Audience: my boss

Audience: topic expert

Length

How long the output is
expected to be (any unit)

Note: Language models have
limited numerical accuracy, so
it's good to be overly precise if
you have a hard limit.

Length: 4 paragraphs

Length: 250 words

Length: strictly under 30 characters 
including spaces

Format
What structure or syntax your
output must comply with

Format: HTML

Format: table

Format: markdown

Any other parameter or
instruction that is useful to
you

Country: X

Product: door bell

Relate recipient job title to the user 
selling proposition

Sign as XYZ

Start with xxx

Include references to X, Y and Z

It is then extremely easy to write a good prompt that you can then use with our extensions.

Spreadsheets

This is what your prompt should look like in a spreadsheet with GPT for Sheets or GPT for Excel
Custom prompt bulk tool:
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Task: Write a cold email
Style: Salesy
Tone: Funny
Topic: Sell the person on the idea of building their brand and growing their 
business through social media videos with our company Brandtegic.
Length: 3 paragraphs

Learn more about GPT for Sheets Custom prompt bulk tool or GPT for Excel Custom prompt bulk
tool.

Documents

This is what a prompt should look like in a document with GPT for Word:

This is what a prompt should look like in a document with GPT for Docs:

You can copy this prompt from the text below:

https://gptforwork.com/help/gpt-for-sheets/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-excel/bulk-ai-tools/custom-prompt
https://gptforwork.com/help/gpt-for-word
https://gptforwork.com/help/gpt-for-docs
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Rate limits
GPT for Work extensions rely on services that enforce rate limits to ensure smooth and fair access
to everyone.

If you choose not to set up API keys, you will share rate limits with other GPT for Work users. By
setting API keys, you benefit from your own rate limits, which you can manage from these links:

For OpenAI models

For Anthropic models

For Mistral AI models

For Gemini models

Google rate limits:

If you use the GPT for Sheets and Docs add-on, you are also subject to the rate limits enforced by
Google, based on your type of account:

External service calls daily limits (URL fetch)

gmail.com 20k / day / gmail.com account

Google Workspace 100k / day / Google Workspace account

INFO

Google's rate limits apply to all add-ons and scripts, not just ours. If you use multiple
scripts or add-ons, your usage counts towards the same rate limits. GPT for Excel and Word
are not affected by Google's rate limits.

https://platform.openai.com/account/limits
https://support.anthropic.com/en/articles/8243635-our-approach-to-api-rate-limits
https://help.mistral.ai/en/articles/155274-how-can-i-increase-my-rate-limits
https://ai.google.dev/gemini-api/docs/quota
https://developers.google.com/apps-script/guides/services/quotas
https://developers.google.com/apps-script/guides/services/quotas

